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Preface
This ASG-SmartDoc User�s Guide tells you how to use ASG-SmartDoc (herein called 
SmartDoc). SmartDoc gives you comprehensive COBOL program knowledge through 
information produced from static analysis and generated documentation. All 
documentation SmartDoc generates presents information in an easy-to-read format. 
Additionally, program structure charts, software metrics, and a program summary report 
provide you with high level program information.

Allen Systems Group, Inc. (herein called ASG) provides professional support to resolve 
any questions or concerns regarding the installation or use of any ASG product. 
Telephone technical support is available around the world, 24 hours a day, 7 days a week.

ASG welcomes your comments, as a preferred or prospective customer, on this 
publication or on any ASG product.

About this Publication
This publication consists of these chapters:

� Chapter 1, "Introduction," gives an overview of SmartDoc and describes the 
program documentation produced by SmartDoc, such as program structure charts, 
software metrics, and program summary reports.

� Chapter 2, "Concepts," contains a detailed description of the concepts and tools 
used by SmartDoc, including the Application Knowledge Repository (herein called 
AKR), Program Metrics, Control Flow Analysis, Data Flow Analysis, Subsets, 
Perform Ranges, Data Items, Input/Output Data Items, and Program Structure.

� Chapter 3, "Getting Started With SmartDoc," contains the information required to 
run and produce SmartDoc reports. 

� Chapter 4, "Techniques," provides a basic understanding of the purpose and usage 
techniques incorporated in producing SmartDoc reports. Each report is described, 
followed by a description of its use in a programming task.

� Chapter 5, "Reports," contains descriptions and illustrations of each report 
produced by SmartDoc. Some reports are shown in the multiple formats produced 
by different analysis jobs.
ix



ASG-SmartDoc User�s Guide
� Chapter 6, "File," contains a description of the File pull-down, used to analyze a 
program, generate the SmartDoc reports, analyze programs prior to use by 
SmartDoc, and to exit SmartDoc.

� Chapter 7, "View," contains a description of the View pull-down, used to view 
metrics data for the programs that reside in the AKR.

� Chapter 8, "Options," contains a description of the Options pull-down, used to 
access the pop-ups that customize the SmartDoc environment. Customizing the 
SmartDoc environment includes defining and processing the Log file, and 
determining the values of the PF keys.

� Chapter 9, "Help," contains a description of the Help pull-down, used to access the 
Online Help facility. This chapter describes the actions available on the Help 
pull-down.

� Chapter 10, "Metrics," contains a description of SmartDoc generated metrics used 
to manage the program maintenance life cycle by providing information about the 
relative complexity and quality of a program. 

� Chapter 11, "Analyze," describes the analyze process used by SmartDoc. The 
analyze process gathers information about the program, including program 
relationships, logic, data and execution paths, and stores this information in the 
AKR. After the analyze information is placed in the AKR, it is available to ESW 
products in online and batch environments, where it is accessed to provide valuable 
information about the design and operation of user systems.

� Chapter 12, "SmartDoc Options," contains a description of SmartDoc options used 
to control report generation and to specify various report formats. Most of these 
options are specified by using the SmartDoc Options screen (when the online 
component is available). When ISPF is not installed, these options can be specified 
in the VIAIN DD statement of the analyze job by using the DPARM parameter. 

� Chapter 13, "AKR Utilities," contains a description of the online and batch AKR 
utilities used by SmartDoc.

� Chapter 14, "Online Component Commands," contains a description of SmartDoc�s 
online component commands. These commands are entered on SmartDoc screens 
in the same manner as ISPF commands, in the command input area on line four.

� Chapter 15, "Help Facility," contains a description of the comprehensive and 
context sensitive Help facilities provided to answer most questions online. The 
Help Tutorial contains help information on several subjects, such as screens, 
pop-ups, reports, commands, messages, and abends. The Help Tutorial also 
includes a Table of Contents that describes each major SmartDoc function, and a 
comprehensive Index for viewing specific information.
x
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Related Publications
The documentation library for ASG-SmartDoc consists of these publications (where nn 
represents the product version number):

� ASG-Center Installation Guide (CNX0300-nn) contains ASG-Center installation 
and customization procedures. ASG-Center must be installed before 
ASG-SmartDoc is installed.

� ASG-ESW Enhancement Summary (ESW1000-nn) highlights the new functionality 
for this release.

� ASG-SmartDoc Installation Guide (DCX0300-nn) provides instruction for 
installing and maintaining ASG-SmartDoc.

� ASG-SmartDoc User�s Guide (DCX0200-nn) describes ASG-SmartDoc 
instructions and report generation. 

Note:
To obtain a specific version of a publication, contact ASG Customer Support.
xi
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ASG-Existing Systems Workbench (ASG-ESW)

ASG-ESW (herein called ESW) is an integrated suite of components designed to assist 
organizations in enhancing, redeveloping, or re-engineering their existing systems. ESW 
products use the Application Knowledge Repository (AKR) to store source program 
analysis information generated by the Analytical Engine. Figure 1 represents the 
components of ESW. 

Figure 1 � ASG Existing Systems Workbench 

Existing Systems Workbench

ASG-Center

Analytical Engine

Application
Knowledge

Repository (AKR)

ASG-Alliance for Application Understanding

ASG-AutoChange for Mass Change Projects

ASG-Bridge for Conversion Projects

ASG-Encore for Evolving COBOL Programs

ASG-Estimate for Resource Estimation

ASG-Insight for Program Understanding

ASG-Recap for Portfolio Analysis

ASG-SmartDoc for Program Documentation

ASG-SmartEdit for COBOL Intelligent Editing

ASG-SmartQuest for Analyzing Abends

ASG-SmartTest for Testing/Debugging
  - TSO
  - CICS
  - IMS
  - ASM
  - APS
  - PLI
  - TCA for Test Coverage Analysis
  - DB2 Stored Procedure
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This table contains the name and description of each ESW component:

ESW Product Herein Called Description

ASG-Alliance Alliance The application understanding component that is 
used by IT professionals to conduct an analysis of 
every application in their environment. Alliance 
supports the analysis and assessment of the 
impact of change requests upon an entire 
application. Alliance allows the programmer/ 
analyst to accurately perform application analysis 
tasks in a fraction of the time it would take to 
perform these tasks without an automated 
analysis tool. The impact analysis from Alliance 
provides application management with additional 
information for use in determining the resources 
required for application changes.

ASG-AutoChange AutoChange The COBOL code change tool that makes 
conversion teams more productive by enabling 
quick and safe changes to be made to large 
quantities of code. AutoChange is an interactive 
tool that guides the user through the process of 
making source code changes.

ASG-Bridge Bridge The bridging product that enables field expansion 
for program source code, without being required 
to simultaneously expand the fields in files or 
databases. Because programs are converted in 
smaller groups, or on a one-by-one basis, and do 
not require file conversion, testing during the 
conversion process is simpler and more thorough.

ASG-Center Center The common platform for all ESW products. 
Center provides the common Analytical Engine to 
analyze the source program and store this 
information in the AKR. This common platform 
provides a homogeneous environment for all 
ESW products to work synergistically.
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ASG-Encore Encore The program re-engineering component for 
COBOL programs. Encore includes analysis 
facilities and allows you to extract code based on 
the most frequently used re-engineering criteria. 
The code generation facilities allow you to use the 
results of the extract to generate a standalone 
program, a callable module, a complement 
module, and a CICS server. Prior to code 
generation, you can view and modify the 
extracted Logic Segment using the COBOL 
editor.

ASG-Estimate Estimate The resource estimation tool that enables the user 
to define the scope, determine the impact, and 
estimate the cost of code conversion for COBOL, 
Assembler, and PL/I programs. Estimate locates 
selected data items across an application and 
determines how they are used (moves, arithmetic 
operations, and compares). Time and cost factors 
are applied to these counts, generating cost and 
personnel resource estimates.

ASG-Insight Insight The program understanding component for 
COBOL programs. Insight allows programmers 
to expose program structure, identify data flow, 
find program anomalies, and trace logic paths. It 
also has automated procedures to assist in 
debugging program abends, changing a 
computation, and resolving incorrect program 
output values.

ASG-Recap Recap The portfolio analysis component that evaluates 
COBOL applications. Recap reports provide 
function point analysis and metrics information, 
program quality assessments, intra-application 
and inter-application comparisons and 
summaries, and historical reporting of function 
point and metrics information. The portfolio 
analysis information can also be viewed 
interactively or exported to a database, 
spreadsheet, or graphics package.

ASG-SmartDoc SmartDoc The program documentation component for 
COBOL programs. SmartDoc reports contain 
control and data flow information, an annotated 
source listing, structure charts, program summary 
reports, exception reports for program anomalies, 
and software metrics.

ESW Product Herein Called Description
xiv



Preface
Invoking ESW Products

The method you use to invoke an ESW product depends on your system setup. If you 
need assistance to activate a product, see your systems administrator. If your site starts a 
product directly, use the ISPF selection or CLIST as indicated by your systems 
administrator. If your site uses the ESW screen to start a product, initiate the ESW screen 
using the ISPF selection or CLIST as indicated by your systems administrator and then 
typing in the product command on the command line.

The product names can also vary depending on whether you access a product directly or 
through ESW. See "ESW Product Integration" on page xvi for more information about 
using ESW.

ASG-SmartEdit SmartEdit The COBOL editing component that can be 
activated automatically when the ISPF/PDF 
Editor is invoked. SmartEdit provides 
comprehensive searching, inline copybook 
display, and syntax checking. SmartEdit allows 
you to include an additional preprocessor (for 
example, the APS generator) during syntax 
checking. SmartEdit supports all versions of IBM 
COBOL, CICS, SQL, and CA-IDMS.

ASG-SmartQuest SmartQuest The diagnostic tool for analyzing batch and CICS 
transaction abends. SmartQuest has been 
designed to make the maximum use of simple 
point-and-shoot techniques to enable fast and 
easy navigation through any data dump. 

ASG-SmartTest SmartTest The testing/debugging component for COBOL, 
PL/I, Assembler, and APS programs in the TSO, 
MVS Batch, CICS (including file services), and 
IMS environments. SmartTest features include 
program analysis commands, execution control, 
intelligent breakpoints, test coverage, pseudo 
code with COBOL source update, batch connect, 
disassembled object code support, and full screen 
memory display.

ESW Product Herein Called Description
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To initialize ESW products from the main ESW screen, select the appropriate option on 
the action bar pull-downs or type the product shortcut on the command line.

ESW Product Integration

Because ESW is an integrated suite of products, you are able to access individual ESW 
products directly, or through the main ESW screen. As a result, different fields, values, 
action bar options, and pull-down options display on a screen or pop-up depending on 
how you accessed the screen or pop-up. 

Certain ESW products also contain functionality that interfaces with other ESW products. 
Using SmartTest as an example, if Alliance is installed, SmartTest provides a dynamic 
link to Alliance that can be used to display program analysis information. If Insight is 
installed and specified during the analyze, the Insight program analysis functions are 
automatically available for viewing logic/data relationships and execution path. For 
example, the Scratchpad option is available on the Options pull-down if you have Insight 
installed. 

Product Name (ESW Name) Shortcut ESW Pull-down Options

Alliance (Application Understanding) AL Understand � Application

AutoChange (Conversion Set) CC Change � Conversion Set

Bridge BR Change � ASG-Bridge

Encore (Program Re-engineering) EN Re-engineer � Program

Estimate ES Measure � ASG-Estimate

Insight (Program Understanding) IN Understand � Program

Recap (Portfolio Analysis) RC Measure � Portfolio

SmartDoc (Program Documentation) DC Document � Program 

SmartEdit SE Change � Program
Or

Change � Program with Options

SmartQuest SQV Understand � Abend/Dump

SmartTest (Testing/Debugging) ST Test � Module/Transaction
xvi
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Access to these integrated products requires only that they be installed and executed in 
the same libraries. 

Example 1
Figure 2 shows the Encore Primary screen that displays when you access Encore directly.

The Encore Primary screen contains these eight action bar menu items: File, View, 
Extract, Generate, Search, List, Options, and Help.

Figure 2 � Encore Primary Screen
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Figure 3 shows the Encore Primary screen that displays when you access Encore through 
ESW by selecting Re-engineer � Program from the ESW action bar menu. Notice that the 
Primary screen name changes to ASG-ESW - Program Re-engineering when you enter 
Encore through ESW. Also, the Logic menu item displays if Insight is installed.

Figure 3 � ESW Encore Primary Screen

Example 2

Figure 4 shows the File - Analyze Submit pop-up that displays when you access 
SmartTest directly. Figure 5 on page xix shows the File - Analyze Submit pop-up that 
displays when you access SmartTest through ESW. 

Figure 4 �  File - Analyze Submit Screen
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The actions shown on these screens can also vary. For example, the D - Doc Options 
action is only available on the File Prepare Program screen (or File - Analyze Submit 
screen) if SmartDoc is installed on your system. In Figure 4 on page xviii, the Doc 
Options action is not displayed.

Figure 5 � ASG-ESW - Prepare Program Screen (accessed through ESW) 

Notice that the Analyze features field in Figure 5 lists additional ESW products than 
shown on Figure 4 on page xviii. This field is automatically customized to contain the 
ESW products you have installed on your system. These are the names of the analyze 
types:

Analyze Type Analyze Type (ESW)

ASG-Encore Re-engineer

ASG-Insight Understand

ASG-SmartDoc Document

ASG-SmartQuest Abend/Dump

ASG-SmartTest Test

Extended Analysis (ASG-SmartTest with 
Insight installed)

Extended Analysis
xix
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Publication Conventions
ASG uses these conventions in technical publications:

ASG Customer Support

ASG provides support throughout the world to resolve questions or problems regarding 
installation, operation, or use of our products. We provide all levels of support during 
normal business hours and emergency support during non-business hours.

ASG Third-party Support. ASG provides software products that run in a number of 
third-party vendor environments. Support for all non-ASG products is the responsibility 
of the respective vendor. In the event a vendor discontinues support for a hardware and/or 
software product, ASG cannot be held responsible for problems arising from the use of 
that unsupported version.

Convention Represents

ALL CAPITALS Directory, path, file, dataset, member, database, 
program, command, and parameter names.

Initial Capitals on Each Word Window, field, field group, check box, button, panel (or 
screen), option names, and names of keys. A plus sign 
(+) is inserted for key combinations (e.g., Alt+Tab). 

lowercase italic 
monospace

Information that you provide according to your 
particular situation. For example, you would replace 
filename with the actual name of the file.

Monospace Characters you must type exactly as they are shown. 
Code, JCL, file listings, or command/statement syntax.

Also used for denoting brief examples in a paragraph.

Vertical Separator Bar ( | ) 
with underline

Options available with the default value underlined (e.g., 
Y|N).

Underline Denotes a cursor-selectable field or line.
xx
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Intelligent Support Portal (ISP)

Online product support is available at: http://www.asg.com/support/support.asp via the 
ASG Intelligent Support Portal (ISP). Your logon information for ISP online support is:

Customer ID = NNNNNNNNN
Password = XXXXXXXXXX

where:

NNNNNNNNNN is your customer ID supplied by ASG Product Distribution.
XXXXXXXXXX is your unique password supplied by ASG Product Distribution.

The ASG-Intelligent Support Portal User's Guide provides instructions on how to use the 
ISP and is located on the ASG Support web page.

Telephone Support

 To expedite response time, please have this information ready: 
� Product name, version number, and release number 
� List of any fixes currently applied 
� Any alphanumeric error codes or messages written precisely as displayed 
� A description of the specific steps that immediately preceded the problem 
� Verify whether you received an ASG Service Pack or cumulative service tape for this 

product. It may include information to help you resolve questions regarding installation of 
this ASG product. The Service Pack instructions are in a text file on the distribution media 
included with the Service Pack. You can access the latest software corrections and Service 
Packs via the ISP.

� The severity code (ASG Customer Support uses an escalated severity system to prioritize 
service to our clients. The severity codes and their meanings are listed below.) 

Severity Codes and Expected Support Response Times

Severity Meaning Expected Support Response Time 

1 Production down, critical situation Within 30 minutes

2 Major component of product disabled Within 2 hours

3 Problem with the product, but customer has 
work-around solution

Within 4 hours

4 "How-to" questions and enhancement 
requests

Within 4 hours
xxi
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The Americas 

Europe, Middle East, and Africa (EMEA)
During normal business hours, we recommend that you call the Central Support number 
first (except in South Africa). 

Asia Pacific (APAC)

All Other Countries (Also for any non-working numbers)

If you receive a voice mail message, follow the instructions to report a production-down 
or critical problem. Leave a detailed message including your name and phone number. 
An ASG Customer Support representative will be paged and will return your call as soon 
as possible. Please have available the information described previously when the ASG 
Customer Support representative contacts you. 

Phone Fax E-mail

United States and 
Canada

800.354.3578 1.703.464.4901 support@asg.com

Phone Fax E-mail

Central Support 00.800.3544.3578 44.1727.812018 support.emea@asg.com 

English 44.1727.736305 44.1727.812018 support.uk@asg.com

French 33.141.028590 33.141.028589 support.fr@asg.com

German 49.89.45716.200 49.89.45716.400 support.de@asg.com

Italian 39.0290450025 support.it@asg.com

Dutch 31.30.241.6133 support.nl@asg.com

Spanish 34.913.523.800 34.917.156.961 support.es@asg.com

South Africa 800.201.423 support.sa@asg.com 

Phone Fax E-mail

Central Support 61.3.9645.8500 61.3.9645.8077 support.au@asg.com

Australia 800.637.947 61.3.9645.8077 support.au@asg.com

Hong Kong 800.96.2800 support.hk@asg.com

Japan 81.3.5326.3684 81.3.5326.3001 support.au@asg.com

Singapore 65.224.3080 65.224.8516 support.sg@asg.com

Phone Fax E-mail

All other countries 1.239.435.2201 support@asg.com
xxii
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ASG Documentation/Product Enhancements
Submit all product and documentation suggestions to ASG�s product management team 
at http://www.asg.com/asp/emailproductsuggestions.asp.

If you do not have access to the web, FAX your suggestions to product management at 
(239) 263-3692. Please include your name, company, work phone, e-mail ID, and the 
name of the ASG product you are using. For documentation suggestions include the 
publication number located on the publication�s front cover.
xxiii
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 1Introduction
1

This chapter contains an overview of SmartDoc, describes the program documentation 
produced by SmartDoc, and contains these sections:

Overview
Programmers and analysts use program documentation to learn about the internal 
structure and logic of programs. Quality documentation gives these IT professionals a 
program road-map that helps them maintain and enhance existing systems. SmartDoc 
provides detailed COBOL program information through static program analysis, 
comprehensive reports, and diagrams. 

In addition, you can use the SmartDoc HTML converter to produce SmartDoc reports in 
an hyperlinked HTML document you can view from any web browser. For information 
on using the SmartDoc HTML converter, see "HTML Converter" on page 115.

Section Page

Overview 1

SmartDoc Reports 2

Interfaces 3

Operating Systems 3

Printers 4

COBOL Support 4

Preprocessor Support 4

Major SmartDoc Components 5
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SmartDoc is a part of Center, an integrated product family supporting software 
maintenance life cycle automation.

Program Preparation

SmartDoc prepares a program report by using one of the analyze methods described in 
Chapter 11, "Analyze," on page 159. The AKR stores the analysis output. Then, this 
information becomes an integrated component of the program documentation.

SmartDoc Reports
SmartDoc has an interactive user interface used to generate documentation, reports, and 
diagrams. These are the SmartDoc reports:

See Chapter 5, "Reports," on page 35 for detailed information on SmartDoc reports.

SmartDoc Reports

Table of Contents Master Index

Program Summary Metrics report
Program Metrics
Software Science Volume Metric
Control Variable Metric
Cyclomatic Complexity Metric
Essential Complexity Metric
GOTOFAR Metric
Perform Range Metrics

Advanced Source Listing Paragraph Cross-Reference

CALL Statement report Perform Range Hierarchy Chart

Compiler/Optimizer Output report Perform Range Usage and Interface report

Condensed Source Listing Program Exception report

COPY Statement report Structure Chart

Data Division report Subset report

Enhanced Data Cross Reference report Verb Summary
2
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Interfaces
SmartDoc is a batch-oriented product that you can integrate with compile and link JCL, 
or you can run standalone. It includes an interactive, online component to generate 
program documentation, to set up and maintain the AKR, and to display program metrics. 

Note:
These functions can also be accomplished if ISPF is not installed.

The SmartDoc online component features Common User Access (CUA) screens, action 
bars, pull-downs, and pop-ups designed for easy access to all product features.

An action bar is the line of keywords displayed at the top of a screen. Each keyword 
represents a category of actions you can perform on that screen. Process the action bar by 
selecting an action. Select an action by moving the cursor to the desired keyword and 
pressing Enter.

A pull-down displays when you select an action on the action bar. On a pull-down, 
actions followed by three dots (...) display a pop-up when selected. Actions not followed 
by three dots (...) immediately activate internal commands. There are two ways to select 
an item on a pull-down:

� Move the cursor to the desired keyword and press Enter.

� Enter the number of the desired action in the input field and press Enter.

A pop-up is a window that displays when you type a command or select an item on a 
pull-down or a pop-up. You can enter information for the requested action on a pop-up. 
Enter the desired data and/or option, then follow the instructions to process the 
information.

Note:
Press PF3/15 to exit a pull-down or a pop-up without processing any actions.

Operating Systems
SmartDoc runs under MVS and uses ISPF (Version 3.1 or later) as its standard online 
user interface. If ISPF is unavailable, you can manually set up and maintain JCL to 
produce reports. Use the procedures (PROCs) included with SmartDoc to maintain the 
AKR.
3
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Printers
SmartDoc supports most printers that use a standard character set, and provides program 
parameters to use alternate characters if required. See Chapter 8, "Options," on page 141 
for more information.

COBOL Support
SmartDoc supports these versions of COBOL:

� COBOL/370

� COBOL II (including Release 3)

� CASE-generated COBOL

� Enterprise COBOL Release 3.1

Preprocessor Support
SmartDoc supports these preprocessor languages directly:

� Command-level CICS

� Command-level DL/I

� CA-IDMS

� SQL

Other preprocessor languages can be supported from the generated COBOL code.
4
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Major SmartDoc Components 
The first screen SmartDoc displays identifies major SmartDoc components (see 
Figure 6). The action bar is one of these, and designates the primary functional 
organization of the SmartDoc online component. Each action bar item displays a 
pull-down list of options available for that action.

Figure 6 � Primary SmartDoc Screen

Actions
These are the SmartDoc Primary screen actions:

 

Action Description

File Displays the File pull-down used to analyze a program, submit SmartDoc 
reports, manage the AKR, and exit SmartDoc. See Chapter 6, "File," on 
page 107 for additional information.

View Displays the View pull-down used to view metrics for a program in the 
AKR. See Chapter 7, "View," on page 135 for additional information.

Options Displays the Options pull-down used to set options, such as PF key 
values, Log file attributes, and various options for the interactive process. 
See Chapter 8, "Options," on page 141 for additional information.

Help Displays the Help pull-down used to access the Online Help facility. See 
the online help, Chapter 9, "Help," on page 149, and Chapter 15, "Help 
Facility," on page 235 for additional information.
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 2Concepts
This chapter contains a detailed description of concepts and tools used by SmartDoc and 
contains these sections:

Application Knowledge Repository (AKR)
SmartDoc generates program documentation and metrics from the information the 
program analysis places in the AKR. 

The AKR is a BDAM or a VSAM file organization. The AKR has utilities for allocation 
and maintenance, and you can use these utilities to allocate multiple AKRs. For more 
information about AKR structure and maintenance, see Chapter 13, "AKR Utilities," on 
page 199.

The Program Analyzer stores the program information in the AKR after it analyzes a 
program. This information is about program relationships, logic and data, execution 
paths, and COBOL intelligence. For more information about the Program Analyzer, see 
Chapter 11, "Analyze," on page 159.

Section Page

Application Knowledge Repository (AKR) 7

Program Metrics 8

Control Flow Analysis 10

Data Flow Analysis 10

Subsets 10

Perform Ranges 12

Data Items 13

Program Structure 14
7
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Program Metrics
Software metrics assess program complexity, architecture, and software quality. They 
allow organizations to identify programs that need enhanced, re-engineered, or additional 
resources.

The AKR stores the program metrics information as a separate member (i.e., it is stored 
separately from the actual program). If you delete the program from the AKR, the metrics 
information remains intact. Use the Metrics Display and Utilities screen to rename or 
delete metrics.

Unlimited versions of metric data are retained for each program, providing information 
for complexity versus time graphs.

Software Science Volume Metric
The Software Science Volume Metric is a size (or volume) metric based on the premise 
that the larger the program, the more difficult it is to understand and maintain. The 
Software Science Volume Metric is defined by using these nine variables:

� n1= number of distinct operators in the program

� n2 = number of distinct operands in the program

� N1= total number of operators in the program

� N2 = total number of operands in the program

� n = n1 + n2 = the vocabulary of the program

� N = N1 + N2 = the length of the program

� The volume (V) of a program can then be defined as:

V = N log2 n

� The effort (E) to understand a program can be defined as:

E = V * V

� SmartDoc reports on program volume (V).
8
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Cyclomatic Complexity Metric
The Cyclomatic Complexity Metric measures logical flow paths. This metric is defined 
as the number of predicates (or branch) points in the program, and operates on the 
premise that the number of program paths determine the complexity of the program. The 
number of predicates is a count of all conditional branches in the program. 

Control Variable Metric
The Control Variable Metric is similar to the Cyclomatic Complexity Metric, except the 
Control Variable Metric measures the number of program control variables. This metric 
is based on the premise that programs with equal flow paths, but more variables 
controlling the flow, are more difficult to understand and maintain than programs with 
fewer control variables. For example:

Complexity = (number of branch points)

Complexity = (number of branch points) + (number of control variables)

Essential Complexity Metric
The Essential Complexity Metric measures how much a program can be reduced, 
quantifying how well structured a program is. This metric is defined as the Cyclomatic 
Complexity Metric minus the number of reducible subgraphs in the program. Reducible 
subgraphs are created through unstructured constructs.

The value of the Essential Complexity metric is equivalent to the Cyclomatic Complexity 
Metric after removing all proper, single entry, and single exit subgraphs. For example:

Complexity = (number of branch points - reducible subgraphs)

GOTOFAR Metric
The GOTOFAR metric measures the relative frequency of long GOTOs in a program. A 
long GOTO is one that jumps out of the current paragraph. The GOTOFAR metric is a 
rational quantity expressed as a decimal fraction with a value greater than or equal to zero 
and less than one. The metric is defined as this ratio, for example:

Complexity = (number of long GOTOs)/(number of PROC DIV statements)
9
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Control Flow Analysis
The analyze job provides the control flow analysis when you perform a SmartDoc 
analysis. The Advanced Source Listing reports control flow analysis information when 
you analyze a program. The control flow analysis indicates the control path to or from a 
particular point in the code. The PROCEDURE DIVISION of the Advanced Source 
Listing shows each source statement. Whenever SmartDoc encounters a label 
(PROCEDURE DIVISION, paragraph, or section label), information on how the control 
flows to that label is shown on the Advanced Source Listing. The Advanced Source 
Listing also shows where the source passed control when SmartDoc encounters a 
COBOL verb affecting control flow. When SmartDoc encounters the end of a paragraph 
or a perform range, the Advanced Source Listing shows all possible return locations.

Data Flow Analysis
The analyze job provides the data flow analysis when you perform an Extended 
SmartDoc analysis. Information from the SmartDoc data flow analysis is presented on the 
Advanced Source Listing for each data item.

When you use a data item, SmartDoc indicates all locations in the source where the 
current data item value may have been set. When a data item is modified, SmartDoc 
indicates all locations within the source where the modified value may be used next. A 
SmartDoc data flow analysis considers all data alias names (renames, redefines, record 
group items).

Subsets
SmartDoc classifies COBOL statements into subsets by grouping similar COBOL verbs 
together. For example, lines that contain READ, WRITE, OPEN, or CLOSE verbs can be 
referenced as the IO subset. The Subset report lists each of the subsets and identifies the 
paragraphs or the divisions containing them. The paragraph or the division name is 
shown with the page and line number where that subset occurs in the Advanced Source 
Listing.
10
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These are the COBOL subsets and their corresponding entities:

COBOL Subset Description

ASsignment Statements that assign a value, such as MOVE, ADD, and 
Compute.

CAll Statements that relate to subprogram calls, such as CALL 
and CANCEL.

CIcs Any CICS or DL/1 Command Level statements.

COBOLII PROCEDURE DIVISION statements that are exclusively 
COBOL II, including CONTINUE, END, and 
INITIALIZE verbs.

COMment Statements having no run-time effect, such as all lines with 
an asterisk (*) in column 7, the entire IDENTIFICATION 
DIVISION, and NOTE statements.

CONditional Statements or the parts of statements that conditionally 
change the flow of control in a program such as IF, ELSE, 
and WHEN.

DB2 | SQL EXEC SQL statements.

DDL SQL Data Definition Language statements, such as 
CREATE, ALTER, DECLARE, and DROP.

DEBug Statements containing a DEBUG, EXHIBIT, ON, 
READY, or RESET verb, as well as statements containing 
a D in column 7.

DEFinition Declaratives of data items including the 
SPECIAL-NAMES paragraph in the ENVIRONMENT 
DIVISION, as well as the entire DATA DIVISION.

DIRective Statements that direct the complier to take specific actions 
during compilation, such as BASIS, EJECT, and TITLE.

DL/I | DL/1 DL/I Command Level statements.

DML SQL Data Manipulation Language statements, such as 
SELECT, UPATE, INSERT, and COMMENT.

ENtry The PROCEDURE DIVISION statements and all ENTRY 
statements.
11
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Perform Ranges
A perform range consists of all the code that executes by following a PERFORM 
statement, for example:

PERFORM PARAGRAPH-ABC THRU PARAGRAPH-XYZ.

The prior statement indicates the paragraphs range begins with PARAGRAPH-ABC and 
continues through the end of PARAGRAPH-XYZ, including all paragraphs executed 
between.

EXIt | PGMExit Statements containing a STOP RUN, GOBACK, or EXIT 
PROGRAM verb, as well as CALL statements indicated as 
NORET (non-returning).

FALLTHROUGH Statements of PERFORMed units that fall through to the 
next paragraph.

FD Statements containing file definitions.

GOTO Statements containing an ALTER or an GOTO verb.

IDMSQ IDMS statements.

IO
Input
Output

COBOL IO statements (IO, Input, or Output respectively) 
including CALL statements indicated as containing IO, 
Input, or Output.

DIVision
PARagraph
SECtion

Statements containing DIVISION or SECTION headers, 
or PARAGRAPH labels.

MATH Statements containing ADD, SUBTRACT, MULTIPLY, 
DIVIDE, or COMPUTE verbs.

PERform Statements containing the PERFORM, SORT, or MERGE 
verbs.

SORTMerge Statements containing SORT, MERGE, or RELEASE 
verbs; a paragraph or a section name referred to in 
INPUT/OUTPUT PROCEDURES.

01 AND 77 LEVELS Statements containing 01 or 77 data definition.

COBOL Subset Description
12
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Data Items
A data item can be any of these:

� Elementary dataname

� File name

� Group name

� Table name

� Table element name

� Special name

SmartDoc supports any legal COBOL reference for a data element. Also, SmartDoc 
identifies a redefined variable by the specified name and the redefined name, and treats a 
table entry reference as a reference to the entire table. All references are reported when 
data items overlap, and a name can refer to parts of multiple data items. For example, 
SmartDoc identifies references to a group item, as well as the individual elements within 
the group. This is true of data item modification and/or uses.

SmartDoc identifies valid data item references, as opposed to matching simple character 
patterns in the variable name. These valid data item references identify redefined or 
renamed data items, or record group items (also called aliases). SmartDoc also identifies 
indirect data item references. Indirect references are datanames directly or indirectly 
affected by the use of a data item or a modification.

SmartDoc identifies definitions, modifications, and uses of data items. A definition is the 
defined data item and data item aliases specified in the DATA DIVISION. Modification 
is an occurrence of a data item where its value is set or altered. Lastly, SmartDoc uses a 
tested or a used value to identify how a data item is being used.

Input and Output Data Items
The Perform Range Usage and Interface report identifies data items used to communicate 
parameters to and from a perform range. These data items are referenced as IN or OUT. 
IN data items are modified outside of the perform range, then used prior to modification 
within the perform range. OUT data items are modified within the perform range, then 
used outside the perform range prior to modification. USE and MOD are data items 
referenced inside the perform range.
13
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Program Structure
SmartDoc shows you the structure of a COBOL program. The Perform Range Hierarchy 
Chart and Structure Chart show statements comprising the general program structure. 
The Perform Range Hierarchy Chart shows the program structure in an area as densely as 
possible, and indicates the relative nesting level of performs and calls. The Structure 
Chart graphically shows the information reported on the Perform Range Hierarchy Chart.
14
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 3Getting Started With SmartDoc
This chapter contains the information required to run and produce SmartDoc reports and 
contains these sections:

Introducing SmartDoc
This chapter is for the new SmartDoc user. Review Chapter 2, "Concepts," on page 7 to 
understand SmartDoc terminology before following the sample SmartDoc session 
presented in this chapter. Also, review Chapter 5, "Reports," on page 35 to familiarize 
yourself with the many SmartDoc reports.

Perform these tasks before beginning the sample SmartDoc session:

� Determine the AKR used. 

If you do not know the name of the AKR to use, contact your systems programmer 
or allocate an AKR as directed in Chapter 13, "AKR Utilities," on page 199.

� Select a program to document.

Section Page

Introducing SmartDoc 15

Starting SmartDoc 16

Analyzing the Program 17

Generating SmartDoc Reports 18

Editing the JCL 20
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See these chapters for more information: 

� Chapter 11, "Analyze," on page 159 for information on analyze options, program 
analysis, and generating SmartDoc reports.

� Chapter 12, "SmartDoc Options," on page 193 for information on SmartDoc 
options.

Starting SmartDoc
The method used to invoke SmartDoc depends on your system setup. See your systems 
administrator if you need assistance activating SmartDoc.

To start SmartDoc without using the ESW screen, follow this step: 

� Use the ISPF selection or CLIST (as indicated by your systems administrator). The 
SmartDoc Primary Screen displays after you activate the session.

To use the ESW Primary screen to start SmartDoc 

1 Initiate the ESW Primary screen by using the ISPF selection or CLIST as indicated 
by your systems administrator.

2 Select Document � Program and press Enter. The product name displays on the 
screen as ASG-ESW - Program Documentation (see Figure 7).

Figure 7 � SmartDoc Primary Screen
16
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Analyzing the Program

The selected program must be analyzed by the Program Analyzer before you can produce 
SmartDoc reports. 

To analyze a program

1 Select File � Analyze from the SmartDoc Primary screen and press Enter (see 
Figure 8). The Prepare Program pop-up displays (see Figure 9).

Figure 8 � File Pull-down

Figure 9 � ASG-ESW Prepare Program Pop-up

Note:
The product names listed under the Analyze features (Y/N) field may differ from 
the names shown in Figure 9 if you did not start SmartDoc from the ESW Primary 
screen.
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2 Type the dataset of the JCL used to compile and link the program in the Compile and 
link JCL field.

3 If other ESW are products installed:

Select the desired analyze job(s) type(s) in the Analyze features field.

Or

If SmartDoc is the only product installed, the default for SmartDoc is YES.

4 Type the AKR name in the AKR dataset name field and press Enter. Our sample 
session uses USER.TEST.AKR.

5 Type Y in the Compile? field.

6 Type D in the command line to select the File - ASG-SmartDoc Reports pop-up to 
submit the reports simultaneously.

Generating SmartDoc Reports

Use the File - SmartDoc Report pop-up to produce SmartDoc reports, to submit or edit 
the JCL for the analyze job, and to specify the SmartDoc analysis. 

Note:
You can use the SmartDoc HTML converter to produce SmartDoc reports in an 
hyperlinked HTML document you can view from any web browser. For information on 
using the SmartDoc HTML converter, see "HTML Converter" on page 115.

To submit an analyze job

1 From the Analyze Submit screen, select Option D and press Enter.

2 Type a back slash(/) in the Analyze field and press Enter to submit an Analyze job.

3 Type a back slash(/)in the Extended SmartDoc analysis field and press Enter to 
obtain extended analysis and reporting features.

4 Type Y in the Compile field and press Enter to compile the program at the time of 
analysis.
18
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5 Type 1 in the Actions field and press Enter. The File - Select Reports pop-up 
displays (see Figure 10). 

Figure 10 � File - Select Reports Pop-up

6 Type a non-blank character in the report field to select a report and press Enter.

To only produce the Advance Source Listing and the Enhanced Paragraph 
Cross-Reference reports, select the Minimum reports field. For this exercise, make 
sure that the Minimum reports field is not selected.

To specify format and content options for reports, select an action in the Report 
Options field. See "File - Select Reports Pop-up" on page 120 for additional 
information on these options.

Note:
You can submit other reports from this screen without performing another analyze 
after a program is analyzed and it resides in the AKR.

If you are outputting to HTML, you must generate an Advanced Source Listing for 
the HTML hyperlinked entries to work properly. See "To create HTML reports" on 
page 116 for more information.

7 Press F3 to return to the File - ASG-SmartDoc Reports pop-up after selecting the 
reports. 

8 Type 3 in the Actions field to edit the JCL for the analyze job.
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Editing the JCL
To initiate an editor session with the compile/analyze JCL for the displayed analyze job, 
follow this step:

� From the File - SmartDoc Report pop-up, type 3 and press Enter. The Editor screen 
(see Figure 11) displays.

Figure 11 � Editor Screen Showing Compile/Analyze JCL

To edit the JCL

1 Review the generated JCL to make sure it is correct for your environment. 

2 Type SUBMIT to submit the job.

3 Press PF3/15 to return to SmartDoc.

You have successfully submitted a SmartDoc analysis and report job.

Retrieve the output from your assigned printer when the job is complete. This is the 
same printer that SYSOUT output is normally printed on, unless you specified a 
different printer.
20
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This chapter describes the purpose and techniques of using SmartDoc reports and 
contains these sections:

Section Page

Introduction 22

Advanced Source Listing 22

Call Statement Report 23

Condensed Source Listing 24

Copy Statement Report 24

Data Division Report 25

Enhanced Data Cross-Reference Report 26

Program Metrics 27

Paragraph Cross-Reference 30

Perform Range Hierarchy Chart 30

Perform Range Usage and Interface Report 31

Program Exception Report 32

Structure Chart 33

Subset Report 33

Verb Summary Report 34
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Introduction
This chapter describes each report function and how it applies to a typical programming 
task. Then, two solutions are given. The first solution is the cumbersome programming 
method required without SmartDoc. The second solution is the easy SmartDoc technique.

See Chapter 5, "Reports," on page 35 for report samples and information.

Advanced Source Listing

Purpose of Report
The Advanced Source Listing augments the source with control and data flow 
information, and gives you extended understanding of the program. This information 
improves your ability to navigate through the source, and reveals hidden detail, for 
example:

Action Description

Programming Task You want to add code to support a new employee type in the 
company's employee information system. You need to 
understand how the program uses the EMPLOYEE-CODE. 
You also need to ensure the existing code supports the new type 
and that, where needed, the new type is addressed.

Without SmartDoc Manually trace through the code to find and mark all references 
to EMPLOYEE-CODE. Now manually trace and mark all logic 
paths that may lead to where the EMPLOYEE-CODE is used. 
When you understand all the paths leading to usage points, 
repeat the previous steps everywhere the EMPLOYEE-CODE 
value may determine the logic path used. Now you may have 
enough information to make changes, depending on program 
size. Make the changes, recompile the program, and test the 
changes.

The SmartDoc 
Technique

Use the Enhanced Data Cross-Reference report to find all 
references to EMPLOYEE-CODE. Use the Advanced Source 
Listing control and data flow information to understand how 
EMPLOYEE-CODE is used at each program reference 
location. Make any necessary code changes. Now, reanalyze, 
and run SmartDoc reports for the program. Review the program 
changes and use the Advanced Source Listing control and data 
flow information to ensure they work. Recompile and test the 
program. SmartDoc's static analysis capability enhances your 
ability to make changes that work correctly the first time.
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Note:
If you are outputting to HTML, you must generate an Advanced Source Listing for the 
HTML hyperlinked entries to work properly. See "To create HTML reports" on page 116 
for more information.

Call Statement Report

Purpose of Report
The Call Statement report shows all calls to external programs, if program control returns 
to the current program, and where the call is located. Finally, the Call Statement report 
shows the parameters passed to the called program and how they are used, for example:

Action Description

Programming Task A program is being changed to include extra information. The 
revised program is going to use old data in new ways, and you 
need to find where the data items are being used and changed.

Without SmartDoc Another manual search is needed. You need to find all called 
programs and search them, as well as searching the program 
being altered. You do not know whether the called program 
changes parameters that are later used. So, you also need to 
search the code you are altering for every occurrence of 
parameters being passed to another program.

The SmartDoc 
Technique

Review the Call Statement report to find all calls to other 
programs. The Call Statement report lists IN parameters and 
OUT parameters. From the information in the Call Statement 
report, you can turn to the Advanced Source Listing and follow 
the data flow information for the affected variables.
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Condensed Source Listing

Purpose of Report
The Condensed Source Listing shows structurally significant code portions giving you a 
clear overview of the program. Listed divisions, sections, and paragraphs are indented, 
for example:

Copy Statement Report

Purpose of Report
The Copy Statement report shows all COBOL COPY statement occurrences, and 
displays other source managers' COPY type directives (-INC, ++INCLUDE, etc.), for 
example:

Action Description

Programming Task You are a new programmer assigned to maintain and enhance a 
large, old, and unstructured program. You need to learn the old 
program before making changes.

Without SmartDoc Study and manually analyze the listings to try to gain an 
understanding of the program structure.

The SmartDoc 
Technique

Review the Condensed Source Listing showing the structurally 
significant program parts with noise verbs removed. The 
Condensed Source Listing enables you to easily understand 
even unstructured programs.

Action Description

Programming Task The user is getting erroneous output. You are trying to locate its 
source, but cannot find the problem in the copied code.

Without SmartDoc Trace through the code noting any COPY statements. Try to 
find the copied code source and examine it for any variable 
names duplicated in the source code.

The SmartDoc 
Technique

Review the Copy Statement report showing the DSNs for the 
actual code copied. Use that information to go directly to the 
code in question.
24
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Data Division Report

Purpose of Report
The Data Division report gives you detailed information about all 01structures in a 
program DATA DIVISION. This is the information the Data Division report provides:

� COBOL level number

� Dataname

� Length

� Starting and ending position

� Format

� Picture clause definition

� Name of the COPY member where the data item is defined (if applicable)

For example:

Action Description

Programming Task You are assigned to export report data from the mainframe to 
the PC and reformat it. To reformat the data, you need to know 
the length, starting, and ending position of each data item 
displaying in the report. 

Without SmartDoc Use program and copy member listings to determine each data 
item length before creating the program to export and reformat 
the report data. 
Then, you must produce a report copy and manually count the 
columns to determine starting and ending position. 

The SmartDoc 
Technique

Review the DATA Division report to identify the length, 
starting and ending position and use the information to develop 
a program to export and reformat the report data.
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Enhanced Data Cross-Reference Report

Purpose of Report
The Enhanced Data Cross-Reference report provides a cross-reference to all program 
data item references (including alias definitions and references). With this information 
you can locate every data item reference easily, without having to manually scan the 
code, for example:

Action Description

Programming Task You need to expand the a field length and understand the 
potential impact on other fields that use the data item before 
implementing this change.

Without SmartDoc Manually review the code to find every data item reference, 
then list all data items that may be indirectly impacted by 
change. Manually review the code and build a list of 
REDEFINES or RENAMES for the data item to expand. 
Now repeat the first step for each RENAMES or REDEFINES. 
Manually review the code to find the reference location for each 
data item, and build an indirectly affected data items list. Repeat 
this procedure for each listed data item until no more indirectly 
affected data items are found.

The SmartDoc 
Technique

Review the SmartDoc Enhanced Data Cross-Reference report. 
The report shows all data item definitions, alias definitions, 
usages, modifications, and indirect references.
Now, review the SmartDoc Advanced Source Listing report and 
find the source lines indicated by the Enhanced Data 
Cross-Reference report. At each source line, determine if other 
data items are indirectly affected by the first data item size 
change, and build a list of indirectly affected data items.
Repeat the previous process with the second list by using the 
Enhanced Data Cross-Reference report, until no more indirectly 
affected data items are found. The final list should contain the 
data item in question and any indirectly affected ones. This list 
contains the data items that require expansion to expand the first 
data item.
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Program Metrics

Purpose of Report
Program Metrics show the program's complexity, program architecture, and software 
quality mathematically. Metrics for multiple program versions allow you to examine how 
complexity and quality changes over time, for example:

Extended Example
This is an extended example of the use of Metrics for multiple program versions:

Follow the procedure below to use the SmartDoc technique to calculate the mean and 
standard deviation values. You can use these values to determine what programs would 
benefit most from restructuring.

To use SmartDoc to calculate metric mean and standard deviation values 

1 Calculate the mean for each of the three metrics. The mean is the total metric values 
added together for all the programs, divided by the number of programs.

2 Use the mean calculated in step 1 to calculate the standard deviation for each of the 
three metrics. 

Action Description

Programming Task You have to improve the existing software and are not sure 
where to start. 

Without SmartDoc Edit the library and select a program at random, or perhaps, 
select the software with the most records.

The SmartDoc 
Technique

Run a SmartDoc analysis and start working with the program 
with the worst metrics. Program metrics tell you what software 
is most likely to fail over time.

Action Description

Programming Task The company has twenty programs and is deciding which 
programs to rework.

Without SmartDoc Start your search with the program that is causing the most 
problems or with the largest program.

The SmartDoc 
Technique

Use SmartDoc to get the Software Science Volume, Cyclomatic 
Complexity, and the Control Variable metrics value for all of 
the programs being considered.
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3 Calculate the difference in the number of standard deviations between the 
Cyclomatic Complexity and the Software Science Volume metric for each program. 

4 Calculate the difference in the number of standard deviations between the Control 
Variable metric and the Software Science Volume metric for each program. 

Use the calculations from step 3 and step 4 to identify programs whose number of 
standard deviations from the mean for the Cyclomatic Complexity metric and the Control 
Variable metric are more than one standard deviation greater than the number of standard 
deviations for the Software Science Volume metric. These programs are probably good 
candidates for restructuring.

Consider the programs listed in this table:

Software Science 
Volume Cyclomatic Complexity Control Variable

Program
Metric 
Value

# Standard 
Deviations

Metric 
Value

# Standard 
Deviations Diff.

Metric 
Value

Standard 
Deviations Diff.

1 3000 0.03 16 1.12 1.09 25 1.14 1.11

2 2500 0.78 17 0.82 0.04 25 1.14 0.36

3 3500 0.84 21 0.39 -0.45 32 0.76 -0.08

4 2400 0.94 18 0.52 -0.42 26 0.86 -0.08

5 2800 0.29 15 1.42 1.13 24 1.41 1.12

6 2900 0.13 19 0.21 0.08 28 0.32 0.19

7 3300 0.52 20 0.09 -0.43 29 0.05 -0.47

8 3200 0.36 18 0.52 0.16 26 0.86 0.5

9 1900 1.75 27 2.21 0.46 24 1.41 -0.34

10 2600 0.62 19 0.21 -0.41 24 1.41 0.79

11 3700 1.17 19 0.21 -0.96 30 0.22 -0.95

12 2000 1.59 24 1.3 -0.29 30 0.22 -1.37

13 2200 1.26 18 0.52 -0.74 33 1.03 -0.23

14 3700 1.17 17 0.82 -0.35 34 1.3 0.13

15 4100 1.81 23 1.00 -0.81 32 0.76 -1.05

16 3900 1.49 23 1.00 -0.49 32 0.76 -0.73
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These programs should be reworked:

� Program 18 would benefit most, and needs restructuring to improve ease of 
maintenance. In the program metrics table the differences between the Software 
Science Volume metric and the other two metrics for Program 18 are about 1.23 
and 1.43.

� Program 5 might be examined next. In the program metrics table the differences 
between the Software Science Volume metric and the other two metrics are about 
1.13 and 1.12.

� Finally, examine program 1. In the program metrics table, program 1 has a little 
more than one standard deviation greater Cyclomatic Complexity and Control 
Variable metrics than Software Science Volume metric. The other programs seem 
proportionally complex for their size.

17 3300 0.52 15 1.42 0.9 32 0.76 0.24

18 3400 0.68 26 1.91 1.23 37 2.11 1.43

19 2700 0.45 20 0.09 -0.36 30 0.22 -0.23

20 2500 0.78 19 0.21 -0.57 31 0.49 -2.09

Metric 
Mean

Standard 
Deviation for 
Metric Value

Metric 
Mean

Standard 
Deviation for 
Metric Value

Metric 
Mean

Standard 
Deviation for 
Metric Value

2980 617.74 19.7 03.3 29.2 3.7

Software Science 
Volume Cyclomatic Complexity Control Variable

Program
Metric 
Value

# Standard 
Deviations

Metric 
Value

# Standard 
Deviations Diff.

Metric 
Value

Standard 
Deviations Diff.
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Paragraph Cross-Reference

Purpose of Report
The Paragraph Cross-Reference report lists every entry and exit for all paragraphs and 
sections contained within the program. The listing also displays paragraph entries and 
exits by line number. Use the information contained in the report to discern all accesses to 
and from a paragraph or section, for example:

Perform Range Hierarchy Chart

Purpose of Report
The Perform Range Hierarchy Chart shows the structural interdependencies of the 
program. This diagram shows you the program perform range execution relationships as 
an indented list, for example:

Action Description

Programming Task You altered the calculating method for 401K contributions and 
a paragraph of original code is no longer needed. But, you must 
insure the paragraph is not used by other code before deleting it 
from the source.

Without SmartDoc Search the source code for paragraph references. The paragraph 
can be removed after the entire source is checked.

The SmartDoc 
Technique

Review the paragraph in the Paragraph Cross-Reference report 
to see all locations where it is invoked. This eliminates costly 
mistakes caused by a PERFORM or a GO TO that was 
overlooked when the program was changed.

Action Description

Programming Task You need to maintain and enhance a large program, and need to 
learn the program before making changes.

Without SmartDoc Study and manually analyze the listings to understand the 
program structure.

The SmartDoc 
Technique

Review the Perform Range Hierarchy Chart to see the program 
structure displayed in a dense, semi-graphical representation. 
The Perform Range Hierarchy Chart lists the control flow 
transfers from one perform range to another, enabling you to 
easily understand the program structure.
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Perform Range Usage and Interface Report

Purpose of Report
The Perform Range Usage and Interface report lists the program perform ranges along 
with the paragraphs and sections that perform them. The data items involved with the 
perform range are also given, and are listed as INPUTs, OUTPUTs, USES, or MODS.

This report displays all data item usage within a perform range. Use this information to 
make separately callable modules when re-engineering code. The Perform Range Usage 
and Interface report also tells you where perform ranges are invoked, and how perform 
range data changes can impact other program areas, for example:

Action Description

Programming Task You are adding a new feature to existing code, and need to 
remove the file-reading portion to make a separate module 
called from its original location, as well as from new code. 
As situations change, logic must change to match it. A 
conditional statement needs changed, and the impact on later 
uses of the affected variable needs examining.

Without SmartDoc Evaluate the source code paragraph that does the reading to 
locate all of the perform range input or the output data items so 
that they can be passed to and from the new module. Also, all 
data items that are used or modified need to become part of the 
new module�s Data Division. All of the old paragraph�s 
invocation locations need altered to the appropriate call.
Find all outgoing variables affected by the conditional. Walk 
through the code and try to determine what perform range uses 
the variable next and the affect of the alterations. Trace out from 
each of those perform ranges and see what affect there is.

The SmartDoc 
Technique

A reference to the reading perform range, in this case a 
paragraph only, in the Perform Range Usage and Interface 
report immediately shows all the data items involved, 
eliminating the laborious task of finding them yourself and 
removing the potential for errors. Also, all the invocation 
locations are displayed in the PERFORMED BY portion of the 
report.
Use the Perform Range Usage and Interface report to 
immediately see what variables enter and exit the perform 
range. See "Advanced Source Listing" on page 22 for an 
example of how the variables are used. Then follow the data 
flow information for the affected variables to see what change 
is needed.
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Program Exception Report

Purpose of Report
The Program Exception report provides program processing flow information, including 
these items: 

� Unstructured exits from a perform range

� Live exits

� Recursion

� Uninitialized uses

� Modifications without uses

� Dead code

� Dead data

Information from the Program Exception report reveals important code features that may 
cause undesired results and/or abends. Having these possible errors centrally located 
shortens the debugging process and identifies trouble spots for further investigation, for 
example:

Action Description

Programming Task You made changes to an existing program and the program is 
constantly timing out, indicating an infinite loop.
Many variables were added or had their uses altered during code 
changes. Now test the changes.

Without SmartDoc Finding the recursive cycle involves decrypting the dump from 
the abend, then examining the source until the loop is found.
Execute the program in as many ways as possible, trying to test 
for every possible case.

The SmartDoc 
Technique

Run the Program Exception report before executing the 
program. Note that a recursive cycle is indicated, including the 
actual statements along with the line numbers of each. Fix the 
infinite loop before it becomes a problem.
Review the Program Exception report to see where errors occur 
before attempting program execution. The Program Exception 
report lists potential problems, such as uninitialized data and 
live exits. These can then be fixed to assure greater program 
reliability.
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Structure Chart

Purpose of Report
The Structure Chart displays a program structure graphically. This diagram gives a clear, 
concise program overview, for example:

Subset Report

Purpose of Report
The Subset report identifies logical groupings of similar COBOL verbs. The subsets help 
you to identify similar statement groups within the program, for example:

Action Description

Programming Task You want to add a new feature to an old unstructured program 
and you need to understand the existing structure.

Without SmartDoc Study and manually analyze the listings, and try to understand 
the program structure.

The SmartDoc 
Technique

Review the Structure Chart that displays the program structure 
in an easy-to-understand format. The control flow becomes 
immediately and readily apparent. Make a Tile Mode version 
for future reference.

Action Description

Programming Task You need to check the number and relative positioning of 
program comments to ensure code quality assurance standards. 
You decide to consolidate all the I/O into one area while 
updating a program.

Without SmartDoc You need to search the source code line-by-line to locate and 
verify all comments, a time consuming and unproductive task.
Use FIND and RFIND commands on all possible I/O verbs. 
Note where they are and what it takes to move them.

The SmartDoc 
Technique

Review the Subset report comments section to immediately 
identify all code comments (and their line numbers).
Review the Subset report where the I/O statements are listed as 
a logical grouping by line number. These lines on the Advanced 
Source Listing show what logic leads up to them and what you 
need to do to overhaul them.
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Verb Summary Report

Purpose of Report
The Verb Summary report cross-references COBOL verbs to where they are used within 
the program. This report includes the Verb Frequency Table, showing the percentage of 
use in proportion to all other verbs. This information provides a complete verb usage 
listing, for example:

Action Description

Programming Task Your company has verb usage standards that require a single 
paragraph to be used to do all reads from a file, and you must 
ensure that a new program follows the standard.
Company standards require that no GO TOs be used, and you 
are quickly reviewing the code.

Without SmartDoc You search the source program line-by-line for file read 
references.
Search the code for all GO TOs, then write down where they are 
and repair them.

The SmartDoc 
Technique

Review the Verb Summary report revealing all program READ 
statements. The Advanced Source Listing is included so you 
can check file references.
Review the Verb Summary report for any GO TOs.
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This chapter describes each SmartDoc report and contains these sections:
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Introduction
SmartDoc program documentation is used to understand internal program structures and 
includes these features:

� Source code

� Source code commentary

� External program specifications

� Design documents

� Program structure charts

� Cross-reference maps

SmartDoc provides you with accurate, timely, and automatic program documentation. 
Comprehensive information about a COBOL program is presented in reports and listings 
used to effectively meet the challenge of maintaining and enhancing existing systems. In 
addition, you can generate SmartDoc reports in an HTML format for web distribution 
(see "HTML Converter" on page 115).

SmartDoc presents program information in a report collection that documents each 
program. For example, the program Structure Chart displays program logic graphically, 
and the software metrics enable you to evaluate and rank each program within a system.

This chapter describes and illustrates each SmartDoc report. Some reports are shown in 
the multiple formats produced by the different types of analysis jobs. Each analysis type 
provides SmartDoc with a slightly different feature set.

Compiler/Optimizer Output 104

Master Index 105

Section Page
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 These are the identifiers used to indicate the type of analysis performed:

Report Headings
All SmartDoc reports contain a standard heading, as shown in Figure 12.

Figure 12 � Report Heading Example

Identifier Description

DA An Extended SmartDoc analysis and compile were performed. 
This analysis provides data flow information. 
All features are available.

DX An Extended SmartDoc analysis was performed (no compile). 
This analysis provides data flow information. 

DMAP information is not merged into the Data Division of the 
Advanced Source Listing, and statement offsets are not 
available in the Procedure Division of the Advanced Source 
Listing.

DC A short SmartDoc analysis and compile were performed. This 
analysis provides all reporting capabilities excluding data flow 
information. 
Data flow information in the Advanced Source Listing is 
replaced with data cross-reference information. Uninitialized 
uses and modifications that have not been used are not noted in 
the Advanced Source Listing, the Enhanced Data 
Cross-Reference report, or the Program Exception report.

DS A short SmartDoc analysis was performed (no compile). This 
analysis provides all reporting capabilities excluding data flow 
information and compiler information. 
The DS analysis provides the same information as the DC 
analysis, but does not provide compiler information. 
Specifically, DMAP information is not merged into the Data 
Division of the Advanced Source Listing, and statement offsets 
are not available in the Procedure Division of the Advanced 
Source Listing.
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Report Field Descriptions
These are the report fields and their descriptions:

Note:
The Program Summary report does not include the program name in the report heading. 
The Table of Contents and Program Summary reports do not contain page numbering.

Table of Contents Report
Think of SmartDoc reports as chapters in a book describing a program. SmartDoc 
generates a Table of Contents (see Figure 13 on page 39) for this book and divides it into 
these categories:

Field Description

(A) SmartDoc release number and level.

(B) Report title.

(C) Program name the report was generated for.

(D) Date and time the report was generated.

(E) Report page number.

Category Contents

I        Logic 1. Advanced Source Listing
2. Condensed Source Listing
3. Perform Range Hierarchy chart
4. Structure chart

II       Data 1. Enhanced Data Cross-Reference 
2. Data Division report
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Figure 13 �  Table of Contents Report

III     General 1. Subsets report
2. Verb Summary
3. COPY Statement report
4. CALL Statement report
5. Paragraph Cross-Reference
6. Perform Range Usage and Interface report
7. Program Exception report
8. Metrics and Related reports

IV     Compiler Output

V      Master Index

Category Contents
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Report Field Descriptions
These are the Table of Contents report field descriptions:

Program Summary
The page following the Table of Contents shows program summary information (see 
Figure 14 on page 41). This is the information included in the Program Summary: 

� Number of lines in the source program

� Number of statements in the IDENTIFICATION DIVISION

� Number of statements in the ENVIRONMENT DIVISION

� Number of statements in the DATA DIVISION

� Number of statements in the PROCEDURE DIVISION

� Metrics values for the program

� Numbers of various types of COBOL statements

� Number of data item modifications without subsequent uses

� Number of data item uses without initialization

� Parameters specified for this execution of SmartDoc

� Options in effect for this execution of SmartDoc

� Type of analysis performed for this program

Field Description

(A) Program author from the Identification Division.

(B) List of reports generated for this execution of SmartDoc.

(C) Page number where the particular report begins.

(D) Program name.
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Figure 14 � Program Summary

Report Field Descriptions
These are the Program Summary report field descriptions:

Field Description

(A) Summary information, including the number of statements in each division, 
metrics values for the program, numbers of various COBOL statements in the 
program, and the number of data exceptions.

Note:
Number of COBOL copy statements is the number of copy statements 
resolved by the COBOL compiler only.

(B) List of the VIAIN DD statement parameters in effect for this execution of 
SmartDoc.

(C) Options in effect for this execution of SmartDoc.

(D) Type of analysis performed for this program.
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Advanced Source Listing
The Advanced Source Listing provides you with information for tracing program logic, 
and for understanding the program data flow that enhances and replaces the COBOL 
compiler listing. The source code prints in the same format as the original source file with 
the exception of the SKIP and EJECT compiler directives (these function in the same 
manner as in the compiler listing). Two formats are produced: one for the DATA 
DIVISION, and a second for the PROCEDURE DIVISION.

For COBOL II Release 3 and later programs containing internal subprograms, SmartDoc 
produces a separate Advanced Source Listing for each subprogram.

Advanced Source Listing for the DATA DIVISION
SmartDoc produces two types of DATA DIVISION reports depending on the type of 
analysis performed.

Analysis with Compile
The source code prints when the Analysis job runs with a compile, and displays the 
extracted compiler DMAP information for each data item merged into the listing on the 
right side of the report (a DC or a DA analysis). This is the DMAP information:

Field Description

BASE Base locator cell for a COBOL data item used internally to 
reference the data item.

DISPLACEMENT Relative offset of the data item within the base locator cell.

DEFINITION Assembly language internal definition of a data item.

COMPILER FLAGS Compiler flags, generated by the COBOL compiler, identify 
types of data items. These are the flags for COBOL II:

D = dataname is the object of an OCCURS 
DEPENDING clause.

E = dataname is EXTERNAL.

F = file is fixed length.

FB = file is fixed length and blocked.

G = a GLOBAL.

O = an OCCURS clause.
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The first reference line number in the PROCEDURE DIVISION is indicated, unless the 
data item is not used. If the data item is not used, the first reference line number is 
indicated as DEADDATA. The first reference refers to the data item in source sequence.

Figure 15 on page 44 shows an Advanced Source Listing for the DATA DIVISION, 
produced by a DC or a DA type of analysis.

OG = the group has its own length definition.

R = dataname redefines another dataname.

S = a spanned file.

U = an undefined format file.

V = a variable length file.

VB = a variable length blocked file.

USAGE Access method for an FD, or a description of how a data item 
is used.

Field Description
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Figure 15 � Advanced Source Listing (DC or DA Analysis) DATA DIVISON
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Report Field Descriptions Analysis with Compile
These are the Analysis with Compile report field descriptions:

Field Description

(A) Line numbers generated by the analyze job. All line number references 
throughout the SmartDoc reports are based on these numbers.

(B) Source lines.

(C) Base locator cell used internally to reference the data item.

(D) Displacement or the relative offset of the data item within the base locator cell.

(E) Assembly language internal definition of the data item.

(F) Compiler generated flags that identify the type of data item listed.

(G) Usage of the data item or of the file as defined in the COBOL program.

(H) First reference of the data item in source sequence.
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Analysis without Compile
In this analysis, the first reference line number in the PROCEDURE DIVISION is 
indicated when the Analysis job runs without a compile (a DS or a DX analysis), unless 
the data item is not used. If the data item is not used the first reference line number is 
indicated as DEADDATA. The first reference refers to the source sequence data item. 
Figure 16 shows the Advanced Source Listing produced by a DS or a DX type of 
analysis.

Figure 16 � Advanced Source Listing (DS or DX Analysis) - DATA DIVISION
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Report Field Descriptions Analysis without Compile
These are the Analysis without Compile report field descriptions:

Advanced Source Listing for the PROCEDURE DIVISION
The source code PROCEDURE DIVISION prints information about each line on the 
right side of the report. This information includes these items:

Control flow information. Control flow information shows how a statement is 
executed (PERFORM, GO TO, FALLTHRU, ENTRY, etc.), and how the flow continues 
to the next logical statement (PERFORM, GO TO, FALLTHRU, EXIT, RETURN, etc.). 
Use this information when tracing the logical flow of the program. Unexecutable code is 
indicated as DEADCODE.

Data flow information. Data flow information displays for each data item in a source 
line. The location of the data item definition is shown each time the data item is 
referenced. The location of the previous modification that set the current value displays if 
the reference is a USE. If the reference is a MODIFICATION, the location of the next use 
of the value is shown. Use this information when tracing data item usage.

Data items. Data items used without first being initialized are referenced as 
NO-VALUE. Data items modified without subsequently using the assigned value are 
referenced as NO-USE.

Special registers. Special registers are referenced as D-COBOL. Special registers are 
not included in the DATA DIVISION, therefore they are outside the bounds of the 
program. SmartDoc is unable to determine processing outside the bounds of the program, 
and refers to the special registers as being defined by COBOL.

CICS defined data items. CICS defined data items are referenced as D-CICS when a 
program containing command level CICS is analyzed without using the CICS 
preprocessor.

Field Description

(A) Line numbers generated by the analyze job. All line number references 
throughout the SmartDoc reports are based on these numbers.

(B) Source lines.

(C) First reference of the data item in source sequence.
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Data cross-reference information. If you did not perform an extended program 
analysis, data flow information is unavailable and data cross-reference information shows 
instead (See Chapter 11, "Analyze," on page 159 for information on the analyze features.) 
Data cross-reference information lists the previous and next reference to the address 
space named by a data item, in source sequence. Cross-references are based on generated 
line numbers in the report.

Occasionally, control and data flow information exceeds available report space causing 
an overflow. An overflow causes all control and data flow information for that source line 
to move to the overflow area at the bottom of the page where the source line displays. 
Insufficient space at the bottom of the page causes all previous overflow for that page to 
print, then the new overflow prints on the next page.

A symbol legend prints at the bottom of each report page. These symbols correspond to 
the control flow and data flow information shown to the right of each PROCEDURE 
DIVISION source statement. 

These are the control flow symbols:

Symbol Description

<- Indicates where control was passed from.

-> Indicates where control is being passed.

- G Control is transferred by a GO TO.

I Control is transferred by an internal call, for COBOL II Release 3 and 
later programs.

P Control is transferred by a PERFORM.

R Control RETURNs to the specified line.

C Control is transferred by an ON CONDITION exception or by a 
DECLARATIVE.

FALLTHRU Indicates processing falls through to the next statement.

PGM EXIT Control EXITs the program.

PGM ENTRY Program execution begins here.

DEADCODE Source line contains unexecutable code.
48



5   Reports
These are the data flow symbols:

When a source line contains multiple data items, each data item reference is enclosed in 
parentheses and listed in the order it displays in the source.

Data flow analysis information is unavailable when a short SmartDoc analysis is 
performed. Cross-referenced information is shown with these symbols:

� D�the reference is to the definition of the data item

� P�the previous reference of the data item

� N�the next reference of the data item

These figures illustrate the Advanced Source Listing for the PROCEDURE DIVISION:

� The Advanced Source Listing produced by a DA analysis is shown in Figure 17 on 
page 50. 

� The Advanced Source Listing produced by a DX analysis is shown in Figure 18 on 
page 52.

� The Advanced Source Listing produced by a DC analysis is shown in Figure 19 on 
page 54.

� The Advanced Source Listing produced by a DS analysis is shown in Figure 20 on 
page 56.

Symbol Description

D Definition of the data item.

M Previous modification of the data item.

U Next use of the data item.

E Possible external modification. An external modification occurs when a 
data item is passed to a called program and is modified by the called 
program.

D-CICS Data item defined by CICS.

D-COBOL Special register. This data item also includes implicitly used registers. 
For example, CALL statements are marked as D-COBOL because the 
return code register is affected by the CALL.

D-IDMS Data item defined by IDMS.

D-SQL Data item defined by SQL.
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Extended SmartDoc Analysis with Compile (DA Analysis)

Figure 17 � Advanced Source Listing (DA Analysis) - PROCEDURE DIVISION
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Report Field Descriptions
These are the Extended SmartDoc with Compile (DA Analysis) report field descriptions:

Field Description

(A) Line numbers generated by the analyze job. All line number references 
throughout the SmartDoc reports are based on these numbers.

(B) PROCEDURE DIVISION source lines.

(C) Displacement of the statement into the CSECT. Use this information when 
debugging a program. For example, when a program abends, you can calculate 
the displacement by using the PSW address and the load point to determine the 
source statement where the problem actually occurred.

(D) Control flow and data flow information. Control flow information shows how a 
statement executes and how the flow continues to the next logical statement. 
Data flow information shows the definition, previous modification of a data 
item, and the next data item use.

(E) Symbol legend used to identify control flow and data flow.
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Extended SmartDoc Analysis without Compile (DX Analysis)

Figure 18 � Advanced Source Listing (DX Analysis) - PROCEDURE DIVISION
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Report Field Descriptions
These are the Extended SmartDoc Analysis without Compile (DX Analysis) report fields:

Field Description

(A) Line numbers the analyze job generated. All line number references throughout 
the SmartDoc reports are based on these numbers.

(B) PROCEDURE DIVISION source lines.

(C) Control flow and data flow information. Control flow information shows how a 
statement gets executed and how the flow continues to the next logical statement. 
Data flow information shows the definition, previous modification of a data item, 
and the next data item use.

(D) Legend of symbols used to identify control flow and data flow.
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Short SmartDoc Analysis with Compile (DC Analysis)

Figure 19 � Advanced Source Listing (DC Analysis) - PROCEDURE DIVISION
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Report Field Descriptions
These are the Short SmartDoc Analysis with Compile (DC Analysis) report fields:

Field Description

(A) Line numbers the analyze job generated. All line number references throughout 
the SmartDoc reports are based on these numbers.

(B) PROCEDURE DIVISION source lines.

(C) Displacement of the statement into the CSECT. Use this information when 
debugging a program. For example, when a program abends, you can calculate 
the displacement by using the PSW address and the load point to determine the 
source statement where the problem actually occurred.

(D) Control flow and data cross-reference information. Control flow information 
shows how a statement executes and how the flow continues to the next logical 
statement. Data cross-reference information shows the definition, previous 
reference, and the next data item reference.

(E) Overflow information from the statement containing more information than fits 
on the line with the PROCEDURE DIVISION source statement.

(F) Legend of symbols used to identify control flow and data flow.
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Short SmartDoc Analysis without Compile (DS Analysis)

Figure 20 � Advanced Source Listing (DS Analysis) - PROCEDURE DIVISION
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Report Field Descriptions
These are the Short SmartDoc Analysis without Compile (DS Analysis) report fields:

Field Description

(A) Line numbers the analyze job generated. All line number references throughout 
the SmartDoc reports are based on these numbers.

(B) PROCEDURE DIVISION source lines.

(C) Control flow and data cross-reference information. Control flow information 
shows how a statement executes and how the flow continues to the next logical 
statement. Data cross-reference information shows the definition, previous 
reference, and the next data item reference.

(D) Overflow information from the statement containing information than fits on the 
line with the PROCEDURE DIVISION source statement.

(E) Legend of symbols used to identify control flow and data flow.
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Advanced Source Listing for COBOL II Release 3 and Later Programs
For COBOL II Release 3 and later programs, the Advanced Source Listing uses the 
symbol I to identify calls to internal subprograms. The symbol is followed by the line 
number where the control is passed. Figure 21 and Figure 22 illustrate the Advanced 
Source Listing for the PROCEDURE DIVISION of a COBOL II Release 3 program, 
showing an internally-called subprogram. An Extended SmartDoc analysis with a 
compile has been performed (DA analysis).

Figure 21 shows the call statement, showing that control is transferred by an internal call 
to line 606.

Figure 21 � Advanced Source Listing for COBOL II Release 3 - Example 1

Figure 22 shows the code, beginning on line 606, control was transferred to in the 
previous figure.

Figure 22 � Advanced Source Listing for COBOL II Release 3 - Example 2
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Condensed Source Listing
The Condensed Source Listing (see Figure 23 on page 60) eliminates structurally 
insignificant source code statements and shows the remaining code indented 
hierarchically according to divisions, sections, and paragraphs. The IDENTIFICATION, 
ENVIRONMENT, DATA, and PROCEDURE divisions are shown on the Condensed 
Source Listing. For COBOL II Release 3 and later programs, each internally-called 
subprogram is started on a new page.

This is the list of items included on the Condensed Source Listing: 

Item Significant Program Portion

IDENTIFICATION DIVISION Division header

ENVIRONMENT DIVISION Division header
Section headers

DATA DIVISION Division header
Section headers
FD, SD, RD, CD, 01, and 77 level data items

PROCEDURE DIVISION Division header
Section and paragraph labels
GO TO statements
PERFORM statements
CALL statements
ENTRY statements
CICS statements that are structurally significant (e.g., 
LINK)
STOP RUN statements
GOBACK statements
PGM EXIT statements
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Figure 23 � Condensed Source Listing

Report Field Descriptions
These are the Condensed Source Listing report fields:

Field Description

(A) Source code line numbers.

(B) Significant source code statements that show the structure of the program.
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Perform Range Hierarchy Chart
The Perform Range Hierarchy Chart (see Figure 24 on page 62) shows the perform range 
execution relationships (not the execution sequence of the program) in an indented list. 
Each relative PERFORM nesting level is also shown. When SmartDoc produces the 
diagram, these various conditions can occur:

� If the list is too long (vertically) to fit on a page, it continues on the next page.

� If the list is too wide (horizontally) to fit on a page, the item that does not fit and its 
subordinates display on the next page with no other information. The location 
where the item would have displayed contains a reference to the page where it does 
display (by name and page number).

� If a perform range is called from multiple places, and it is not a terminal PERFORM 
(a PERFORM that does not perform anything else), the perform range is shown or 
is given a cross-reference (based on the DUPPERF option). The cross-reference is 
by name and page number to the first occurrence where the full structure is defined. 
The DUPPERF option determines if a perform range is repeated on the Perform 
Range Hierarchy Chart each time it is called.

Note:
The DUPPERF option can produce a lengthy Perform Range Hierarchy Chart if the 
program contains many perform ranges called from multiple places.

For COBOL II Release 3 and later programs containing internal subprograms, a separate 
Perform Range Hierarchy Chart is produced for each subprogram.

Use these options to produce the Perform Range Hierarchy Chart:

Option Description

Gotos option GO TO and ALTER statements are also included in the report.

Conditionals option Conditionals that affect the PERFORM, CALL, GO TO, and 
ALTER statements are also included. When you select the 
Conditionals option, the Gotos option is automatically selected.
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Figure 24 � Perform Range Hierarchy Chart

Report Field Descriptions
These are the Perform Range Hierarchy Chart fields:

Field Description

(A) Line number as generated for the Perform Range Hierarchy Chart.

(B) Perform range level including all nested perform ranges.

(C) Each perform range and the code included in that range as a unit.
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Perform Range Hierarchy Chart for COBOL II Release 3 and Later Programs
For COBOL II Release 3 and later programs, the Perform Range Hierarchy Chart (see 
Figure 25) places the word INTERNAL after the call statement to identify 
internally-called subprograms.

Figure 25 � Perform Range Hierarchy Chart for COBOL II Release 3

Perform Range Hierarchy Chart - Gotos and Conditionals Options
To include GO TO and ALTER statements in the report, follow this step:

� Select the Perform Range Hierarchy Chart Gotos option. 

To include the structurally relevant conditional statements associated with the 
PERFORM, CALL, GO TO, and ALTER statements in the report, follow this step:

� Select the Perform Range Hierarchy Chart Conditionals option.

To automatically select the Gotos option, follow this step:

� Select the Conditionals option. 
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Figure 26 shows the Perform Range Hierarchy Chart, including the Gotos and 
Conditionals options.

Figure 26 � Perform Range Hierarchy Chart - Gotos & Conditionals Options

Structure Chart
The Structure Chart (see Figure 27 on page 65) presents the program execution order 
graphically, and shows the relationships between the logical units of the program. Logical 
units are called programs and performed paragraphs or sections. 

Note:
The Structure Chart does not show the information in execution sequence.

Structure Charts are produced in Page Mode, Tile Mode, or Bird�s Eye View. Page Mode 
produces a Structure Chart that fits in a notebook. Tile Mode produces a large Structure 
Chart in pieces that form a single chart when taped together. Bird�s Eye View produces 
the Structure Chart in a highly condensed format that shows the entire program in a 
minimum number of pages.
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These are the options used to produce the Structure Chart:

Figure 27 shows the different Structure Chart output types.

Figure 27 � Structure Chart Components

These notes correspond to the numbers in Figure 27.

Option Description

Gotos option GO TO and ALTER statements are included in the report.

Conditionals option Conditionals that affect the PERFORM, CALL, GO TO, and 
ALTER statements are also included. Select the Conditionals 
option to automatically select the Gotos option.

Field Name Description

1, 3, 5 Legend Pages These pages give you instructions on how to use the chart that 
immediately follows.

2 Bird's Eye View A Structure Chart produced in Tile Mode format with a box 
size of 1 x 1 (in characters).

4 Tile Mode 
Structure Chart

Structure Chart consisting of pages that can be taped 
together.

6 Page Mode 
Structure Chart

Structure Chart that fits in a notebook. Wherever possible, 
this type of Structure Chart shows a parent and all of its 
subordinates (called paragraphs or sections) on the same 
page. If the parent and its subordinates do not fit on a page, 
they are shown on a separate page as a substructure.
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The Structure Chart presents each logical unit as a box with lines going to or coming from 
it. The lines indicate the execution order. When you specify Page Mode TO PAGE, the 
page numbers are shown instead of the box, and a connected box is continued on the next 
page. A diagram continued from another page is shown as FROM PAGE(S) followed by 
the page number(s).

A perform range called from multiple places that is not a terminal PERFORM (a 
PERFORM that does not perform anything else) is shown or given a cross-reference 
(based on the DUPPERF option). This cross-reference is by name and page number to the 
first occurrence where the full structure is defined. The DUPPERF option determines if a 
perform range is repeated on the Structure Chart each time it is called. Using the 
DUPPERF option can produce a lengthy Structure Chart if the program contains many 
perform ranges called from multiple places.

Note:
The DUPPERF option only applies to Structure Charts produced in Tile Mode. 
NODUPPERF is implicit for Structure Charts produced in Page Mode.

Figure 28 identifies the format of the logical units of the Structure Chart.

Figure 28 � Structure Chart Format
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Report Field Description

These are the Structure Chart Format fields:

For COBOL II Release 3 and later programs containing internal subprograms, SmartDoc 
produces a separate Structure Chart for each subprogram.

Field Description

FROM 
PAGE(S)

If this unit is called from other pages, this text lists the calling pages.

pp Page number(s).

mmm Number of times the unit is called from this parent.

nnn Total number of calling units.

xxxxxxx Name of the unit.

R Recursive perform.

ccc Number of called units displaying on other pages.

TO PAGE If the called units do not display on this page, this text lists the page of the 
called unit.
67



 ASG-SmartDoc User�s Guide
Bird's Eye View
The Bird's Eye View is a Tile Mode Structure Chart that condenses each box to one 
character (see Figure 29). These are the characters the Bird's Eye View displays, and their 
meanings:

Figure 29 �  Structure Chart - Bird�s Eye View

Report Field Description

A. This field shows the Bird's Eye View program structure. 

Field Description

O Perform unit on the Structure Chart. This can be a perform range, GO TO, 
CALL, or a conditional statement.

+ Conditional control transfer by a GO TO, CALL, or a perform range.

V Unit is a reuse (or recursive) use of a unit previously defined on the diagram.
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Page Mode
Page Mode produces the Structure Chart in a format designed to be placed in a notebook, 
as shown in Figure 30.

Figure 30 � Structure Chart - Page Mode

Report Field Description

A. This field show the graphical program structure.
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Page Mode with Gotos and Conditionals Options
To include the GO TO and ALTER statements in the report, follow this step:

� Select the Structure Chart Gotos option.

To include the structurally relevant conditional statements associated with the 
PERFORM, CALL, GO TO, and ALTER statements in the report, follow this step: 

� Select the Structure Chart Conditionals option.

To automatically select the Gotos option, follow this step:

� Select the Conditionals option.

Figure 31 shows the Page Mode Structure Chart, including the Gotos and Conditionals 
options.

Figure 31 � Structure Chart - Page Mode with GOTOs & Conditionals
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Page Mode Overflow Substructure
The Overflow Substructure shown in Figure 32 lists the called paragraphs or sections of a 
logical unit that do not fit on the appropriate page of the Structure Chart.

Figure 32 � Structure Chart - Page Mode (Overflow Substructure)

Report Field Description

A. This field shows the parent and its subordinates as an overflow substructure, with 
connecting FROM and TO pages indicated.
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Tile Mode
Tile Mode produces the Structure Chart shown in Figure 33 in a format designed to be 
taped together into one large diagram of the entire program.

Figure 33 � Structure Chart - Tile Mode

Report Field Description

A. Graphical source code hierarchy. 
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Structure Chart for COBOL II Release 3 and Later Programs
For COBOL II Release 3 and later programs, the Structure Chart places the word 
INTERNAL after the call statement in any appropriate box to identify internally-called 
subprograms (see Figure 34).

Figure 34 � Structure Chart for COBOL II Release 3
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Enhanced Data Cross-Reference Report
The Enhanced Data Cross-Reference report (see Figure 35 on page 75) cross-references 
all program data entities, and lists all data items and related definitions alphabetically, 
including special registers, figurative constants, and literals. This report references each 
data item to where it is directly or indirectly used or modified. The locations where 
aliases are defined, modified, or used are also indicated.

The Enhanced Data Cross-Reference report helps you to answer your data questions. 
Each data item is referenced to locations where it is used or modified. The report 
indicates data that was neither used or modified as DEADDATA. Additionally, each data 
item is referenced to aliases (i.e., renames or redefines) eliminating the manual searches 
through the listing to locate where a data field is used or modified.

A symbol legend prints at the bottom of each report page. These symbols correspond to 
the reference information shown to the right of each data item. These are the descriptions 
for each of these symbols:

For COBOL II Release 3 and later programs containing internal subprograms, SmartDoc 
produces a separate Enhanced Data Cross-Reference report for each subprogram. The 
reports identify Global data items as GLOBAL.

Field Description

A Data item alias definition (renames or redefines).

I Indirect modification of the data item value if it is on the line with MODS. This 
occurs due to a rename, or to a secondary name modification such as a renamed 
or a redefined data item. The reference is to an indirect use of the data item value 
if it is on the line with USE. This occurs due to the value being used by a 
secondary name such as a renamed or a redefined data item.

# Data item that has not been initialized, or a data item that was modified without 
a subsequent reference or use of that value.
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Figure 35 � Enhanced Data Cross-Reference Report
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Report Field Descriptions
These are the Enhanced Data Cross-Reference report field descriptions:

Subset Report
The Subset report (see Figure 36 on page 77) identifies logical groups of subsets. A 
subset is a group of statements containing similar COBOL verbs. For example, lines that 
contain READ, WRITE, OPEN, or CLOSE verbs can be referenced as an IO subset. The 
Subset report shows the paragraph page and line number where a particular subset is 
located. If there are no source statements for a subset, (NONE) displays for that subset.

For COBOL II Release 3 and later programs, the containing Paragraph/Division is 
qualified by the containing program. 

See the table contained in "Subsets" on page 10 for a list and description of subsets 
supported by SmartDoc.

Field Description

(A) Alphabetical program data item listing including figurative constants, string 
constants, and COBOL special registers.

(B) Each data item is cross-referenced based on whether it is defined, used, or 
modified. If the data item is a literal, the reference shows LITERAL followed by 
where that literal is used. References are shown as p/n, where p is the page 
number of the Advanced Source Listing and n is the line number on that page 
where the data item occurs.

(C) Legend that indicates the symbol value corresponding to the cross-reference 
information.
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Figure 36 � Subset Report

Report Field Descriptions
These are the Subset report field descriptions:

Field Description

(A) Subset group followed by the paragraphs and/or division names containing 
statements with that particular subset type. When there are no statements for the 
indicated subset, (NONE) is shown.

(B) Reference to the page and line number on the Advanced Source Listing where the 
statement containing that subset type is located.
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Subset Report for COBOL II Release 3 and Later Programs
For COBOL II Release 3 and later programs, the Subset report (see Figure 37) lists the 
program name before each Paragraph/Division name.

Figure 37 � Subset Report for COBOL II Release 3
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Data Division Report
The Data Division report (see Figure 38) provides detailed information about all 01 
structures in the DATA DIVISION of a program. This is the information on the Data 
Division report: 

� COBOL level number

� Dataname

� Length

� Starting and ending position

� Format

� Picture clause definition

� COPY member name where the data item is defined (if applicable)

Figure 38 � Data Division Report

Report Field Descriptions
These are the Data Division report field descriptions:

Field Description

(A) Name of the record containing the specified data items.

(B) Name of the copy member where the record is defined, if applicable.
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Verb Summary Report
The Verb Summary report (see Figure 39 on page 81) cross-references COBOL verbs to 
the lines where they are used. You can include a Verb Frequency Table at the end of the 
Verb Summary report. This report presents how many times each verb is used, and the 
percentage of its use in relation to the total verb count.

Use this report to determine how much a particular verb, or a set of verbs, is used. The 
Verb Frequency Table helps you determine if the program is using verbs according to 
standards. For example, many standards require that you use a single paragraph to read a 
file, and that the paragraph perform each time the file is read. If the report lists multiple 
READ verbs, the program might not adhere to the established standards.

The Verb Summary report displays verb usage with context information. Often, a report 
containing this information is half the size of the source listing. Regardless, a large 
program can still produce a lengthy Verb Summary report. 

To limit report size, follow this step:

� Set the parameters to suppress the Verb Summary report portion or the Verb Frequency 
Table portion.

For COBOL II Release 3 and later programs containing internal subprograms, SmartDoc 
produces a separate Verb Summary report for each subprogram.

(C) COBOL level number for the data item. These are the levels that are reported:
� All 01through 49 levels except 01s with no subitems

� All 88 levels

� All 66 levels

(D) Name of the data item reported (displays up to 32 characters).

(E) Location of the data item. The starting position is listed in the FROM column; the 
ending position is listed in the TO column.

(F) Length of the specified data item.

(G) Format specified for the data item. These formats may display: GROUP, ALPHA 
(alphabetic), ALPNUM (alphanumeric), NUMRIC (numeric).

(H) PICTURE definition for the data item, if applicable.

Field Description
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Figure 39 and Figure 40 on page 82 illustrate the Verb Summary report and the Verb 
Frequency Table.

Figure 39 � Verb Summary Report

Report Field Descriptions
These are the Verb Summary report field descriptions:

Field Description

(A) Advanced Source Listing page and line number where that verb is used.

(B) Statement containing dead code, or data contains DEAD in this field.

(C) Verb along the source statement context that fits on the report line.

(D) Legend that indicates an asterisk (*) is placed at the end of the source line in the 
context area when the entire statement cannot be shown.
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Verb Frequency Table
The Verb Frequency Table (see Figure 40) presents a count of the times each verb is 
used, and the percentage of its use in relation to the total verb count.

Figure 40 � Verb Summary Report - Verb Frequency Table

Report Field Descriptions
These are the Verb Frequency table field descriptions:

Copy Statement Report
The Copy Statement report shown in Figure 41 on page 83 lists COPY directives used 
within the program, including these items:

� COBOL COPY statement

� Librarian -INC statement

� Panvalet ++INCLUDE statement

� COPY IDMS statement

Field Description

(A) Each verb in the program is listed in this field. INTERNAL CALL displays 
only for COBOL II Release 3 and later programs.

(B) Number of times each verb was used in the program.

(C) Verb usage percentage in relation to the total verb count.
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� COPYDD statement

� EXEC SQL INCLUDE statement

� User-specified source managers

Use the Copy Statement report to recognize program portions that may be contained in 
external datasets. These are the ways information is presented on the report:

� The actual statement

� Page and line number containing the statement

� Division where the statement occurs

� Name of the dataset containing the copied or the included member

For COBOL II Release 3 and later programs, the division containing the statement is 
qualified by the containing program.

The copy or the include member expands in the Advanced Source Listing.

Figure 41 � Copy Statement Report

Report Field Descriptions
These are the Copy Statement report field descriptions:

Field Description

(A) Advanced Source Listing page and line number where the statement occurs.

(B) DIVISION where the statement occurs.

(C) Source statement.

(D) Dataset name from where the member is copied.
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Copy Statement Report for COBOL II Release 3 and Later Programs
For COBOL II Release 3 and later programs, the Copy Statement report lists (see 
Figure 42) the program name before each Division name.

Figure 42 � Copy Statement Report for COBOL II Release 3

Call Statement Report
The Call Statement report (see Figure 43 on page 85) lists the source code lines that use 
the COBOL CALL statement. Use this report to determine how control passes to other 
programs. These are the ways information is presented on this report:

� The actual CALL statement

� Page and line number containing the statement

� Arguments in the USING clause

If the called program exists in the AKR, the Call Statement report shows if it is returning 
or non-returning (RET or NORET). If you mark a program or a group of programs as 
returning or non-returning during installation, the report marks them as RET or NORET. 
Called programs that do not exist in the AKR are shown with an asterisk (*) preceding the 
page and line number. This report also indicates whether each item in the USING clause 
is an IN or an OUT parameter. IN parameters are used before any modifications occur to 
the passed value of the parameter. OUT parameters are modified by the called program. 
CALL statements that cannot be executed display as DEADCODE.

For COBOL II Release 3 and later programs, the Call Statement marks CALLs by the 
type of call (internal or external).
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Figure 43 � Call Statement Report

Report Field Descriptions
These are the Call Statement report field descriptions:

Field Description

(A) Page and line number where the CALL statement occurs in the Advanced 
Source Listing. An asterisk (*) preceding a page and line number indicates the 
CALLed program does not exist in the AKR.

(B) A Yes displayed in this field indicates the CALLed program returns. 
SmartDoc determines if a program is returning or non-returning based on the 
RET and NORET parameters.

(C) Source statement containing the CALL verb.

(D) Legend of symbols used to indicate whether an item in the USING clause is 
an IN or an OUT parameter.
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Call Statement Report for COBOL II Release 3 and Later Programs
For COBOL II Release 3 and later programs, SmartDoc adds the TYPE field to the Call 
Statement report (see Figure 44). The TYPE field identifies each call as an INT (internal 
call) or an EXT (external call).

Figure 44 � Call Statement Report for COBOL II Release 3

Paragraph Cross-Reference Report
The Paragraph Cross-Reference report (see Figure 45 on page 87) lists the paragraphs 
and the sections in the program and shows how they execute. Use this report to determine 
how a paragraph gets executed, and the paragraphs it executes. Control is passed to 
another paragraph based on these factors:

� GO TO statements

� PERFORM statements

� ALTER statements

� Fall through logic

� PERFORM and internal CALL return processing

� ON CONDITION statements

� Internal CALL information (COBOL II Release 3 and later)

Paragraphs that transfer control or reference another paragraph are listed by page and line 
number. Unreferenced paragraphs are shown as DEADCODE.

For COBOL II Release 3 and later programs containing subprograms, SmartDoc 
produces a separate Paragraph Cross-Reference report for each subprogram. The 
Paragraph Cross-Reference report also includes internal CALL information.
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Figure 45 � Paragraph Cross-Reference Report

Report Field Descriptions
These are the Paragraph Cross-Reference report fields:

Field Description

(A) Each paragraph or section name in the program is listed with the page and line 
number where it occurs in the Advanced Source Listing.

(B) How control was passed to the paragraph (PERFORM, FALLTHRU, GOTO, 
etc.).

(C) Paragraph or section where control passed, along with the page and line 
number where it occurs in the Advanced Source Listing.

(D) How control is being passed to another paragraph (PERFORM, FALLTHRU, 
GOTO, etc.).
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Paragraph Cross-Reference for COBOL II Release 3 and Later Programs
For COBOL II Release 3 and later programs, the Paragraph Cross-Reference report (see 
Figure 46) qualifies the target paragraph/section name with the program name.

Figure 46 � Paragraph Cross-Reference for COBOL II Release 3

(E) Paragraph or section where control is being passed.

(F) Legend that describes how control is passed to or from the paragraph.

Field Description
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Perform Range Usage and Interface Report
The Perform Range Usage and Interface report lists the paragraphs and sections that 
invoke a perform range. A perform range consists of all the code executed by following a 
PERFORM statement. The report shows each perform range along with a cross-reference 
to the paragraph(s) that invokes it.

This report also shows the INPUTS and OUTPUTS of each perform range. INPUTS 
(shown on the report as IN) are the data items modified before entry into the performed 
paragraph and used within the perform range. OUTPUTS (shown on the report as OUT) 
are the data items modified within the perform range, then subsequently used elsewhere 
in the program. USE and MOD are data items referenced inside the perform range.

Paragraphs that call for perform range execution are identified as well. This report shows 
you how perform ranges are used, and how data in perform ranges affects other program 
areas.

If an Extended SmartDoc analysis is not performed, INPUTS and OUTPUTS are 
unavailable and only USE and MOD information is shown.

Perform Range Usage and Interface for COBOL II Release 3 and Later 
Programs

For COBOL II Release 3 and later programs containing subprograms, SmartDoc 
produces a separate Perform Range Usage and Interface report for each subprogram.
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Extended Analysis (DX or DA)
Figure 47 shows the Perform Range Usage and Interface report produced by an extended 
analysis, with a compile (DA) or without a compile (DX). 

Figure 47 � Perform Range Usage & Interface Report (DX or DA Analysis)

Report Field Descriptions
These are the Perform Range Usage & Interface report (a DX or a DA analysis) fields:

Field Description

(A) Perform range in the program is listed.

(B) Paragraph or section that invokes the PERFORM. The page and line number 
where the PERFORM is invoked is also shown.
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Short Analysis (DS or DC)
Figure 48 shows the Perform Range Usage and Interface report produced by an Extended 
SmartDoc analysis, with a compile (DC) or without a compile (DS). 

Figure 48 � Perform Range Usage & Interface Report (DS or DC Analysis)

(C) Each INPUT, OUTPUT, USE, and MOD of the perform range is shown with 
the page and line number where it occurs.

(D) Legend of symbols used to indicate a data item as an input or an output.

Field Description
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Report Field Descriptions
These are the Perform Range Usage & Interface report (DS or DC analysis) fields:

Program Exception Report
The Program Exception report lists conditions that may cause the program to fail or 
execute differently than intended. These are the items reported on the Program Exception 
report:

Field Description

(A) Each perform range in the program is listed.

(B) Paragraph or section that invokes the PERFORM. The page and line number 
where the PERFORM is invoked is also shown.

(C) Each use and modification of the perform range is shown with the page and 
line number where it occurs.

(D) Legend of symbols used to indicate if a data item is an input or an output.

Field Description

MODIFICATION 
WITHOUT USE

Value other than the assigned value modified a data item 
(or a subfield of it).

UNINITIALIZED USE Data item (or a subfield of it) was used without first being 
initialized.

Note:
Data items initialized by external calls to non-COBOL 
programs may display as uninitialized uses.

RECURSION Recursion generally occurs when a paragraph or a perform 
range performs itself. This programming technique can 
lead to endless loops.

OUT OF PERFORM 
JUMP

An exit is made from a perform range, due to the use of a 
GO TO, bypassing the normal perform range return to the 
line following the perform statement.
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Program Exception Report for COBOL II Release 3 and Later Programs

For COBOL II Release 3 and later programs, SmartDoc qualifies data items and 
paragraphs by the containing program within the Program Exception report.

These figures illustrate the Program Exception report:

� The Program Exception report produced by a DX or a DA type of analysis is shown 
in Figure 49 on page 94.

� The Program Exception report produced by a DS or a DC type of analysis is shown 
in Figure 50 on page 96.

LIVE EXITS Live exits are exits from perform ranges left dangling by 
overlapping PERFORMs and GOTOs in the original 
performed paragraphs. Internally, the COBOL compiler 
creates a jump statement to return to the caller at the end of 
a perform range. When the jump is actually performed, the 
jump statement is cleared. If an exit is made from the 
perform range before the jump statement is cleared (the 
normal flow is changed), the internal jump statement is left 
live. If an overlapping perform range is subsequently 
executed, the jump statement set by the original perform 
range is still live and causes the program to jump back to 
the location of the first caller to that perform range. This 
results in the program not executing as expected.

DEADDATA Unreferenced data items or data items only referenced in 
DEADCODE. If a dead data item is included by a COPY 
statement, it is marked as DEAD IN COPY. Otherwise, 
items are marked as DEAD NOT IN COPY. 

DEADCODE PROCEDURE DIVISION statements never executed 
under any conditions. If a dead statement is included by a 
COPY statement, it is marked as DEAD IN COPY. 
Otherwise, it is marked as DEAD NOT IN COPY. 

Field Description
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Extended Analysis (DX or DA)
Figure 49 shows the Program Exception report produced by an Extended SmartDoc 
analysis with a compile (DA) or without a compile (DX).

Figure 49 � Program Exception Report (DX or DA Analysis)
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Report Field Descriptions
These are the Program Exception report (DX or DA analysis) fields:

Field Description

(A) Modifications without subsequent use(s) - uses without prior initialization(s) 
within this program section heading.

(B) Data items that have been used without being initialized, and data items that 
have not been subsequently used after being modified.

(C) Data items that have been used without being initialized are indicated with 
USE. Data items modified without subsequently using the value are indicated 
with MOD.

(D) Page and line number on the Advanced Source Listing where the data item is 
located.

(E) List of Recursion section heading.

(F) Each perform range or each paragraph that performs itself is listed along with 
the page and line number on the Advanced Source Listing where the recursion 
occurs.

(G) List of Out-of-Perform Jumps section heading.

(H) Perform range that contains an out of perform jump is identified.

(I) Page and line number on the Advanced Source Listing where the PERFORM 
statement that caused the out of perform jump is located.

(J) Statement that caused the out of perform jump.

(K) List of Live Exits section heading.

(L) Perform range that contains a live exit is indicated.

(M) Statement that caused the live exit.

(N) Page and line number on the Advanced Source Listing where the perform 
range containing the live exit is located.

(O) List of Dead Data section heading.

(P) Each page and line number containing dead data.

(Q) List of Dead Code section heading.
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Short Analysis (DS or DC)

Figure 50 shows the Program Exception report produced by a short SmartDoc analysis 
with a compile (DC) or without a compile (DS).

Figure 50 � Program Exception Report (DS or DC Analysis)

(R) Each paragraph that contains dead code is identified.

(S) Page and line number on the Advanced Source Listing where the paragraph 
containing dead code is located.

Field Description
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Report Field Descriptions
These are the Program Exception report (a DS or a DC analysis) fields: 

Field Description

(A) Modifications without uses (uninitialized uses within this program section 
heading).

(B) Data items that have been used without being initialized, and data items that 
have not been subsequently used after being modified.

(C) Data items that have been used without being initialized with USE. Data items 
modified without subsequently using the value are indicated with MOD.

(D) Page and line number on the Advanced Source Listing where the data item is 
located.

(E) List of Recursion section heading.

(F) Each perform range or each paragraph that performs itself along with the page 
and line number on the Advanced Source Listing where the recursion occurs.

(G) List of Out-of-Perform Jumps section heading.

(H) Each perform range that contains an out of perform jump.

(I) Page and line number on the Advanced Source Listing where the PERFORM 
statement that caused the out of perform jump is located.

(J) Statement that caused the out of perform jump.

(K) List of Live Exits section heading.

(L) Each perform range that contains a live exit is indicated.

(M) Statement that caused the live exit.

(N) Page and line number on the Advanced Source Listing where the perform 
range containing the live exit is located.

(O) List of Dead Data section heading.

(P) Each page and line number containing dead data.

(Q) List of Dead Code section heading.
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Program Exception Report for COBOL II Release 3 and Later Programs
For COBOL II Release 3 and later programs, the Program Exception report (see 
Figure 51) displays the program name before each data item, perform range name, etc., 
where appropriate.

Figure 51 � Program Exception Report for COBOL II Release 3

(R) Each perform range or each paragraph that contains dead code is identified.

(S) Page and line number on the Advanced Source Listing where the perform 
range or the paragraph containing dead code is located.

Field Description
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Metrics Report
Software metrics assess the complexity, program architecture, and software quality that 
indicate the condition or state of each program. They allow you to identify programs that 
need enhancing or re-engineering.

The AKR stores program metrics information as a separate member, away from the 
program. Also, the AKR retains unlimited versions of metric data for each program, 
providing the information for the complexity versus time graphs. However, due to page 
limitations, the metrics report lists only the 25 most recent versions.

The Metrics report provides metrics information by program and by PERFORM range. 
These are the included program metrics: 

� Software Science Volume

� Cyclomatic Complexity

� Essential Complexity

� Control Variable

� GOTOFAR

The report displays the program metric information graphically. PERFORM Range 
metrics included in the report are, Cyclomatic, Essential, and GOTOFAR. The 
PERFORM range metrics information is in table format. (See Chapter 10, "Metrics," on 
page 155 for metric definitions.)

Software Science Volume and Control Variable Program Metrics
Figure 52 on page 100 shows the Software Science Volume and Control Variable Metric 
graph sections of the Metrics report. Metrics are reported by program. (See "Software 
Science Volume Metric" on page 8 and "Control Variable Metric" on page 9 for 
additional information on the metrics calculations.)
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Figure 52 � Metrics Report - Software Science Volume & Control Variable Program

Report Field Descriptions
These are the Metrics report (Software Science Volume & Control Variable Program) 
fields:

Field Description

(A) Average Software Science Volume Metric value, based on the most recent 
version of program metrics in the AKR.

(B) Graph of the Software Science Volume Metric. Each column on the graph 
represents one version of the program.

(C) Date each program version was analyzed.

(D) Brief description of the Software Science Volume Metric.

(E) Average Control Variable Metric value, based on the most recent version of 
program metrics in the AKR.

(F) Graph of the Control Variable Metric. Each column on the graph represents 
one version of the program.

(G) Date each program version was analyzed.

(H) Brief description of the Control Variable Metric.
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Cyclomatic Complexity and Essential Complexity Program Metrics
Figure 53 shows the Cyclomatic Complexity Metric and the Essential Complexity Metric 
sections of the Metrics report. Metrics information is reported by program. (See 
"Cyclomatic Complexity Metric" on page 9 and "Essential Complexity Metric" on page 9 
for additional information on the metrics calculations.) 

Figure 53 � Metrics Report - Cyclomatic Complexity & Essential Complexity Program

Report Field Descriptions
These are the Metrics report (cyclomatic complexity & essential complexity program) 
fields:

Field Description

(A) Average Cyclomatic Complexity value, based on the versions of program 
metrics in the AKR.

(B) Graph of the Cyclomatic Complexity Metric. Each column on the graph 
represents one version of the program.

(C) Date each program version was analyzed.

(D) Brief description of the Cyclomatic Complexity Metric.
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GOTOFAR Program Metric
Figure 54 shows the GOTOFAR Program Metric report. For more information on the 
GOTOFAR metric calculation, see "GOTOFAR Metric" on page 9.

Figure 54 � Metrics Report - GOTOFAR Program Metrics

(E) Average Essential Complexity value, based on the versions of program 
metrics in the AKR.

(F) Graph of the Essential Complexity Metric. Each column on the graph 
represents one version of the program.

(G) Date each program version was analyzed.

(H) Brief description of the Essential Complexity Metric.

Field Description
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Report Field Descriptions
These are the Metrics report (GOTOFAR program metrics) fields:

PERFORM Range Metric Report
Figure 55 shows the PERFORM Range Metrics section of the Metrics report. Metrics are 
reported by PERFORM range.

Figure 55 � Metrics Report - PERFORM Range Metrics Report Field Descriptions

Field Description

(A) Average GOTOFAR value, based on the versions of program metrics in the 
AKR.

(B) Graph of the GOTOFAR Metric. Each column on the graph represents one 
version of the program.

(C) Date each program version was analyzed.

(D) Brief description of the GOTOFAR Metric.
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Report Field Descriptions
These are the Metrics report (PERFORM range metrics report field descriptions) fields:

Compiler/Optimizer Output
The Compiler/Optimizer Output incorporates the compiler and CA-Optimizer output into 
a SmartDoc report. This output consists of the memory map, PMAP or LIST (if 
requested), statistics, error messages, and unmerged DMAP items.

Figure 56 � Compiler/Optimizer Output

Field Description

(A) PERFORM range names for the calculated metrics.

(B) Cyclomatic Complexity calculated for each PERFORM range.

(C) Essential Complexity value calculated for each PERFORM range. 

(D) GOTOFAR metric calculated for each PERFORM Range.
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Report Field Description

A. This field shows the memory map and statistics for the program.

Master Index
The Master Index (see Figure 57 on page 106) is an alphabetical listing of all named 
entities in the SmartDoc reports. This report helps you determine where a particular entity 
is located in the SmartDoc reports. Use this report as the starting point for investigating a 
program item.

This is the information included on the Master Index:

� All named entities

� Figurative constants

� Literals

� Labels

� Data items

� Items implicitly defined by the environment (compiler, preprocessors, etc.)

Master Index for COBOL II Release 3 and Later Programs

For COBOL II Release 3 and later programs, Master Index entries are qualified (where 
needed) by the containing program to eliminate ambiguities.
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Figure 57 � Master Index

Report Field Descriptions
These are the Master Index fields:

Field Description

(A) Each entity in the program.

(B) Type of entity such as a literal, figurative constant, label, data item, etc. The 
page and line number where the definition of that entity is located is also 
shown.

(C) Symbol for the report and the page number where the entity is referenced.

(D) Legend of symbols used to identify the report on the referenced entity.
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This chapter describes the File pull-down and contains these sections:

File Pull-down

To display the File pull-down, follow this step:

� Select File on the action bar and press Enter. 

Note:
The File pull-down contains different actions on the Program Metrics View screen. See 
Figure 72 on page 137 for more information.

Section Page

File Pull-down 107

Analyze Submit or ASG-ESW - Prepare Program Pop-up 109

File - SmartDoc Report Pop-up 113

HTML Converter 115

ASG-ESW - AKR Utility Pop-up 126

ASG-ESW - AKR Directory Pop-up 128

File - AKR Allocate/Expand Pop-up 132
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Figure 58 � File Pull-down

Actions
These are the actions available on the File pull-down:

Field Description

1. Analyze Displays the Analyze Submit pop-up (see Figure 59 on page 109) 
used to submit a compile/analyze job.

2. Reports Displays the ASG-ESW - Prepare Program pop-up (see Figure 60 on 
page 113) used to specify what reports are generated, and to 
customize the generated reports.

3. AKR utility Displays the ASG-ESW - AKR Utility pop-up (see Figure 67 on page 
126) used to display the member list, to allocate or to expand an 
AKR, to rename a member, and to delete a member.

4. Exit Exits SmartDoc.
108



6   File
Analyze Submit or ASG-ESW - Prepare Program Pop-up                                                                      
The File - Analyze Submit and ASG-ESW Prepare Program pop-ups enable you to 
specify the information necessary to perform an analyze. Because ASG-ESW is an 
integrated suite of products, you can access the analyze function through SmartDoc 
(File - Analyze Submit pop-up) or through ASG-ESW (ASG-ESW Prepare Program 
pop-up). The information on both pop-ups is similar, but the terminology is slightly 
different. Here, we use the ASG-ESW Prepare Program pop-up.

Use the Analyze Submit or ASG-ESW - Prepare Program pop-up (see Figure 59) to 
analyze and place a program in the AKR. 

To display the Analyze Submit or ASG-ESW Prepare Program pop-up, follow this step:

�  Select File � Analyze and press Enter.

Or

Type ANALYZE on any screen and press Enter.

Figure 59 � ASG-ESW Prepare Program Pop-up
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Options
These are the Analyze Submit or ASG-ESW Prepare Program pop-up options:

Field Description

E - Edit JCL Type E to review or to change the compile/analyze JCL, if necessary. 
Select the S option to generate the JCL to edit from the JCL member 
you specified in the dataset name field (using the rules outlined in the 
Automatic JCL Modifications section). The generated JCL displays 
on the Edit screen.
When editing is complete, type SUBMIT to execute the edited JCL. 
Optionally, you can use the CREATE command to save the edited 
JCL in a partitioned dataset. Otherwise, changes made at this time are 
not saved.

S - Submit JCL Type S to submit the JCL to compile/analyze the specified program. 
The JCL submitted is generated from the JCL member specified in 
the dataset name field, applying the rules outlined in the Automatic 
JCL Modifications section.

D - SmartDoc 
Options

This field displays only if SmartDoc is installed. Type D and press 
Enter to display the File - ASG-SmartDoc Option screen (see 
Figure 60 on page 113) used to request an Extended SmartDoc 
analysis and to specify which reports (if any) to generate.
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Fields
These are the Analyze Submit ASG-ESW Prepare Program pop-up fields:

Field Description

Compile and link 
JCL (PDS or 
sequential)

Dataset name Required. The PDS member or the sequential 
dataset containing the JCL to compile and link 
the program. If the JCL resides in a source 
manager such as Librarian or Panvalet, use the 
VIASUB edit macro to submit the 
compile/analyze job.

Analyze Features

Understand Optional. This field displays only if Insight is 
installed. This analysis provides the logic and 
program execution flow capabilities of Insight. 
If Insight is the only product installed, this field 
contains YES and cannot be changed. The 
default is N.

Test Optional. This field displays only if SmartTest is 
installed. Enter Y to perform a SmartTest 
compile/analysis. This analysis provides the 
testing and debugging information required by 
SmartTest. If SmartTest is the only product 
installed, this field contains YES and cannot be 
changed. The default is Y.

Extended Analysis Optional. This field displays only if SmartTest is 
installed. This type of analysis provides 
comprehensive program analyzing capabilities 
in addition to the testing and debugging 
capabilities of SmartTest. The default is Y.
An Extended SmartDoc analysis is specified on 
the File - SmartDoc Options pop-up (see 
Figure 60 on page 113).

Document Optional. This field displays only if SmartDoc is 
installed. This type of analysis provides the 
report information generated by SmartDoc. If 
SmartDoc is the only product installed, this field 
contains YES and cannot be changed. The 
default is N.

Re-engineer Optional. YES specifies that a Encore 
compile/analysis is performed. This type of 
analysis provides the logic and program 
execution flow capabilities of Encore. The 
default is N.

Abend/Dump Optional. This field displays only if SmartQuest 
is installed. This type on analysis lets you 
analyze the source code to be used when 
diagnosing dumps. The default is N.
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AKR dataset 
name

Optional. The AKR that contains the information for the analyzed 
program.

AKR program 
name

Optional. Enter an alias name for the analyze process to use when 
saving its results in the AKR.
If you do not enter a value in this field, the results of the analyze job 
are saved in the AKR with the same name as the PROGRAM-ID 
statement name in the COBOL source.
If an AKR program name is entered, the analyzed program is saved 
in the AKR with that name, and as an alias of the PROGRAM-ID.
If the program contains ENTRY points, the analyze job saves a 
member for each ENTRY point in the AKR with an alias of the 
PROGRAM-ID.

Note:
This field is only used for the AKR program name and does not 
change the COBOL program name in the source.

Analyze options Optional. This field is used to override analyze options. Default 
options for the analyze job are established at installation time. 
Analyze options that can be entered in this field are described in 
Chapter 11, "Analyze," on page 159.

Compile? Optional. A program does not need to be compiled if Insight, Encore, 
or SmartDoc are the only features specified. To suppress the compile 
step, type N in this field. This field is forced to a value of Y if 
SmartTest and/or Extended analysis is selected.

Link load 
module 
reusable?

Optional. This field is used to test a program dynamically loaded 
under SmartTest and is tested with RUN MONITOR. You need to 
mark the load module as reusable so that the Breakpoints are retained 
across calls. The default is Y.

Field Description
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File - SmartDoc Report Pop-up
Use the File - SmartDoc Options pop-up (see Figure 60) to specify analyze options and 
display the File - Select Reports pop-up. 

To display the File - SmartDoc Options pop-up, follow this step:

� From the Analyze Submit pop-up, type D and press Enter. 

Note:
You can perform a SmartDoc analysis with another product analysis. Also, you can 
perform a SmartDoc analysis with or without generating the SmartDoc reports. Generate 
the reports or the additional reports later, without analyzing the program again.

Figure 60 � File - SmartDoc Report Pop-up
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Fields
These are the File - ASG-SmartDoc Report pop-up fields:

Field Description

Analyze Options Enter a non-blank character to select an analyze option:
Analyze Specifies that SmartDoc analyzes the current 

program. If a program in the current AKR was 
already analyzed by SmartDoc, you can generate 
reports without running another analysis job. In 
this case, do not select Analyze.

Produce Reports Specifies data flow analysis is performed for 
SmartDoc reports. Select this option to generate 
the reports selected on the File - Select Reports 
pop-up when the program is analyzed. To only 
run a compile/analyze, leave this option blank.

Extended Analysis Provides the data flow analysis for 
ASG-SmartDoc reports. N is the default.

Compile Type Y or N to execute a compile before the 
current program is analyzed. Type N if you want 
to analyze a program without generating reports.

Source AKR 
program name

Enter the program to generate SmartDoc reports. This field is only 
required when a SmartDoc analysis was done and the program resides in 
the AKR.

Actions Enter the desired action number:
Select Reports Displays the File - Select Reports pop-up used to 

specify the reports generated.
S - Submit JCL Submit the JCL to analyze and/or generate reports for 

the specified program.
E - Edit JCL Displays the JCL for the compile/analyze job in the 

ISPF editor for review. When editing is complete, 
enter the ISPF SUBMIT command to execute the 
JCL. Optionally, you can use the ISPF CREATE 
command to save the edited JCL in a partitioned 
dataset. Otherwise, the changes you make now are 
not saved. 

Note:
The VIASUB edit macro cannot be used now since it has been updated.
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HTML Converter

SmartDoc HTML is a utility that converts SmartDoc reports into a hyperlinked HTML 
4.0 document that can be viewed from a Web browser.

SmartDoc HTML 4.0 documents can be transferred from the mainframe to the PC by 
using a file transfer program like ASG-Outbound� to view it in a Web browser. The 
SmartDoc HTML Converter creates a hyperlinked table of contents with an entry for each 
report generated by SmartDoc. 

Options Output to HTML (Enter DSN below) Generates SmartDoc reports in 
HTML format for web 
distribution (see "HTML 
Converter" on page 115).

HTML Output DSN Enter an HTML output file name 
ending in .HTML.
The Output DSN is stored in the 
user�s profile and is retained for 
subsequent panel displays.

Note:
JCL generated by SmartDoc will always write HTML data to the same 
HTML Output DSN, which could lead to catalog issues for a multiple 
compile job. Only one member can be processed at a time. Enter a 
unique HTML Output DSN. 

ASG-SmartDoc 
Parms

Enter any desired SmartDoc execution options. To concatenate options, 
separate them by a comma or a space.

Field Description
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To create HTML reports

1 Use SmartDoc to analyze the desired program. If a program in the current AKR was 
previously analyzed by SmartDoc, you can generate reports without running another 
analysis job.

2 Select the reports you want from the File � Select Reports screen.

3 Select Options: Output to HTML and enter an output DSN. 

4 Use action 2 to submit the JCL.

Or

Use action 3 to edit the JCL, and then submit the JCL manually.

5 Transfer the output HTML file (this file must be transferred in ASCII format) to a 
PC with a Web browser. To transfer the file, you can use FTP or any file-transfer 
utility such as ASG-Outbound.

Note:
The file must have a .htm or a .html extension on the PC.
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6 View the file using a standard Web browser. The ASG-ESW/SmartDoc HTML 
Report window displays as shown in Figure 61.

Figure 61 � ASG-ESW/SmartDoc Report 

Click the hyperlinked report name on the HTML report Table of Contents to view a 
report. Click on the hyperlinked numbers in the Fall Thru column of the report to 
view the referenced line of code. All colored text is a hyperlink to the referenced 
code, report, or data item.

Note:
The reports shown in the hyperlinked Table of Contents will vary depending on the 
reports you selected from the ASG-SmartDoc File - Report selection window.

You must generate an Advanced Source Listing for HTML hyperlinked entries to 
work properly.
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The VIADCNVT JCL

Use the VIADCNVT JCL to convert existing reports. This JCL executes the load module 
VIADCNVT that reads a SmartDoc report (specified as SYSUT1 in Figure 62) and 
generates an HTML output file (specified as SYSUT2 in Figure 62). You can then 
transfer the resulting file to a PC and view it using any Web browser.

Figure 62 � VIADCNVT JCL

//VIADCNVT JOB (ACCOUNT),'SMARTDOC-HTML CONVERTER',CLASS=A,             
 //    PRTY=6,MSGCLASS=X,NOTIFY=&SYSUID,REGION=6M                        
 //*------------------------------------------------------------------   
 //*                 INSTRUCTIONS FOR USING THIS JCL                     
 //*                 ===============================                     
 //*  THIS JCL EXECUTES THE LOAD MODULE VIADCNVT THAT TAKES A SMARTDOC   
 //*  REPORT SAVED IN A DATA SET SPECIFIED IN SYSUT1 DD STATEMENT AND    
 //*  CONVERTS IT INTO AN HTML FILE SPECIFIED IN THE SYSUT2 DD STATEMENT.
 //*  THE HTML FILE CAN THEN BE TRANSFERRED TO A PC. WE RECOMMEND THAT   
 //*  YOU USE A LOW-LEVEL QUALIFIER OF HTML ON THE OUTPUT DATA SET.      
 //*  ONCE THE HTML FILE HAS BEEN TRANSFERRED TO THE PC, AND HAS A FILE  
 //*  EXTENSION OF .HTML, IT CAN BE BROWSED BY ANY BROWSER.              
 //*                                                                     
 //*  MODIFY THIS JCL AS FOLLOWS:                                        
 //*  1. JOBCARD - INSURE THAT THE JOBCARD IS PROPERLY FORMATTED FOR     
 //*               YOUR INSTALLATION.                                    
 //*  2. DOC2HTML- FILL IN THE CORRECT VALUES FOR ASG, CENTER, AND     
 //*               SYSOUT                                              
 //*  3. HTMLSTEP- SUPPLY THE CORRECT DOCIN AND HTMLOUT DATASET NAMES  
 //*                                                                   
 //*  SUBMIT THE JOB.                                                  
 //*------------------------------------------------------------------ 
 //DOC2HTML PROC ASG=ASG,                                              
 //           CENTER=VIACENXX,                                         
 //           SYSOUT=*,                                                
 //           DOCIN='',                                 
 //           HTMLOUT=''                                
 //*                                                                   
 //CONVERT  EXEC PGM=VIADCNVT,REGION=6M                                
 //*                                                                   
 //STEPLIB  DD DSN=&ASG..&CENTER..LOADLIB,DISP=SHR                     
 //SYSPRINT DD SYSOUT=&SYSOUT                                          
 //SYSUT1   DD DSN=&DOCIN.,DISP=SHR                                    
 //SYSUT2   DD DSN=&HTMLOUT.,DISP=(NEW,CATLG),                         
 //            UNIT=SYSDA,SPACE=(CYL,(1,1),RLSE),                      
 //            DCB=(RECFM=VB,LRECL=600,BLKSIZE=3120)                   
 //         PEND                                                        
 //*                                                                    
 //HTMLSTEP EXEC DOC2HTML,                                              
 //         DOCIN='USER.PROGRAM.SDOC',     <-- USER'S SMARTDOC REPORT   
 //         HTMLOUT='USER.PROGRAM.HTML'    <-- OUTPUT HTML DATASET
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where:

HTML Transfer from Host

This is one of the ways you can transfer the generated HTML file to PC. ASG 
recommends you use your documented procedures and facilities for transferring text data 
from the mainframe host system to you Web browser compatible platform. If you do not 
have a documented procedure, you can use FTP to transfer files. Shareware and 
third-party software exists that you can use to simplify the transfer. Additionally, you can 
use ASG-Outbound Express� to transfer the data.

To use FTP to transfer the generated HTML file to PC

1 Start FTP:  
ftp <host-id>  

For example:

ftp S390.company.com

2 Enter userid:

<userid>

3 Enter password:

<password>

JCL Statement Definition

VIADCNVT Required. Specify the jobcard.

STEPLIB Dataset where the load module VIADCNVT resides.

SYSUT1 Input file name. Enter the dataset name of the cataloged input 
SmartDoc report file. 

When you generate the SmartDoc report using SmartDoc, edit 
the SmartDoc report generation JCL and in the SMARTDOC 
step, modify the VIASDRPT DD to specify a permanent dataset 
where the report should go, and the dataset name under which it 
should be saved.

For more information on how to generate SmartDoc reports, see 
"To create HTML reports" on page 116 .

SYSUT2 Output file name. Enter the name of the variable block sequential 
file where the converted HTML document will go. This is the 
file you will transfer to the PC for viewing. 
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4 Set mode:  

ascii

5 Send HTML file:

get <&sysuid..smartdoc.html> <d:\path\...\path\smartdoc.html>

For example:

get user.smartdoc.html c:\myhtml\pgm1.html

6 End FTP:

quit

To view the transferred HTML file

1 Start your Web browser.

2 Enter the address of the transferred HTML file and press Enter.

For example:

<d:\path\...\path\smartdoc.html>

3 The HTML file displays in your Web browser window (see Figure 61 on page 117).

File - Select Reports Pop-up
Use the File - Select Reports pop-up (see Figure 63) to select and customize the generated 
reports.

Figure 63 � File - Select Reports Pop-up
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Fields
Type a non-blank character in one of these fields to generate a SmartDoc report: 

Field Description

Minimum 
Reports

Generates the Advanced Source Listing and the Enhanced Data 
Cross-Reference report for the specified program. The 
Compiler/Optimizer Output is also generated if a compile was 
performed. All other reports are suppressed. 

Advanced 
Source Call

Generates the Advanced Source Listing for the specified program.

Call Generates the Call Statement report for the specified program. N 
suppresses the report.

Compiler Output Generates the Compiler/Optimizer Output for the specified program.

Condensed 
Source

Generates the Condensed Source Listing for the specified program.

Copy Generates the Copy Statement report for the specified program.

Data Division Generates the Data Division report for the specified program.

Data 
Cross-reference

Generates the Enhanced Data Cross-Reference report.

Master Index Generates the Master Index for the specified program.

Metrics Generates the Metrics report for the specified program.

Paragraph 
Cross-reference

Generates the Paragraph Cross-Reference report. 

PERFORM 
Range Hierarchy

Generates the Perform Range Hierarchy Chart for the specified 
program.

PERFORM 
Range Usage

Generates the PERFORM Range Usage report for the specified 
program.

Program 
Exception report

Generates the Program Exception report for specified program.

Structure Chart Generates the Structure Chart for the specified program.

Subset Generates the Subset report for the specified program.
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See Chapter 12, "SmartDoc Options," on page 193 for more option information.

 SYSPRINT Causes the ESW monitor to create a separate compiler output file. 
Input this file to a post-processor or use it for other user-specified 
processing.

Verb Context Generates context information and includes it on the Verb Summary 
report.

Verb Frequency Generates the Verb Frequency Table and includes it in the Verb 
Summary report.

Report Options Select of one of these options:
1. General - All Reports Displays the File - General 

ASG-SmartDoc Options pop-up 
used to specify options for report 
output.

2. Structure Chart Displays the File - Structure Chart 
Options pop-up used to specify 
the content and format of the 
Structure Chart.

3. PERFORM Range Hierarchy Displays the File - PERFORM 
Range Hierarchy pop-up used to 
specify the content of the 
PERFORM Range Hierarchy 
Chart.

Field Description
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File - General ASG-SmartDoc Report Options Pop-up
Use the File - General ASG-SmartDoc Report Options pop-up (see Figure 64) to specify 
if reports are to contain a banner page and report help. You can also condense the 
Advanced Source Listing to only include SmartDoc cross-reference information.

Figure 64 � File - General ASG-SmartDoc Report Options Pop-up

Options
To select the desired options, type a non-blank character in one of these fields preceding 
the option:

See Chapter 12, "SmartDoc Options," on page 193 for more option information.

Field Description

Banner Page Includes a banner page that precedes the Table of Contents for the 
generated reports.

Report Help Includes descriptive information about the report and its contents on 
the first page of the report.

Short Output Specifies that only cross-reference information displays on the 
Advanced Source Listing when an extended SmartDoc analysis is 
performed. Select this option to improve the Advance Source Listing 
readability when analyzing large programs that might produce many 
overflow lines.
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File - Structure Chart Options Pop-up
Use the File - Structure Chart Options pop-up (see Figure 65) to specify the content and 
format of the Structure Chart.

Figure 65 � File - Structure Chart Options Pop-up

Options 

To select an option, type a non-blank character in one of these option fields:

Field Description

Duplicate 
PERFORMs

Specifies that PERFORM ranges be duplicated on the PERFORM 
Range Hierarchy report and the Structure Chart for each use. If 
Duplicate PERFORMs is not selected, the PERFORM range is 
shown where it is first used. Subsequent uses refer to the first use. 

Include 
CONDITIONALs

Includes the structurally relevant conditional statements that affect 
the PERFORM, CALL, GO TO, and ALTER statements on the 
Structure Chart. 

Note:
If the Include CONDITIONALs option is selected, Include GO 
TOs must also be selected.

Include GO TOs Includes GO TO and ALTER statements on the Structure Chart, in 
addition to PERFORM and CALL statements.

Bird's Eye Generates the Bird's Eye View representation of the Structure 
Chart. This report is shown in Tile Mode with each box condensed 
to one character.
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See Chapter 12, "SmartDoc Options," on page 193 for more option information.

File - PERFORM Range Hierarchy Options Pop-up
Use the File - PERFORM Range Hierarchy Options pop-up (see Figure 66) to duplicate 
PERFORMs, include CONDITIONALs, and include GO TOs.

Figure 66 � File - PERFORM Range Hierarchy Options Pop-up

Chart Mode Enter the desired mode number. Select Tile Mode to generate a 
chart designed to be taped together into one diagram. Select Page 
Mode to generate a chart designed to be placed in a notebook.

Vert. box size 
(3-31)

Specifies the height (in lines) of each box on the Structure Chart. 
The minimum value that can be entered is 3; 31 is the maximum. 
The maximum value can be constrained by physical limitations, 
such as the number of lines per page. The default value for this field 
is 6.

Horiz. box size 
(3-31)

Specifies the width (in characters) of each box on the Structure 
Chart. The minimum value that can be entered is 3 (6 for DBCS); 
the maximum value is 31. The maximum value can be constrained 
by physical limitations, such as the number of lines per page. The 
default value for this field is 9.

Structure Chart 
Max Pages

Specifies the maximum number of pages generated for a Structure 
Chart. The value may be in the range 1 to 999999, inclusive. The 
default is 999999.

Field Description
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Options
To select an option, type a non-blank character in one of these option fields:

ASG-ESW - AKR Utility Pop-up
Use the ASG-ESW - AKR Utility pop-up (see Figure 67) to display the member 
directory, to allocate or expand an AKR, to rename a member, and to delete a member. 

To display the ASG-ESW - AKR Utility pop-up:

� Select File � AKR utility from the SmartDoc Primary Screen and press Enter.

Figure 67 � ASG-ESW - AKR Utility Pop-up

Field Description

Duplicate 
PERFORMs

Specifies that PERFORM ranges be duplicated on the PERFORM 
Range Hierarchy report for each use. If Duplicate PERFORMs is 
not selected, the PERFORM range is shown where it is first used. 
Subsequent uses refer to the first use.

Include 
CONDITIONALs

Includes the structurally relevant conditional statements that affect 
the PERFORM, CALL, GO TO, and ALTER statements on the 
PERFORM Range Hierarchy report. 

Note:
If the Include CONDITIONALs option is selected, Include GO 
TOs must also be selected.

Include GO TOs Includes GO TO and ALTER statements on the PERFORM Range 
Hierarchy Chart, in addition to PERFORM and CALL statements.
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Options
These are the ASG-ESW - AKR Utility pop-up options:

Fields
These are the ASG-ESW - AKR Utility pop-up fields:

Field Description

Blank - Display member 
list

Displays the ASG-ESW - AKR Directory pop-up that lists 
the member directory. You can also use the 
ASG-ESW - AKR Directory pop-up to delete and rename 
members.

A - Allocate/expand AKR Select option A to allocate a new AKR or to expand an 
existing AKR. Enter the AKR name in the Dataset name 
field. The File - AKR Allocate/Expand pop-up (see 
Figure 69 on page 132) displays. If expanding an existing 
AKR, type YES in the Expand existing AKR field on that 
pop-up.

D - Delete member Select option D to delete a member. Prior to selecting option 
D, type the AKR and program names in the Dataset name 
and Member fields.

R - Rename member Select option R to rename a member. Prior to selecting 
option R, type the AKR and member names in the Dataset 
name and Member fields; and type the new name in the New 
name field.

Field Description

Dataset name Required. Enter the name of the AKR directory. If the TSO ID 
qualifier is the same as the user ID, type the group, type, and member 
without quotes. If the TSO ID qualifier is different than the user ID, 
type the project, group, type, and member within quotes. Alternately, 
the member name may be typed in the Program field.

Member Required when deleting or renaming a program. Enter the name of 
the member in the AKR; otherwise, type the member name in the 
Member field or in the Dataset name field.

Newname Required when renaming a member. Enter the new name of the 
member. The name must be between 1 and 10 alphanumeric 
characters.
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ASG-ESW - AKR Directory Pop-up
The ASG-ESW - AKR Directory pop-up (see Figure 68) lists all members in the 
specified AKR. 

To display the ASG-ESW - AKR Directory pop-up, follow this step:

� Press Enter on the ASG-ESW - AKR Utility pop-up with no entry in the command 
input area. Scroll this pop-up to view members that are not visible.

To view a specific member, follow this step: 

� Enter the L (Locate) command with a character string. The pop-up is scrolled to the 
member that most closely matches the character string.

Figure 68 � ASG-ESW - AKR Directory Pop-up

Volume serial Required if the dataset specified in the Dataset name field is not 
cataloged. Enter the volume serial number. If the dataset is cataloged, 
this field is optional.

Password Required if the dataset is protected. Enter the dataset password.

Field Description
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Fields
These are the ASG-ESW - AKR Directory pop-up fields:

Field Description

AKR Complete dataset name of the requested AKR, as entered on the 
ASG-ESW - AKR Utility pop-up (see Figure 67 on page 126).

Row Relative number in the AKR of the first member displayed on this 
pop-up.

Total members Total number of members in this AKR, not including aliases.

Total records Number of records allocated to this AKR, typed in the Space Amount 
field on the File - AKR Allocate/Expand pop-up (see Figure 69 on 
page 132) when the AKR was allocated or expanded.
If you enter the Space Units as Tracks or as Cylinders instead of 
Records, the amount is converted to Records and displays in the Total 
records field.

Total entries Total number of members in this AKR, including aliases.

Free space Amount of available space in this AKR, rounded to the nearest .1 
percent.

Command line 
area

The command line area, to the left of the Name field, accepts these 
line commands:
D - Delete Type D to the left of the member to delete it from the 

AKR. Alias members cannot be deleted. Members can 
also be deleted on the ASG-ESW - AKR Utility pop-up 
(see Figure 67 on page 126).

R - Rename Type R to the left of the member to rename it. Then type 
the new name in the New name field. Note that alias 
members cannot be renamed. When a primary member 
name is changed, the alias name is automatically 
changed. Members can also be renamed on the 
ASG-ESW - AKR Utility pop-up (see Figure 67 on 
page 126).

Name AKR member name. Member names are taken from the 
PROGRAM-ID statement.
If the analyzed program contains an ENTRY point, Name is the 
ENTRY point name. If you overrode the name in the PROGRAM-ID 
statement when you submitted the analyze job, Name is the name 
typed in the AKR program name field on the ASG-ESW Prepare 
Program pop-up. See the ASG-ESW Prepare Program pop-up (see 
Figure 59 on page 109) for more information on entries in the AKR.
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New name Required when renaming a member. Enter the new member name. 
The member name must be 1 through 10 alphanumeric characters.

Alias Of If an analyzed program contains an ENTRY point, Alias of is the 
name of the program containing the ENTRY point.
If you overrode the name in the PROGRAM-ID statement when the 
analyze job was submitted, Alias of is the name typed in the AKR 
program name field on the Analyze Submit or Prepare Program 
pop-up.

Note:
An alias member cannot be deleted or renamed. The alias name is 
automatically changed when the primary member is deleted or 
renamed.

See the ASG-ESW Prepare Program pop-up (see Figure 59 on page 
109) for more information on alias names in the AKR.

Type Type of analysis performed on the member. The type of analysis is 
specified on the ASG-ESW Prepare Program pop-up (see Figure 59 
on page 109) and can be one of these entries: 
AL Indicates an Alliance analysis was performed.

ASM Indicates the program is an Assembler source program.

DA Indicates an Extended SmartDoc analysis with a 
COBOL compile was performed.

DC Indicates a SmartDoc analysis with a COBOL compile 
was performed.

DS Indicates a SmartDoc analysis was performed.

DX Indicates an Extended SmartDoc analysis was 
performed.

EN Indicates a Encore analysis was performed.
The Renaissance RN analysis type is currently still a 
valid analysis type, but will not be supported in future 
releases of Encore.

IN Indicates a Insight analysis was performed. The IN 
value displays as a result of a Insight analyze job. This 
value is entered on the Analyze Submit pop-up and can 
only be specified if the Insight product is installed.

Field Description
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INTERNAL This is aN Encore feature that indicates the member 
contains logic segment information. The Name field 
contains $$SEGMENTS or the name you assigned to 
the member by using the Rename function. The 
$$SEGMENTS member contains the logic segment 
information.

METRICS This is a SmartDoc feature that indicates the member 
contains metrics information. The Name field contains 
$$METRIC or the name you assigned to the metrics by 
using the Rename function. The $$METRIC member 
contains metrics that have been calculated for the 
programs in this AKR.

PROFILE This is a SmartTest feature that indicates the member 
contains profile information. Generally, the member 
name is the user ID for which the profile was created. 
Profile information is automatically saved when the 
SmartTest Session Tailoring screen is used to specify 
the testing environment options. After program level 
testing options are specified on the Session Tailoring 
screen (and saved in the AKR profile member), the 
profile member is used by SmartTest when a test 
session is initiated. A profile is only used (and updated) 
by the user for whom it is created. Any modifications 
to the Session Tailoring screen are automatically 
reflected in the profile member.

RC Indicates a Recap analysis was performed.

SQ Indicates a SmartQuest analysis was performed.

ST Indicates a SmartTest analysis was performed.

Date Date the program was analyzed.

Time Time the program was analyzed.

Jobname JOB NAME used to analyze the program. 

Space Percentage of space the program is using on this AKR, rounded to the 
nearest .1 percent.

Field Description
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File - AKR Allocate/Expand Pop-up
Use the File - AKR Allocate/Expand pop-up (see Figure 69) to allocate a new AKR, or to 
expand an existing AKR. 

To display the File - AKR Allocate/Expand pop-up

1 Select File � AKR Utility and press Enter (see Figure 67 on page 126).

2 Type A and press Enter.

To expand an existing AKR, follow this step: 

� Type YES in the Expand existing AKR field. 

To allocate a new AKR, follow this step:

� Type NO in the Expand existing AKR field.

The space needed for the AKR depends on the size and number of programs analyzed and 
placed in it. See the ASG-Center Installation Guide for space estimates.

Figure 69 � File - AKR Allocate/Expand Pop-up with SMS and a VSAM AKR
132



6   File
Options
These are the File - AKR Allocate/Expand pop-up options:

Fields
These are the File - AKR Allocate/Expand pop-up fields:

Field Description

S - Submit JCL Submits the JCL to allocate or to expand the AKR shown in the AKR 
dataset name field.

E - Edit JCL Used to edit the JCL to allocate or to expand the AKR shown in the 
AKR dataset name field.

C - Specify 
Catalog

Displays the AKR Catalog Information pop-up used to specify the 
dataset name and password of a private catalog to contain the AKR.

Field Description

Expand existing 
AKR

Required. Enter YES to expand the AKR shown in the AKR dataset 
name field. Enter NO to allocate a new AKR. The default is NO.

AKR dataset 
name

The AKR name specified on the ASG-ESW - AKR Utility pop-up 
(see Figure 67 on page 126).

Note:
Management Class, Storage Class, Data Class, and Unique provide 
various parameters for newly allocated datasets. These parameters 
apply only if you have SMS active at your site. Your systems 
administrator determines the valid entries for these parameters.

Management Class Optional. Enter the management class for a new 
AKR. The default is MGMTCLAS.

Storage Class Optional. Enter the storage class for a new AKR. 
The default is STORCLAS.

Data Class Optional. Enter the data class for a new AKR. 
The default is DATACLAS.

Unique Optional. Type NO if the AKR is a 
sub-allocation in a VSAM data space on the 
volume. The default is YES.

Volume Required. Enter the volume serial number where 
the AKR is to reside.
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Space units Optional. Enter the type of units to allocate. The 
units must be records, tracks, or cylinders. The 
default is records.

Primary space/
Secondary space Required if you are not using SMS. Enter the 

amount of space to allocate in the type of units 
specified in the Primary Space Units field. Enter 
the amount of secondary space if required.

Note:
The space needed for the AKR depends on the size and number of 
programs analyzed and placed in it. See the ASG-Center Installation 
Guide for space estimates.

Job statement 
information

Optional. Enter appropriate JOB statement information for your site.

Field Description
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This chapter describes the View pull-down used to view metrics data for the programs 
that reside in the AKR and contains these sections:

View Pull-down
Use the View pull-down (see Figure 70) to view metrics data for the programs that reside 
in the AKR.

To display the View pull-down, follow this step:

� Select View on the action bar and press Enter.

Figure 70 � View Pull-Down

Section Page
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Action

Metrics View. Displays the View - Open Metrics Repository pop-up used to specify the 
program metrics viewed.

 View - Open Metrics Repository Pop-up
Use the View - Open Metrics Repository pop-up (see Figure 71) to specify the AKR for 
the displayed metrics.

 To display the View - Open Metrics Repository pop-up, follow this step:

�  Select View � Metrics View and press Enter.

Figure 71 � View - Open Metrics Repository Pop-up

Fields
These are the View - Open Metrics Repository pop-up fields:

Field Description

Data set name If the TSO ID qualifier is the same as the user ID, enter the library, 
type, and member without quotes.

TEST.AKR(pgmname)

If the TSO ID qualifier is different than the user ID, enter the 
project, library, type, and member with quotes.

'TSOID.TEST.AKR(pgmname)'

Volume serial Required if the dataset is not cataloged. Enter the volume serial 
number. If the dataset is cataloged, this field is optional.

Data set password Required if the dataset is protected. Enter the dataset password.
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Program Metrics View Screen
Use the Program Metrics View screen (see Figure 72) to display the latest metrics 
generated for a program. 

To display the Program Metrics View screen, follow this step: 

� Type the AKR dataset name on the View - Open Metrics Repository pop-up and press 
Enter. Use this screen to delete or to rename the metrics for a particular program.

Figure 72 � Program Metrics View Screen

Note:
The Program Metrics View screen contains a shortened action bar.
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Action Bar
These are the actions available on the Program Metrics View screen action bar:

Action Description

File The File pull-down contains the Print and Exit Metrics Display 
actions. The Print action prints the current program metrics 
information. To release the print, select Options � Process list file. 
The Exit Metrics Display action displays the View - Open Metrics 
Repository pop-up. Specify another AKR here. Press PF3/15 to exit.

Options The Options pull-down deletes, renames, or sorts the program 
metrics. The Options pull-down contains these actions:
Delete Metrics After selecting the program metrics name to delete, 

use this action to display the Options - Delete 
Confirmation pop-up to delete the metrics. On the 
Options - Delete Confirmation pop-up, type Y to 
delete the metrics, or N to cancel the deletion.

Rename After selecting the program metrics to rename, use 
this action to display the Options - Rename Metrics 
pop-up to rename the metrics. On the 
Options - Rename Metrics pop-up, enter the new 
name and select the desired option to rename the 
metrics only, or to rename the program and the 
metrics.

Sort Metrics Use this action to display the Options - Sort Metrics 
pop-up to change the order of the metrics listed on 
the Program Metrics View screen. On the 
Options - Sort Selection pop-up, specify the column 
to sort on. Sorting of metrics are in ascending order.

Process list 
file Use this action the display the Options - Log/List 

pop-up to set values for allocating, formatting, and 
processing the ASG-Recap Log and List files.

Help The Help pull-down accesses the online help facility. See the online 
help and Chapter 9, "Help," on page 149 and Chapter 15, "Help 
Facility," on page 235 for more information.
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 Fields
These are the Program Metrics View screen fields:

Field Description

AKR AKR specified on the View - Open Metrics Repository pop-up (see 
Figure 71 on page 136) displays in this field.

Sorted On Column on which the display is sorted. This can be the Name field 
or one of the metric types shown.

Total Metrics Total number of programs with metrics in this AKR.

AKR Average Average metrics value of all programs in the AKR for each metrics 
type.

Command line 
area

Command line area, to the left of the Name field, accepts this line 
command:
S Type S to the left of each program to delete or rename, then use 

the Options pull-down to choose the appropriate action. See 
�Action Bar� on page 138 for more information.

Name Programs and metrics that reside in this AKR.

Date Date the program was analyzed.

Time Time the program was analyzed.

Volume Most recent Software Science Volume metric calculated for the 
program.

Cyclomatic 
Complexity

Most recent Cyclomatic Complexity metric calculated for the 
program.

Essential 
Complexity

Most recent Essential Complexity metric calculated for the program.

Control Variable Most recent Control Variable metric calculated for the program.
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This chapter describes the Options pull-down used to access the pop-ups that customize 
the SmartDoc environment and contains these sections:

Options Pull-down
Use the Options pull-down (see Figure 73 on page 142) to access the pop-ups used to 
customize the SmartDoc environment. Customizing the SmartDoc environment includes 
defining and processing the Log file, and determining the values of the PF keys.

To display the Options pull down, follow this step:

� Select Options on the action bar and press Enter. 

Note:
The Options pull-down contains different actions on the Program Metrics Display screen. 
See Figure 72 on page 137 for more information.

Section Page
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Figure 73 � Options Pull-down

Actions
These are the Options pull-down actions:

Action Description

1. Product Parameters Displays the Options - Product Parameters pop-up (see 
Figure 74 on page 143) that controls the online operation of 
SmartDoc. This includes specifying whether an alarm sounds 
when an error message displays and defining the Log file.

2. Log file Displays the Options - Log File Definition pop-up (see 
Figure 75 on page 144) that processes the Log file. Use this file 
for system message logging and error handling.

3. PF keys Displays the Options - PF Key Definition pop-up (see Figure 76 
on page 147) that displays or changes the PF keys used with 
SmartDoc.
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Options - Product Parameters Pop-up
Use the Options - Product Parameters pop-up (see Figure 74) to set parameters that affect 
the online operation of SmartDoc, and to allocate the SmartDoc Log file. 

To display the Options - Product Parameters pop-up, follow this step:

� Select Options � Product Parameters and press Enter.

Or

Type PARMDEF on any screen and press Enter.

Figure 74 � Options - Product Parameters Pop-up

Fields
These are the Options - Product Parameters pop-up fields:

Field Description

Alarm Required. Specifies whether an audible alarm sounds when an error 
message displays.

LOG FILE Generic Unit Required. Enter the device type for the Log file 
allocated upon entry into SmartDoc. The Log file 
is used for error messages and log commands. 
Specify file characteristics on the Options - Log 
File Definition pop-up (see Figure 75 on page 
144).

Volume Serial Optional. Enter the volume serial number for the 
Log file.
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Options - Log File Definition Pop-up
Use the Options - Log File Definition pop-up (see Figure 75) to set values for allocating, 
formatting, and processing the SmartDoc Log dataset. SmartDoc uses this file for error 
messages and log commands. 

To display the Options - Log File Definition pop-up, follow this step:

� Select Options � Log file and press Enter.

Or

Type PRINTLOG on any screen and press Enter.

Figure 75 � Options - Log File Definition Pop-up
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Options
These are the Options - Log File Definition pop-up options:

Option Description

1 - Process log file Verify or change the Options, then select 1 to print and/or 
deallocate the Log file. A new file is allocated to collect additional 
data, if required.

If you specify the PK or PD Process option, you must enter Job 
statement information prior to selecting this option.

Note:
It is not necessary to exit SmartDoc to print the Log file.

2 - Customized data 
set name

Displays the Options - Log Customization pop-up, which enables 
you to specify a dataset name where the Log file will be saved. By 
default, these files are allocated using this naming convention:
USERID.yyyxxxxx.VIALOG

where: 
yyy is the product ID.
xxxxx is a sequential number from 00001 to 99999. 
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Fields
These are the Options - Log File Definition pop-up fields:

Field Description

Process option Required. Specify one of the listed processing options. The default is 
PD.

Primary tracks Required. Specify the number of primary tracks to allocate. A size 
change does not take effect until the next allocation occurs. The 
default is 1.

Secondary tracks Required. Specify the number of secondary tracks to allocate. A size 
change does not take effect until the next allocation occurs. The 
default is 1.

Lines per page Required. Specify the number of print lines per page. Typical 
maximum values are 60 for six lines per inch and 80 for eight lines 
per inch. The default is 56.

Sysout class Required. Specify the SYSOUT class value. The default is asterisk 
(*) which sends the SYSOUT to the destination specified in the 
MSGCLASS parameter on the JOB statement.

Process options This field lists the available options for the Log file:
PK Print and keep
PD Print and delete
K   Keep without printing
D   Delete without printing

LOG FILE IS 
ALLOCATED

This message displays when the Log file has been properly allocated. 
If the message does not display, check the assignments on the 
Options - Product Parameters pop-up (see Figure 74 on page 143).

Job statement 
information

Specify the appropriate JOB statement information for your 
installation. 

Note:
These JCL statements are required if the PK or PD Process option is 
specified.
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Options - PF Key Definition Pop-up
Use the Options - PF Key Definition pop-up (see Figure 76) to display and/or redefine PF 
key values. 

To display the Options - PF Key Definition pop-up

1 Select Options � PF keys and press Enter.

2 Type KEYS on any screen and press Enter. PF keys 1 through 12 display initially. 
Press Enter to display a similar screen for PF keys 13 through 24.

Figure 76 � Options - PF Key Definition Pop-up

Fields
These are the Options - PF Key Definition pop-up fields:

Field Description

Number of PF 
keys

Number of supported PF keys.

Terminal type Indicates the type of terminal being used. These are the 3270 type 
terminals SmartDoc supports:
Model 2 (24 lines x 80 columns)
Model 3 (27 lines x 80 columns)
Model 4 (43 lines x 80 columns)
Model 5 (27 lines x 133 columns)

PF1 - PF12 Value assigned to PF keys 1 through 12. You can assign any 
command or any data value to a PF key.

PF13 - PF24 Value assigned to PF keys 13 through 24.
147



 ASG-SmartDoc User�s Guide
148



9
 9Help
This chapter describes the Help pull-down used to access the Online Help facility and 
contains these sections:

Help Pull-down
Use the Help pull-down (see Figure 77) to access the Online Help facility. 

To display the Help pull-down, follow this step:

� Select Help on the action bar and press Enter. 

Figure 77 � Help Pull-down
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Actions
These are the Help pull-down actions:

 Usage Notes

See "Screen Help" on page 237 for more information about the Online Help facility.

Action Description

1. Current screen Displays help for the current screen or pop-up.

2. Current message Displays help for the current message.

3. All reports Displays a complete list of all SmartDoc reports, where you can 
view information about a specific report by selecting the 
appropriate number.

4. All commands Displays a complete list of all SmartDoc primary commands, 
where you can view information about a specific command by 
selecting the appropriate number.

5. Specific 
command

Displays the Help - Specific ASG Command pop-up (see 
Figure 78 on page 151) used to obtain help about a specific 
SmartDoc primary command.

6. Specific message Displays the Help - Specific ASG Message Number pop-up (see 
Figure 79 on page 151) used to obtain help about a specific 
message number.

7. Common abends Displays the Abends screen, where you can view information 
about a specific abend by selecting the appropriate number. Select 
topic 2 on this screen to display the ASG Abend Codes screen, 
which lists all the ESW user abends and their explanations.

8. Table of contents Displays the online help table of contents, listing general 
information about SmartDoc. See Chapter 15, "Help Facility," on 
page 235 for more information and an example of the online help 
table of contents.

9. Index Displays the initial online help index screen. See Chapter 15, 
"Help Facility," on page 235 for more information and an example 
of the online help index.

10. Action bar Displays the Help Tutorial for the SmartDoc action bar.

11. About Displays the Help - About pop-up (see Figure 80 on page 152) that 
lists information about the currently installed levels of SmartDoc 
and Center.
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Help - Specific ASG Command Pop-up
Use the Help - Specific ASG Command pop-up (see Figure 78) to obtain help about a 
specific SmartDoc primary command. 

To display the Help - Specific ASG Command pop-up, follow this step:

� Select Help � Specific command and press Enter.

Figure 78 � Help - Specific ASG Command Pop-up

Fields

Command. Required. Enter a SmartDoc primary command and press Enter. The Help 
Tutorial for that command displays. See Chapter 15, "Help Facility," on page 235 for 
more information.

Help - Specific ASG Message Number Pop-up
Use the Help - Specific ASG Message Number pop-up (see Figure 79) to display help for 
a specific ESW message. 

To display the Help - Specific ASG Message Number pop-up, follow this step:

� Select Help � Specific message and press Enter.

Figure 79 � Help - Specific ASG Message Number Pop-up
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Fields

Message. Required. Enter a ESW message number and press Enter. The Help 
Explanation and Action screen for that message displays. See Chapter 15, "Help 
Facility," on page 235 for more information on the Help Explanation and Action screen.

Help - About Pop-up
Use the Help - About pop-up (see Figure 80) to display information about the 
currently-installed releases of SmartDoc and Center. 

To display the Help - About pop-up, follow this step:

� Select Help � About and press Enter.

Figure 80 � Help - About Pop-up

Fields
These are the Help - About pop-up fields:

Field Description

Product name Displays the name SmartDoc or the name of the ESW product 
you are currently running.

Release number Displays the currently installed release number of SmartDoc.

Maintenance level Displays the currently installed SmartDoc level number.

ASG-Center release 
number

Displays the currently installed release number of Center.
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Note:
ASG Customer Support requests this information when you contact them for assistance. 
This information can also be displayed by typing PRODLVL on any screen.

Center maintenance 
level

Displays the currently installed Center level number.

Operating system Displays the operating system you are running.

Field Description
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 10 Metrics
This chapter describes the SmartDoc generated metrics used in the management of the 
program maintenance life cycle and contains these sections:

Introduction to Metrics
Metrics gives you information about the complexity and quality of a program that helps 
you manage the program maintenance life cycle. Metrics are best used when you are 
comparing programs of a similar nature. For example, you should not compare a batch 
program that writes reports with a CICS accounts payable program.

This is a sample procedure for using SmartDoc metrics to manage the maintenance life 
cycle of a program:

To use SmartDoc metrics to manage the maintenance life cycle of a program

1 Use SmartDoc to analyze each program.

2 From the Program Metrics View pop-up (see Figure 72 on page 137), sort the display 
on each of the metric types and print the results.

3 Group the programs by purpose and calculate an average for each metrics group, or 
use the average shown on the Program Metrics View pop-up.

4 Calculate a standard deviation for each metric in the group (percent of average). For 
additional information, see Chapter 4, "Techniques," on page 21.
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5 Calculate the number of standard deviations from the average for each metric on 
each program. For additional information, see Chapter 4, "Techniques," on page 21.

6 Review programs with more than one standard deviation above average for the 
Software Science Volume metric for re-engineering into smaller, independently 
called programs.

7 Programs that have more above average Cyclomatic Complexity and Control 
Variable standard deviations than their Software Science Volume values are 
particularly complex for their size. Consider re-engineering or restructuring these 
programs, as they can be extremely difficult to maintain and enhance.

When you analyze a new program (metrics calculated), compare its metric values against 
existing programs. Use this information to assess the long term maintenance resources 
required to maintain the new program.

Storing Program Metrics
The AKR stores software metrics information as a separate member (i.e., stores it 
separately from the actual program). The metrics information remains intact if the 
program is deleted from the AKR. When you use the AKR Utilities to rename a program, 
the corresponding metrics member is not renamed. To rename or delete a program or 
metrics, use the Program Metrics View pop-up.

Unlimited versions of metric data are retained for each program. However, due to page 
size limitations, only the twenty most recent versions are shown on the metrics reports.

Renaming or Deleting Metrics When ISPF is Not Installed
SmartDoc provides you with options for renaming or deleting metrics when ISPF is not 
installed. Enter these options in the DPARM parameter of the VIASANJC JCL. Use the 
DPARM parameter to specify all SmartDoc reporting options when ISPF is unavailable.
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To rename metrics for a program, follow this step: 

� Use the RENAME(pgm) option along with the PGM=pgmnm option. 

where:

pgm is the new name for the metrics.

pgmnm is the name of the metrics in the AKR to be renamed. Only the metrics are 
renamed when you use the RENAME(pgm) option. 

To rename the program, follow this step: 

� Use the VIASAKRU JCL.

To delete metrics for a program, follow this step:

� Use the DELMET option along with the PGM=pgmnm option.

where pgmnm is the name of the metrics in the AKR being deleted. The program itself 
is not deleted when you use the DELMET option.

Note:
When you use the RENAME or the DELMET options, use only the SmartDoc report 
generation (SDR) feature to execute SmartDoc. RENAME and DELMET prevent 
SmartDoc from generating reports and cannot be used if reports are to be generated.
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This chapter discusses the analyze process used by SmartDoc and contains these sections:

Section Page

Overview 160

Analyzing a COBOL Program 160

The Analyze Process 163

Analyze Using ISPF 164

Analyze Using ISPF/PDF Edit 165

Submitting an Analyze Job When ISPF is Not Installed 171

Automatic JCL Modifications 172

Analyze Summary Report 177

Analyze Options 179
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Overview

Note:
A program must be analyzed before ESW products can provide information about it. 

The analyze process gathers information about the program, such as program 
relationships, logic, data, and execution paths. The AKR stores this information and 
makes it available to ESW products in online and batch environments.

Analyzing a COBOL Program
The analyze process is similar to a COBOL compile. These are the primary inputs:

� Source COBOL program (including copybooks)

� JCL used to compile and link the COBOL program

� Options and features for tailoring the analyze steps

Analyze Input Descriptions

COBOL Source Program
Like the compiler, the analyze process requires basic program standards. These are the 
basic program standards:

� The COBOL language as specified in the COBOL II and COBOL/370 Language 
Reference guides is accepted by the analyze job. The analyze job correctly 
processes any program compiled without warnings or errors by the COBOL II 
compilers.

� COBOL II and COBOL/370 programs that receive error (E), severe (S), or 
unrecoverable (U) messages from the IBM compiler cannot be successfully 
analyzed.
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These tables contain the program analyzer resource estimates for processing various sizes 
of COBOL programs. This information resulted from the running of Analyze under this 
criteria:

� Version - Center R7.0

� CPU Type - 3090-600 running MVS/ESA

� Disk Type - 3390

� Analyze Parms - BUFMAXKB=4096 KB

� Compiler Parms - BUF=256 KB, SIZ=1024 

SmartDoc Short Analysis Resource Estimates

Source Lines
Virtual 

Memory Size
XA Memory 

Size
CPU Time 

MM:SS AKR Blocks
VIAUT2 

Cyls

1000
2000
5000

10000
20000
50000

1060 KB
1060 KB
1060 KB
1060 KB
1060 KB
1060 KB

12100 KB
12200 KB
12500 KB
12800 KB

140000 KB
16000KB

0:04
0:10
0:30
1:00
2:00
5:00

150
300
750

1500
3000
6000

2
3
6

12
24
50

SmartDoc Extended Analysis Resource Estimates

Source Lines
Virtual 

Memory Size
XA Memory 

Size
CPU Time 

MM:SS AKR Blocks
VIAUT2 

Cyls

1000
2000
5000

10000
20000
50000

256 KB
256 KB
256 KB
256 KB
256 KB

4096 KB

12100 KB
12800 KB
16000 KB
20000 KB
28000 KB
48000 KB

0:03
0:15
1:00
5:00

15:00
60:00

250
600

2000
5000

10000
30000

2
5

15
40
80

240
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Compile/Link JCL
The compile/link JCL is the complete JCL used to compile the program. Specifically, the 
JCL should contain steps to accomplish these actions: 

� Fetch the source from the source manager (such as Librarian or Panvalet)

� Execute the preprocessors

� Invoke the compiler with the appropriate options and COPY libraries

� Invoke the linkage editor if desired

Analyze Options and Features
Use these analyze features to indicate the type of analysis performed:

Default options for the analyze process are established at installation time. When you 
submit the analyze job, specify the options to be overridden.

Analysis Features

Encore analysis Provides the information required for code extraction and 
execution flow capabilities. 

SmartTest analysis Provides the testing and debugging information required 
by SmartTest.

Extended SmartTest analysis Provides comprehensive program analyzing capabilities 
in addition to the testing and debugging capabilities of a 
SmartTest analysis.

Insight analysis Provides logic and execution flow capabilities.

SmartDoc analysis Provides the information required for SmartDoc reports. 

Extended SmartDoc analysis Provides data flow analysis.

SmartQuest analysis Analyzes the source used in diagnosing dumps. The 
default is N.
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The Analyze Process
The analyze process consists of setting up and executing a batch job. The method you use 
depends on the environment where the analyze process is invoked, but also may depend 
on the access method containing the compile/link JCL. These are the methods used to 
invoke the analyze process:

Method Description

Analyze Option or 
Command

To display the Analyze Submit pop-up, select File � 
Analyze.

Or

Type ANALYZE from any screen and press Enter. 
Enter the required input and output information, then submit 
the job.

ISPF From any ISPF screen, execute the VIASUBDS CLIST. 
This CLIST is executed by typing:
TSO VIASUBDS dsn parms

where: 

dsn is a PDS member or a sequential dataset containing the 
compile JCL.
parms represents any of the available execution parameters 
described in the VIASUBDS and VIASUB Parameters table 
contained in "Analyze Using ISPF/PDF Edit" on page 165 .

ISPF/PDF Edit Execute the VIASUB PDS edit macro. This edit macro is 
executed by typing this syntax: 
VIASUB parms

where parms represents any of the available execution 
parameters described in the VIASUBDS and VIASUB 
parameters table contained in "Analyze Using ISPF/PDF 
Edit" on page 165 .

VIASANJC JCL Execute the VIASANJC JCL to convert the compile and link 
JCL, then execute the converted JCL to analyze the program. 
This method is used when ISPF is not installed.
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These are the methods for executing an analyze job and when to use them:

Analyze Using ISPF
To submit the analyze job from any ISPF screen, follow this step: 

� Use the VIASUBDS CLIST.

This is the syntax for VIASUBDS:

TSO VIASUBDS input.jcl.dsn parms

where:

input.jcl.dsn is the dataset containing the compile/link JCL. This dataset must 
be a sequential dataset or a member of a PDS.

parms is one or more parameters that control the operation of VIASUBDS. 
Typically, the PANEL parameter is entered to display the Analyze Submit Parameters 
screen for entry of any necessary parameters. The parameters are saved in the ISPF 
profile and used as defaults for the next analyze submission. For a list of these 
parameter, with the default parameters underlined, see "Analyze Using ISPF/PDF 
Edit" on page 165 .

Note:
Using the VIASUBDS CLIST requires the ESW CLIST library to be available through 
the standard SYSPROC allocations.

Compile JCL is From Method for Executing Analyze Job

PDS or sequential dataset Analyze Submit Screen, VIASUBDS CLIST, 
VIASUB edit macro, or VIASANJC JCL

Librarian, Panvalet, or other user 
source manager when editing the JCL 
with ISPF/PDF

VIASUB edit macro

Screen-driven submit facility that 
generates JCL

VIASUBDS CLIST
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Analyze Using ISPF/PDF Edit
To submit the analyze job from the ISPF/PDF Edit screen, follow this step:

� Use the VIASUB edit macro. 

This is the syntax for VIASUB:

VIASUB parms

Where parms is one or more parameters that control the operation of VIASUB. 
Typically, you use the PANEL parameter to display the Analyze Submit Parameters 
screen to enter necessary parameters. The ISPF profile saves the parameters and uses 
them as defaults for the next analyze submission.

Note:
Using the VIASUB edit macro requires the ESW CLIST library to be available through 
the standard SYSPROC allocations.

These are the VIASUB parameters:

Parameter Description

AKR (xxxxx) Indicates the AKR where the results of the analyze job are 
placed. The specified name must conform to the standard TSO 
dataset naming conventions. If the name requires quotes, use 
triple quotes. For example: 
AKR (���ASG, VIACENxx.AKR���) 

AOPT(xxxxx) Specifies options supplied to the analyze job. The COBOL II 
option is automatically added if the compiler specified in the 
input JCL is COBOL II. If you specify more than one analyze 
option, they should be separated by commas and enclosed in 
single quotes. For example: 
AOPT (�XMEM, RECUR,SUBSYS=D239�).

See "Analyze Options" on page 179 for information on each 
analyze option.

CMPL
NOCMPL

CMPL indicates a COBOL compile and an analysis is executed 
by the new JCL. NOCMPL indicates the new JCL is to bypass 
the compile step and only execute the analyze job. When 
NOCMPL is specified, a return code of 1000 (decimal) greater 
than the analyze return code is produced. This bypasses 
subsequent job steps (e.g., a link edit) based on a successful 
compilation. NOCMPL cannot be specified if a SmartTest 
analysis is being executed.
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DSCHK
NODSCHK

DSCHK indicates datasets needed by the resulting JCL are 
verified. Specifically, the AKR and the load library containing 
VIASMNTR are checked. When NODSCHK is specified, the 
AKR and the load library need not exist at the time the VIASUB 
or the VIASUBDS is executed. NODSCHK is useful when the 
JCL is being prepared for submission on another system, or for 
delayed execution when an AKR does not yet exist.

Note:
The cataloged procedure libraries must exist and be accessible 
to VIASUBDS or to VIASUB.

EDIT Specifies that the resulting JCL is not submitted for batch 
processing. The PDF editor is invoked for the resulting JCL. 
Make the desired changes and then type SUBMIT to submit the 
JCL. EDIT must be entered each time it is needed. 

Note:
The edits made to the JCL are not saved. 

Use the CREATE command to save the modified JCL 
elsewhere. The EDIT option is ignored if the Analyze Submit 
Parameters screen displays. In this case, type E to edit the JCL.

INS
NOINS

INS specifies that an Insight analysis is performed.

OUTPUT (xxxxx) Specifies that the resulting JCL is not submitted for batch 
processing. The JCL is written to the specified dataset. The 
specified name must conform to the standard TSO dataset 
naming conventions. A dataset is created if it does not already 
exist. OUTPUT must be entered each time it is needed.

PANEL
NOPANEL

Indicates whether the Analyze Submit Parameters screen is 
displayed for analyze job parameter entry. The Analyze Submit 
Parameters screen displays even if a valid AKR name is 
specified as a parameter, or is obtained from the ISPF profile 
when PANEL is specified.

PGM (xxxxx) Specifies a name when storing the program in the AKR. This 
name overrides the program name in the PROGRAM-ID 
paragraph.

PROCONLY Indicates that the JCL contains only a cataloged procedure 
rather than a complete job. PROCONLY suppresses the 
generation of the VAIAN DD statement. PROCONLY must be 
entered each time it is needed.

Parameter Description
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REUS
NOREUS

Specifies that when you use SmartTest to test a program, the 
program is dynamically loaded and tested with RUN 
NOMONITOR.

ENS
NOENS

Specifies whether an Encore analysis is done.

SD
NOSD

Specifies whether a SmartDoc analysis is done.

SDR
NOSDR

Specifies whether SmartDoc reports are generated.

SDX
NOSDX

Specifies whether a SmartDoc Extended analysis is done.

ST
NOST

Specifies whether a SmartTest analysis is done.

STX
NOSTX

Specifies whether an Extended SmartTest analysis is done. 
When you specify the INS and ST parameters, an Extended 
SmartTest analysis is automatically done.

SQ
NOSQ

Specifies whether a SmartQuest analysis is done.

Parameter Description
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ASG-ESW - Prepare Program Screen
Figure 81 shows the ASG-ESW - Prepare Program screen. This screen displays when you 
specify the PANEL parameter while executing VIASUBDS or VIASUB, or when you 
use the NOPANEL option and SmartDoc detects an error condition.

Figure 81 � ASG-ESW - Prepare Program Screen

Options
These are the ASG-ESW - Prepare Program screen options:

Options Description

E - Edit JCL Used to review or to change the compile/analyze JCL, if necessary. 
Select this option to use the rules outlined in "Automatic JCL 
Modifications" on page 172 to generate the JCL to be edited. The 
generated JCL displays on the Edit screen.
When editing is complete, type SUBMIT to execute the edited JCL. 
Optionally, use the ISPF CREATE command to save the edited JCL 
in a partitioned dataset. Otherwise, any changes made at this time are 
not saved.

S - Submit JCL Submits the JCL to compile/analyze the specified program. The JCL 
submitted is generated from the JCL specified when the VIASUBDS 
CLIST, or the VIASUB edit macro was invoked, applying the rules 
outlined in "Automatic JCL Modifications" on page 172 .

D - Doc Options Displays only if SmartDoc is installed. Type D to display the File - 
SmartDoc Report pop-up (see Figure 60 on page 113) used to request 
an Extended SmartDoc analysis and to specify what reports (if any) 
are generated.
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Fields
These are the ASG-ESW - Prepare Program screen fields:

Field Description

Analyze features Understand Displays only if Insight is installed. This type of 
analysis provides the logic and program 
execution flow capabilities of Insight. If Insight 
is the only product installed, this field contains 
YES and cannot be changed. The default is N.

Test Displays only if SmartTest is installed. Y 
indicates that a SmartTest compile/analysis is 
performed. This type of analysis provides the 
testing and debugging information required by 
SmartTest. If SmartTest is the only product 
installed, this field contains YES and cannot be 
changed. The default is N.

Extended Analysis Displays only if SmartTest is installed. This type 
of analysis provides comprehensive program 
analyzing capabilities in addition to the testing 
and debugging capabilities of SmartTest. The 
default is N. An Extended SmartDoc analysis is 
specified on the File -ASG-SmartDoc Options 
screen.

Document Displays only if SmartDoc is installed. This type 
of analysis provides the report information 
generated by SmartDoc. If SmartDoc is the only 
product installed, this field contains YES and 
cannot be changed. The default is N.

Re-engineer Specifies that an Encore compile/analysis is 
performed. This type of analysis provides the 
logic and program execution flow capabilities of 
Encore. If Encore is the only product installed, 
this field contains YES and cannot be changed. 
The default is N.

Abend/Dump Displays only if SmartQuest is installed. This 
type of analysis lets you analyze the source used 
in diagnosing dumps. The default value is N.

AKR dataset 
name

AKR that will contain the information for the analyzed program.
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AKR program 
name

Specifies an alias name used by the analyze job to save its results in 
the AKR. If you don�t enter a value in this field, the results of the 
analyze job save in the AKR with the same name as the 
PROGRAM-ID statement name in the COBOL source. This field is 
only used for the AKR program name and does not change the 
COBOL program name in the source.

Analyze Options Specifies the analyze options you want to override. Default options 
for the analyze job are established at installation time. Analyze 
options that can be entered in this field are described in "Analyze 
Options" on page 179 .

Compile? Suppresses the compile step. This field is forced to a value of Y if 
SmartTest and/or Extended analysis is selected. 

Note:
A program does not need to be compiled if Insight, Encore, or 
SmartDoc are the only features specified.

Link load module 
reusable?

Tests a program under SmartTest that is dynamically loaded if it is 
tested. It is necessary to mark the load module as reusable so that the 
Breakpoints are retained across calls. The default is Y.

Field Description
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Submitting an Analyze Job When ISPF is Not Installed
When ISPF is not installed, you cannot use the SmartDoc online component (Analyze 
Submit screen), the VIASUB edit macro, or the VIASUBDS CLIST to submit analyze 
jobs. 

To submit an analyze job when ISPF is not installed, follow this step:

� Manually create JCL to analyze a program.

Or

Use the VIASANJC JCL provided with SmartDoc to convert existing compile and 
link JCL.

VIASANJC accepts a compile and link JCL dataset (PDS or sequential) as input. With 
the exception of OUTPUT, all allowed parameters are listed in the VIASUBDS and 
VIASUB Parameters table contained in "Analyze Using ISPF/PDF Edit" on page 165 . 

VIASANJC creates JCL in a separate PDS or sequential dataset to execute these actions: 

� Compile

� Link edit

� Analyze

� Symbol (processing performed by the ESW monitor)

� SmartDoc

Specify these additional parameters in the VIAIN DD statement in the converted JCL, if 
required:

Parameter To Execute or to Generate

INS Insight analysis

ST SmartTest analysis

STX SmartTest Extended analysis

SD SmartDoc analysis

SDX SmartDoc Extended analysis

SDR SmartDoc reports
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Automatic JCL Modifications
The analysis process automatically modifies the JCL based on the specified parameters 
and analyze options. If problems arise, use this procedure as a checklist to manually 
perform the analyze process until the problem is resolved. Make changes to the JCL or 
the compile procedure, or copy the compile procedure.

To manually perform the analyze process

1 Replace the PGM= parameter in these compile step(s):

PGM= parameter      Replace with:

PGM=IGYCRCTL        PGM=VIACOBII
PGM=CPXUPTSM        PGM=VIAOPT3
PGM=CAOTSMON        PGM=VIAOPTII

SQ SmartQuest analysis

EN Encore

Parameter Description

DPARM SmartDoc report options. To generate reports without an analysis, 
enter the PGM=name option in the DPARM parameter to indicate 
the program use.
SYSPRINT Create a separate compiler output file for use by 

a post-processor.
VIADCOMP Create the SmartDoc intermediate compiler 

output file if the CMPOUT SmartDoc option is 
used.

CMPL COBOL Compile The automatic JCL modifications described in 
"Automatic JCL Modifications" on page 172 are 
made when you use VIASANJC to convert 
existing compile and link JCL.

Parameter To Execute or to Generate
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2 Add DD statements to the compile step(s) for these ESW datasets:
//VIASDTOC DD SYSOUT=*
//VIASDRPT DD SYSOUT=*
//VIALOG   DD SYSOUT=*
//VIAMRPT  DD SYSOUT=*
//VIAPRINT DD SYSOUT=*
//VIAAKR   DD DSN=[specified AKR name],DISP=SHR

3 Increase the SPACE= specification for the SYSUT1 DD to a minimum of 
SPACE=(CYL,(5,5)).

4 If the SYSIN DD statement contains FREE=CLOSE, change it to FREE=END.

5 To ensure the ESW load libraries are available, add a //STEPLIB DD statement to 
specify the ESW load libraries, or concatenate the libraries to an existing STEPLIB 
DD.

6 Ensure that the JOB and the modified STEP EXEC statements have a minimum of 
REGION=4096 KB.

7 Add a VIAIN DD statement to designate the features and options used during 
analysis. This is the format of the syntax:

//VIAIN    DD *
* ANALYZE FEATURES:
  INS,ST,STX,SD,SDX,SDR,ENS
/*

To do this step manually, modify the COBOL parameter string to include the 
appropriate ESW parameter. For example:

VPARM=(vopt,vopt,vopt...)
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Where vopt can be any of these parameters:

Parameter Description

INS Insight only analysis (no COBOL compile).

ST SmartTest only analysis (no Extended analysis).

STX SmartTest Extended analysis.

SD SmartDoc analysis.

SDX Extended SmartDoc analysis.

SDR SmartDoc report generation.

SQ SmartQuest analysis.

EN Encore analysis (no COBOL compile).

[analyze parms] Valid analyze parameters (using the standard analyze 
options).

CMPL COBOL compile (forces the JCL to execute a COBOL 
compile and an analysis).

NOCMPL Suppress the COBOL compile (JCL bypasses the compile and 
executes only an analyze job).

(NO)SYSPRINT Create separate compiler output file.

(NO)VIADCOMP Create SmartDoc intermediate compiler output file. The 
intermediate compiler output file is used to produce the 
SmartDoc Compiler Output.

DPARM SmartDoc run-time parameters. If no ESW feature is specified 
(i.e., INS, ST, STX, SD, SDX, SDR, or ENS), all ESW 
processing is suppressed. This means the procedure executes 
a compile as it did before.
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Figure 82 is an example of compile JCL as it might display in a dataset at your site.

Figure 82 � Compile/Analyze JCL Before Modifications
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Figure 83 shows how the compile JCL illustrated in Figure 82 on page 175 displays after 
you generate the compile/analyze JCL following the rules in this section. Statements you 
added or modified are tagged to the right with ASG NEW and ASG MOD.

Figure 83 � Compile/Analyze JCL After Modifications
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Analyze Summary Report
The AKR stores the program information from the completed analyze job. The analyze 
job also produces a summary report of the run-time statistics and diagnostic messages. 
This report varies, depending on whether you specified the SOURCE or the NOSOURCE 
option when you submitted the analyze job.

Figure 84 shows the Analyze Summary report with the SOURCE option used. The 
information shown on this summary is described below.

Figure 84 � Analyze Summary Report
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Fields
These are the Analyze Summary report fields:

Field Description

(A) A complete listing of the program is produced and shows statement numbers 
generated by the analyze job in the first six columns. These numbers are 
referenced in diagnostic messages. These are the notations that can also display 
on the source listing:
C Statement was inserted with a COPY statement.
** Original source statement number is out of sequence.
I Statement was inserted with an INSERT statement.

(B) Report from the ESW monitor facility. The job steps that were executed by the 
monitor facility are listed along with the return codes produced.

(C) The Center (Analyze) release and product level is shown along with the date 
and time the analysis was performed.

(D) LINE and ERROR MESSAGE - Displays only if error conditions were 
encountered. If so, this area lists the line number where the error occurred and 
the error message.

(E) DIAGNOSTICS LINES - Total number of messages issued with subtotals for 
each type.

(F) SOURCE LINES - Number of source lines in the program. The number of 
statements within the DATA DIVISION and PROCEDURE DIVISION are 
also shown. Each level number is counted as one statement in the DATA 
DIVISION. Each verb is counted as one statement in the PROCEDURE 
DIVISION.

(G) PARAMETERS PASSED - Analyze options specified for this analyze job.

(H) OPTIONS IN EFFECT - Options in effect, including default and 
user-specified options.

(I) ENTRY POINTS - Entry points in this program.

(J) EXTERNAL CALLS - Programs that this program CALLs.

(K) END OF PROCESSING - Day, month, year, and time the analyze job 
completed. This date and time is also reflected in the online AKR statistics.
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Analyze Options
Use Analyze options to override the default options for the Analyze job that were 
established when the ESW products were installed.

The Analyze job uses many of the same options as the COBOL II compilers. These 
compile-time options are available for controlling the output format and to describe 
COBOL options.

To override the installation options, follow this step:

� Enter the desired options (separate multiple options with a comma) on the 
File - Analyze Submit pop-up and press Enter.

If you enter an invalid option, it is ignored by the analyze job. If you enter a valid option 
more than once, the last one is processed.

Options that accept program names as parameters, with the exception of PROGRAM, 
accept wildcard characters. The asterisk (*) represents zero or more characters. The 
question mark (?) represents a single character. For example:

The analyze options are summarized in the next sections. Abbreviations are shown in 
uppercase (abbreviations comply with compiler standards). The Analyze Summary report 
printed at the end of each analyze job lists the actual options in effect, and the options that 
were passed to it (the override options).

Parameter Description

DBA* All programs that begin with DBA and end with any number of other 
characters.

D?A* All programs that begin with D followed by any one character, 
followed by A, then followed by any number of other characters.

DBA??? All programs that begin with DBA and end with any three characters.
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Buffers
This is the buffers parameter:

For example:

BUF(nnnnnK)
BUF=nnnnnK

where nnnnn is a number from 20 to 20000.

COBOL Level
These are the COBOL level parameters:

For example:

COBOL370
COBOLII
COB2R3

The default is based on the compiler being used and is determined automatically by the 
submit process.

Parameter Description

BUF Use only as an override. The amount of main storage allocated to 
buffers and internal tables is dynamically allocated. Use BUF if an 
override is necessary. The minimum BUF value is 20 KB; the 
maximum is 20000 KB.

Parameter Description

COBOL370 Overrides the LANGLVL option and processes the input program as 
COBOL/370

COBOLII Overrides the LANGLVL option and processes the input program as 
COBOL II

COB2R3 Overrides the LANGLVL option and processes the input program as 
COBOL II Release 3.0 or Release 3.1.
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DB2 Load Library
This is the DB2 load library parameter:

For example:

DB2LIB=xxxxxx.xxxxx.xxxxxx

where xxxxxx.xxxxx.xxxxxx is the dataset name of the DB2 load library.

DB2 Application Plan
This is the DB2 application plan parameter:

For example:

DB2PLAN=xxxxxxxx

where xxxxxxxx is the name of the ESW application plan.

Parameter Description

DB2LIB Specifies the load library used to invoke the DB2 preprocessor at your 
site.

Parameter Description

DB2PLAN Specifies the ESW application plan the VIASBIND job created at 
installation time. You can use DB2PLAN to override the default plan 
name.
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Dynamic CALLs
These are the dynamic CALLs parameters:

For example:

DYNcall
NODYNcall

The minimum abbreviation is DYN or NODYN. For example, the analyze process for 
this code proceeds differently, depending on whether DYNCALL is specified:

77  MYPROG   PIC X(8)
CALL MYPROG USING PARM1, PARM2

In this example, if DYNCALL is in effect, the analyze process assumes that the program 
being called is MYPROG, regardless of the data value that MYPROG contains at 
run-time. The analyze process looks up the analysis results of MYPROG in the AKR to 
determine whether PARM1 and PARM2 are used or modified.

If NODYNCALL is in effect for this example, the analyze process assumes that the 
program being called could be anything, and treats PARM1 and PARM2 as used and 
modified on the call statement.

Note:
The DYNCALL option is unrelated to the COBOL compiler option DYNAM.

Parameter Description

DYNCALL Default. Specifies whether SmartDoc functions use the variable name 
in dynamic CALLs as the name of the CALLed program. 

NODYNCALL Specifies that dynamic calls are not processed by the analyze, and 
information for them is not available to ESW product functions.
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Flag Messages

These are the message levels:

These are the flag parameters:

For example:

fLAGW
fLAGE
fLAG(x)

Where x is a specified message level. The minimum abbreviations are LAGW, LAGE, 
and LAG(x). 

Note:
Some informational messages are produced regardless of the flag setting.

Parameter Description

I Informational

W Warning

E Error

S Severe

U Unrecoverable

Parameter Description

FLAG Specifies the types of messages listed for the Analyze job.

FLAGW Indicates all warning and diagnostic messages are listed. This is the 
default.

FLAGE Indicates diagnostic messages are listed; all other messages are 
suppressed.

FLAG(x) Indicates all messages of the specified level or above are listed.
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Input
These are the input parameters:

For example:

Input(x,x,...x)
Input=x
NOInput(x,x,...x)
NOInput=x

Where x is a program name. The minimum abbreviation is I or NOI, with at least one 
program name. Wildcard characters are allowed in the program name.

IO
These are the IO parameters:

For example:

IO(x,x,...x)
IO=x
NOIO

Where x is a program name. Wildcard characters are allowed in the program name.

Parameter Description

INPUT Lists the CALLed programs that contain INPUT statements. When 
commands that search for INPUT are issued, statements that CALL 
these programs are shown in the command results. The specified 
programs are in addition to those specified at installation time.

NOINPUT Overrides the installation default list of CALLed programs that 
contain INPUT statements. The specified programs are deleted from 
the default list.

Parameter Description

IO Lists the CALLed programs that contain INPUT and OUTPUT 
statements. When commands that search for INPUT and OUTPUT 
are issued, statements that CALL these programs are shown in the 
command results. The specified programs are in addition to those 
specified at installation time.

NOIO Overrides the installation default list of CALLed programs that 
contain INPUTand OUTPUT statements.The specified programs are 
deleted from the default list.
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Language Level
These are the language level parameters:

For example:

LANGLVL(1)
LANGLVL(2)

The default is based on the compiler used, and is determined automatically by the submit 
process.

Line Count
This is the line count parameter:

For example:

lineCNT=nn

Where nn is a number from 01 to 99. The minimum abbreviation is CNT, with a line 
count number.

Parameter Description

LANGLVL Specifies that the 1968 or 1974 American National Standard COBOL 
definitions are used when analyzing source elements with meanings 
that have changed.

LANGLVL(1) Indicates the 1968 standard is used.

LANGLVL(2) Indicates the 1974 standard (X3.23-1974) is used.

Parameter Description

LINECNT Indicates the number of lines printed on each page of the source 
listing. The default is 60.
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Main
This is the main parameter:

For example:

lineCNT=nn
MAIN

The EXIT PROGRAM statements in COBOL programs are treated as GOBACKs by the 
Analyze job, because the program is treated as a CALLed subprogram. 

Maximum Number of Errors
This is the maximum number of errors parameter:

For example:

MBRERCNT=nnnn

where nnnn is a number from 1 to 4000.

Parameter Description

MAIN Override only. If the program is the main program, use the MAIN 
option to treat the EXIT program as a fallthrough.

Parameter Description

MBRERCNT Specifies the maximum number of analysis errors allowed for a 
member during an analyze job. If this number of errors is exceeded, 
the analyze job terminates processing for that member. The number 
specified must be between 1 and 4000. The default is set at 
installation.
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Output
These are the output parameters:

For example:

Output(x,x,...x)
Output=x
NOOutput(x,x,...x)
NOOutput=x

where x is a program name. The minimum abbreviation is O or NOO, with at least one 
program name. Wildcard characters are allowed in the program name.

Program
This is the program parameter:

For example:

PROgram(xxxxxxxxxx)
PGM=xxxxxxxxxx

where xxxxxxxxxx is a program name up to 10 characters. The minimum abbreviation 
is PRO, with a program name.

Analyzed programs are stored in the AKR and identified by the program name coded in 
the PROGRAM-ID statement. 

Parameter Description

OUTPUT Lists the CALLed programs that contain OUTPUT statements. When 
commands that search for OUTPUT are issued, statements that CALL 
these programs are shown in the command results. The specified 
programs are in addition to those specified at installation time.

NOOutput Overrides the installation default list of CALLed programs that 
contain OUTPUT statements. The specified programs are deleted 
from the default list.

Parameter Description

PROGRAM Overrides the name coded in the PROGRAM-ID statement.
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Recursion
These are the recursion parameters:

For example:

RECur
NORECur

The minimum abbreviation is REC or NOREC.

Return
These are the return parameters:

For example:

RETurn(x,x,...x)
RETurn=x
NORETurn(x,x,...x)
NORETurn=x

where x is a program name. The minimum abbreviation is RET or NORET, with at least 
one program name. Wildcard characters are allowed in the program name.

Parameter Description

RECUR Specifies whether the recursion report should be included in the 
Analyze Summary report. If RECUR is specified and recursion is not 
found, a message displays indicating no recursion was detected. If 
RECUR is specified and recursion is found, a message is issued and 
the recursive code is printed on the report.

NORECUR Default.

Parameter Description

RETURN Overrides the installation list of the programs or the entry points that 
do not return when CALLed. Override the system defaults by listing 
the programs or the entry points that are to return when CALLed.

NORETURN Lists the additional programs or the entry points that are not to return 
when CALLed. When any of these programs are CALLed by the 
program being analyzed, they are treated as non-returning CALLs. 
The specified programs are in addition to the system defaults for 
programs that do not return when CALLed.
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Sequence
This is the sequence parameter:

For example:

SEQ
NOSEQ

Source
These are the source parameters:

For example:

SOUrce
NOSOUrce

The minimum abbreviation is SOU or NOSOU.

Parameter Description

SEQ Default. Specifies whether the analyze job checks the source module 
statement number sequence. A warning message prints if the 
statements are not in sequence. If the Source option is also specified, 
a flag (**) is placed between the Analyze job sequence numbers and 
the source sequence numbers.

Parameter Description

SOURCE Specifies whether the source program is listed. Specify the SOURCE 
option if a full program listing is desired at Analyze time.

NOSOURCE Default.
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Spacing
These are the spacing parameters:

For example:

spACE1
spACE2
spACE3

The minimum abbreviations are ACE1, ACE2, and ACE3.

SQL Authorization ID
This is the SQL authorization ID parameter:

For example:

SQLID=nnnnnnnn

where nnnnnnnn is an 8-character name. 

SQLID(nnnnnnnn,nnnnnnnn,nnnnnnnn)

Parameter Description

SPACE Specifies the spacing for the source listing generated when the 
SOURCE option is used.

SPACE1 Default. Specifies single spacing.

SPACE2 Specifies double spacing; that is, one blank line displays between 
every source line.

SPACE3 Specifies triple spacing; that is, two blank lines display between every 
source line.

Parameter Description

SQLID Specifies the authorization ID or the owner name used by the analyze 
process to qualify unqualified table and view references in your 
program.
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DB2 Subsystem
This is the DB2 subsystem parameter:

For example:

SUBSYS=xxxx

Where xxxx is the name of the subsystem or the location of the DBMS.

Live Exit
This is the live exit parameter:

For example:

XLIVE

Note:
Using XLIVE can significantly increase resource usage.

Parameter Description

SUBSYS Specifies the subsystem or the location that designates the DBMS 
where the tables accessed by a specified program are stored. SUBSYS 
overrides the name provided at installation time.

Parameter Description

XLIVE Use only as an override. Only use this parameter with programs that 
contain live exits. Live exits are exits from perform ranges left 
dangling by imbedded PERFORMs or GO TOs in the original 
performed paragraph. If XLIVE is not used, code that is unprocessed 
because of the live exit is ignored. If XLIVE is used, unprocessed 
code is saved.
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Memory
This is the memory parameter:

For example:

XMEM

Parameter Description

XMEM Use only as an override. If a program is extremely large (for example, 
30,000 source lines) and there is insufficient memory, increase the 
region space. If there is still insufficient memory, enter the XMEM 
option. This results in more disk I/O and additional CPU usage, but 
less memory consumption.
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 12SmartDoc Options
This chapter describes the SmartDoc options used to control report generation and 
specify various report formats, and contains these sections:

Introduction
SmartDoc options control report generation and specify report formats. Use the File 
ASG-SmartDoc Options pop-up to specify most options (when the online component is 
available). 

To display the ASG-SmartDoc Options pop-up, follow this step:

� Type D on the ASG-ESW Prepare Program pop-up and press Enter.

When ISPF is not installed, use the DPARM parameter to specify these options in the 
VIAIN DD statement of the analyze job. See Chapter 11, "Analyze," on page 159 for 
information on the VIAIN DD statement.

Section Page

Introduction 193

SmartDoc Options 194
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SmartDoc Options
This chapter summarizes each SmartDoc option. Each default is underlined, and 
abbreviations are shown in uppercase. These are the defaults that reflect the information 
on the installation tape:

Option Description

BaNner

NOBaNner
Produces a banner page that precedes the Table of Contents for the 
generated reports. The default is BaNner.

BIRDSeye

NOBIRDSeye
Generates a Bird's Eye View representation of the Structure Chart. 
This report is shown in Tile Mode, with each box condensed to one 
character. The default is BIRDSeye.

CAllrept
NOCAllrept

Generates the Call Statement report. The default is CALLrept.

CMpout
NOCMpout

Generates the Compiler/Optimizer Output if SmartDoc is executed 
with a compile. The default is CMpout.

CoNdsrclist
NOCoNdsrclist

Generates the Condensed Source Listing. The default is CoNdsrclist.

CoLon=: Defines a substitute for the colon character used on all generated 
reports. The default is CoLon.

CoPyrept
NOCoPyrept

Generates the Copy Statement report. The default is CoPyrept.

DataDIV
NODataDIV

Generates the DATA Division report. The default is DataDIV.

DataXref
NODataXref

Generates the Enhanced Data Cross-Reference report. The default 
is DataXref.

DELMET Deletes metrics for a program when ISPF is not installed. When this 
option is used, SmartDoc reports cannot be generated. See Chapter 
10, "Metrics," on page 155 for detailed information on this option.
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DuPperf
NODuPperf

Shows perform ranges multiple times on the Perform Range 
Hierarchy Chart or the Structure Chart (Tile Mode only) when they 
are used more than once in a program. 

Note:
If the program contains many perform ranges called from multiple 
places, using the DuPperf option can produce lengthy reports. 

The default is NODuPperf.

HCond
NOHCond

Generates the Perform Range Hierarchy Chart with the 
Conditionals option. The default is NOHCond.

HelP
NOHelP

Includes descriptive help information about a generated report on 
the first page of that report. The default is HelP.

HGoto
NOHGoto

Generates the Perform Range Hierarchy Chart with the Gotos 
option. The default is HGoto.

HsiZe=9 Specifies the horizontal size (in characters) of the boxes on the 
Structure Chart. The minimum value is 3 (6 for DBCS); 31 is the 
maximum. The maximum box size can be constrained by physical 
limitations, such as the page size (LiNesperpag). The default is 9.

LiNesperpage=60 Specifies the number of lines printed on each report page of the 
reports. The HsiZe and VsiZe values combine with the LiNesperpag 
value to determine the maximum box size. The default is 60.

MasterINDEX
NOMasterINDEX

Generates the Master Index for the SmartDoc reports. The default is 
NOMasterINDEX.

MeTrics
NOMeTrics

Generates the Metrics report. The default is NOMeTrics.

MiNimum
NOMiNimum

Specifies that only the Advanced Source Listing and Enhanced 
Data Cross Reference report are generated. The 
Compiler/Optimizer Output is also generated if a compile is 
performed. The default is NOMiNimum.

ParaXref
NOParaXref

Generates the Paragraph Cross-Reference report. The default is 
ParaXref.

PerfHier
NOPerfHier

Generates the Perform Range Hierarchy Chart. The default is 
PerfHier.

Option Description
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PeRfrept
NOPeRfrept

Generates the Perform Range Usage and Interface report. The 
default is PeRfrept.

PgmExcp
NOPgmExcp

Generates the Program Exception report. The default is PgmExcp.

ReName Renames metrics for a program when ISPF is not installed. When 
this option is used, SmartDoc reports cannot be generated. See 
Chapter 10, "Metrics," on page 155 for detailed information on this 
option.

SCond
NOSCond

Generates the Structure Chart with the Conditionals option. The 
default is NOSCond.

SGoto
NOSGoto

Generates the Structure Chart with the Gotos option. The default is 
SGoto.

ShOrtout
NOShOrtout

Shows only the cross reference information on the Advanced 
Source Listing when an Extended SmartDoc analysis is performed. 
Very large programs can produce many overflow lines in the 
Advanced Source Listing. Using this option can reduce the number 
of overflows, thus making the Advanced Source Listing more 
readable. The default is NOShOrtout.

SouRcelist
NOSouRcelist

Generates the Advanced Source Listing. The default is SouRcelist.

StructMode=TM | 
PM

Specifies the type of Structure Chart produced. TM produces a 
Structure Chart in Tile Mode. PM produces a Structure Chart in 
Page Mode. The default is TM.

STructurecht
NOSTructurecht

Generates the Structure Chart. The default is STructurecht.

SubSet
NOSubSet

Generates the Subset report. The default is SubSet.

SysPrint
NOSysPrint

Causes the ESW monitor to create a separate compiler output 
file.Input this file to a post processor or use it for other 
user-specified processing. The default is NOSysPrint.

VCHAR= |
VE=|

Specifies the substitution character to replace vertical bars on the 
Structure Chart and Perform Range Hierarchy Chart. The default is 
| (vertical bar).

Option Description
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VerbContext
NOVerbContext

Generates the Verb Summary report with the context portion of the 
report included. The default is VerbContext.

VerbFreq
NOVerbFreq

Generates the Verb Summary report with the Verb Frequency Table 
portion of the report included. The default is VerbFreq.

VsiZe=6 Specifies the vertical size of the boxes (in lines) on the Structure 
Chart. The minimum value is 3; 31 is the maximum, inclusive. The 
actual maximum box size can be constrained by physical 
limitations, such as the page size (LiNesperpage). The default is 6.

Chart Mode
(TM/PM)

Enter TM in this field to produce the Structure Chart in Tile Mode. 
Tile Mode generates a large Structure Chart on individual sheets of 
paper that you can connect together to form a large chart of the 
complete program.   
Enter PM in this field to produce the Structure Chart in Page Mode. 
Page Mode generates the Structure Chart with references that you 
can place in a notebook. TM is the default.

Horiz. box size Specifies the width (in characters) of each box on the Structure 
Chart. The minimum is 3 (6 for DBCS); the maximum is 31. The 
maximum box size is constrained by the physical page size. The 
default is 9.

Vert. box size Specifies the height (in lines) of each box on the Structure Chart. 
The minimum is 3; the maximum is 31. The maximum box size is 
constrained by the physical page size. The default is 6.

Option Description
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 13AKR Utilities
This chapter describes the online and batch AKR utilities used by SmartDoc and contains 
these sections:

Introduction to AKR Management
The AKR is the repository for all of the information used by the ESW family. The AKR 
stores analyzed programs for use by ESW. You can define a single AKR for use by all 
ESW users, or define separate AKRs for use by departments, groups, or individual users.

ESW gives you online and batch utilities for managing the AKR. This section explains 
the online AKR utilities (see "Online AKR Utilities" on page 200), and the batch AKR 
utilities (see "Batch AKR Utilities" on page 201).

Section Page

Introduction to AKR Management 199

AKR Structure 200

Batch AKR Utilities 201

AKR Commands 203

Batch AKR Reports 214

Allocating and Expanding AKRs without ISPF 216
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AKR Structure
The AKR is a BDAM or a VSAM file organization. 

See the ASG-Center Installation Guide for additional information about the AKR.

Online AKR Utilities
These are the elements the online AKR utilities include:

See the online help for examples of each of these pop-ups.

Element Description

File - AKR Utility pop-up Use to rename or delete a program, or display the AKR 
Directory.

File - AKR Directory pop-up Use to view all programs in an AKR. Use this pop-up to 
rename or delete a group of programs. Statistics about the 
AKR are also shown on this pop-up.

File - AKR Allocate/Expand 
pop-up

Use to allocate a new AKR or to expand an existing 
AKR.

Note:
When you use the Allocate/Expand utility, the default 
AKR organizational type is applied. For example, if 
your site's default AKR type is sequential, any new AKR 
allocated is created as a sequential file, and any 
non-sequential AKR that you expand is reorganized as a 
sequential file.
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Batch AKR Utilities
Use the Batch AKR Utility to maintain the AKR without using ISPF. These are the 
commands available in the batch utility:

Command Description

CONVERT Converts the members you selected from a previous ESW product release 
level to the current release level.

COPY Copies the members you selected from one AKR to another.

DELETE Deletes the members you selected from the AKR.

EXPORT Creates metrics and function-point CDF files. 

Note:
EXPORT is available only to Recap users.

HELP Prints the AKR Utility Help report.

INIT Formats a previously-defined dataset into an AKR format.

MOVE Copies the members you selected from one AKR to another and deletes 
them from the original AKR.

PRINT Prints AKR directory information or COBOL source listings for the 
selected AKR members.

PUNCH Produces a file that contains the AKR directory information, or the COBOL 
source code for the AKR members you selected.
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Job Control Statements
The Batch AKR Utility uses the JCL statements shown in Figure 85. The VIAAKRIN 
and VIAAKROT DD statements describe AKRs used for AKR Utility processing. The 
VIASYSIN DD control cards consist of the necessary Batch AKR commands (see "Batch 
AKR Utilities" on page 201). Review the description for each command to determine 
what DD statements are affected.

Figure 85 � Batch AKR JCL Statements

Control Cards
The control cards following the VIASYSIN DD statement pass commands to the Batch 
AKR Utility. These are the standards control cards must conform to: 

� Command information must be contained in columns 1 through 72 of the control 
card.

� Only one command can be entered on each control card.

� Only one control card may be used per command.

All control cards with command disposition and command summaries are printed to the 
VIALOG AKR Utility Log file. Blank control cards are ignored.
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AKR Commands

Command Format
Commands that use member names accept special characters to signify generic names. 
An asterisk (*) represents zero or more characters. A question mark (?) represents one 
character. 

For example:

Parameter Description

DBA* Specifies all members that begin with DBA and end with any other 
characters.

D?A* Specifies all members that begin with D followed by one character, 
followed by an A, then followed by any other characters.

DBA??? Specifies all members that begin with DBA and end with any three 
characters.

LASTUSED Provides the selection criteria for several commands. The specified 
number represents the number of days since the member was last 
referenced online, or the date the member was analyzed if it has not 
been referenced.

REPLACE Specifies that members are to be replaced on the output AKR.

NOREPLACE Default. Prevents members from being replaced on the output AKR.
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Command Syntax
These descriptions include the format and briefly explain the command parameters:

Item Description

ABBREViations Command abbreviations are shown in uppercase letters; lowercase 
letters in the command are optional.

lowercase Lowercase values indicate user-supplied variable information.

UPPERCASE Uppercase words indicate commands or keywords.

Underline The default value of an operand is underlined.

| A vertical bar separates synonymous commands or operands.

A right ending arrow indicates that the command syntax is 
continued on the next line.

A right beginning arrow indicates the command syntax is 
continued from the previous line.

Right and left ending arrows indicate the end of the command 
syntax.

An operand or a keyword displaying on the main command line is 
required.

Stacked operands on the main line indicate a choice of one 
required item.

An operand or a keyword displaying below the main command 
line is optional.

Stacked operands below the main line show a choice of one 
optional item.

required 

choice1
choice2
choice3

optional

choice1
choice2
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Batch AKR Comments
The Batch AKR Comments command includes a comment with the commands. This is 
the Batch AKR Comments command syntax:

Operands

Comment. User-supplied text.

Usage Notes
Blank control cards are ignored.

A returning arrow indicates that more than one operand can be 
chosen.

A returning arrow with a plus sign (+) indicates that operands can 
be concatenated by placing a + between them.

Item Description

choice1
choice2

choice1
choice2
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CONVERT Batch AKR Command
The CONVERT Batch AKR command converts selected members that were analyzed by 
a prior release of ESW products to the current release level. This is the CONVERT Batch 
AKR command syntax:

Operands
These are the CONVERT Batch AKR command operands:

Usage Notes
Use this command to copy members from the AKR specified in the VIAAKRIN DD 
statement to the AKR specified in the VIAAKROT DD statement, as described in "Job 
Control Statements" on page 202 .

Operand Description

member This operand can be a specific or a generic name as described in 
"Command Format" on page 203 .

LASTUsed Selects members based on the number of days since they were last 
used, as described in "Command Format" on page 203 .

NOTINPlace Specifies that a member with the same name on the receiving AKR 
should be replaced with the member from the sending AKR.

INPlace Specifies that a member is converted and kept within the AKR 
named in the VIAAKRIN DD statement. 

Note:
This option should be used with caution. Consult your systems 
programmer or ASG Customer Support.
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COPY Batch AKR Command
The COPY Batch AKR command copies selected members from one AKR to another. 
This is the COPY Batch AKR command syntax:

Operands
These are the COPY Batch AKR command operands:

Usage Notes
Use this command to copy members from the AKR specified in the VIAAKRIN DD 
statement to the AKR specified in the VIAAKROT DD statement.

Note:
When you use the Allocate/Expand utility, the default AKR organization type is applied. 

Operand Description

member This operand can be a specific or a generic name as described in 
"Command Format" on page 203 .

LASTUsed Selects members based on the number of days since they were last 
used, as described in 
"Command Format" on page 203 .

NOREPlace Prevents existing members from being replaced by members with the 
same name. This is the default.

REPlace Replaces members that have the same name on the receiving AKR.
207



 ASG-SmartDoc User�s Guide
DELETE Batch AKR Command
The DELETE Batch AKR command erases selected members from the AKR. This is the 
DELETE Batch AKR command syntax:

Operands
These are the DELETE Batch AKR command operands:

Usage Notes

Note:
Members are deleted from the AKR specified in the VIAAKRIN DD statement.

You cannot use this command to delete members that begin with VIA (all ESW test 
members begin with VIA). To delete these members, use the online AKR Utility function 
described in "Online AKR Utilities" on page 200 .

Operand Description

member This operand can be a specific or a generic name as described in 
"Command Format" on page 203 .

LASTUsed Selects members based on the number of days since they were last 
used, as described in "Command Format" on page 203 .
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EXPORT Batch AKR Command

The EXPORT Batch AKR command creates metrics and function point CDF files. This is 
the EXPORT Batch AKR command syntax:

Operands
These are the EXPORT Batch AKR command operands:

Usage Notes

Note:
EXPORT is available only for Recap users.

Operand Description

application This operand can be a specific or a generic name as described in 
"Command Format" on page 203 .

FPA Generates only function-point information. If FPA is not specified, 
both metrics and function point information are generated.
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HELP Batch AKR Command
The HELP Batch AKR Command prints a description of the Batch AKR Utility and 
allowable commands. This is the HELP Batch AKR command syntax:

Operands
None.

Usage Notes

� Use a question mark (?) as an alternate command.

� The HELP command has no operands.

The Help report is printed to the SYSOUT specified in the VIAPRINT DD statement.

INIT Batch AKR Command
The INIT Batch AKR command initializes a new AKR. This is an internal command that 
is used by the online AKR Utility Allocation function. See "Online AKR Utilities" on 
page 200 for additional information. This is the INIT Batch AKR command syntax:

Operand
This is the INIT Batch AKR command operand:

Usage Notes
You must create the AKR dataset to be initialized before initialization. 

To create the AKR dataset, follow this step:

� Describe the initialized AKR in the VIAAKRIN DD statement. 

Note:
The VIAAKRIN DD statement is ignored when you specify the DSNAME parameter.

Operand Description

DSname(dsname) Specifies the dataset name for the new AKR.
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MOVE Batch AKR Command
The MOVE Batch AKR command moves selected members from one AKR to another. 
This command copies specified members to the receiving AKR and erases them from the 
sending AKR. This is the MOVE Batch AKR command syntax:

Operands
These are the MOVE Batch AKR command operands:

Usage Notes
This command moves members from the AKR you specified in the VIAAKRIN DD 
statement to the AKR you specified in the VIAAKROT DD statement.

Operand Description

member This operand can be a specific or a generic name as described in 
"Command Format" on page 203 .

LASTUsed Selects members based on the number of days since they were last 
used, as described in "Command Format" on page 203 .

NOREPlace Prevents existing members from being replaced by members with the 
same name. This is the default.

REPlace Replaces members that have the same name on the receiving AKR.
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PRINT Batch AKR Command
The PRINT Batch AKR command prints the AKR directory information for the entire 
AKR, a specified member, or the source code for a specified member. This is the PRINT 
Batch AKR command syntax:

Operands
These are the PRINT Batch AKR command operands:

 Usage Notes
This command extracts the directory information or the COBOL source from the AKR 
you specified in the VIAAKRIN DD statement and prints it to the SYSOUT you 
specified in the VIAPRINT DD statement. See "AKR Utility Directory Report" on page 
215 for additional information.

Operand Description

blank Prints the AKR directory information if the PRINT batch AKR 
command is entered with no operand.

DIRectory Prints AKR directory information. This is the default. If a member is 
specified, only the AKR directory information for that member is 
printed.

PROgram Prints the COBOL source for the specified AKR member. The 
generated COBOL source listing contains expansions of all 
COPYBOOKs and/or INCLUDEs, as well as the results of any 
source preprocessors such as CICS macro expansion.

member This operand can be a specific or a generic name as described in 
"Command Format" on page 203 .

LASTUsed Selects a member based on the number of days since it was last used, 
as described in "Command Format" on page 203 .
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PUNCH Batch AKR Command
The PUNCH Batch AKR command produces a file that contains AKR directory 
information for the entire AKR, a specified member, or the source code for a specified 
member. This is the PUNCH Batch AKR command syntax:

Operands
These are the PUNCH Batch AKR command operands:

Usage Notes
This command extracts the directory information or the COBOL source from the AKR 
you specified in the VIAAKRIN DD statement and writes it to the file you specified in 
the VIAPUNCH DD statement. The file that is produced file is in standard IBM 
IEBUPDTE Utility format. ADD control cards are produced for each logical entity. See 
"Punch Directory File" on page 216 for more information.

Operand Description

blank Produces a file containing the AKR directory information if the 
PUNCH batch AKR command is entered with no operand.

DIRectory Produces a file that contains directory information. This is the 
default. If a member is specified, the AKR directory information for 
that member only is printed.

PROgram Produces a file that contains COBOL source code for the specified 
AKR member. The generated COBOL source contains expansions of 
all COPYBOOKs and/or INCLUDEs, as well as the results of any 
source preprocessors such as CICS macro expansion.

member This operand can be a specific or a generic name as described in 
"Command Format" on page 203 .

LASTUsed Selects a member based on the number of days since it was last used, 
as described in "Command Format" on page 203 .
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This is the format of the file produced by the PUNCH DIRECTORY command:

Batch AKR Reports

AKR Utility Log
The VIALOG AKR Utility Log provides a summary of the commands issued to the Batch 
AKR Utility (see Figure 86 on page 215). This is the information this log contains:

� Comments

� Commands

� Completion messages

� Short summary of commands processed

The heading includes the ESW product level information, and the date and time the job 
was executed. Comments are enclosed in a box comprised of asterisks. The second page 
contains the log summary.

Description Length Format

Member name 10 Character

Number of source lines 6 Right justified

Days since last used 4 Right justified

Analyze date 9 DDMMMYYYY

Analyze job name 8 Character

Analyze CPU 4 Character

Analyze product level 8 Character

Last reference date 9 DDMMMYYYY

Last reference user ID 8 Character

Last reference CPU 4 Character
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Figure 86 � AKR Utility Log

AKR Utility Directory Report
The AKR Utility Directory report (see Figure 87) lists the PRINT DIRECTORY 
command results and writes to the VIAPRINT DD file. The title line contains the ESW 
product level information, title, date, and time the job was executed. The report lists the 
AKR dataset used, the command used to produce the report, and the directory 
information for the selected members.

Figure 87 � AKR Utility Directory Report
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Punch Directory File
The Punch Directory (see Figure 88) writes to the VIAPUNCH DD file when the 
PUNCH DIRECTORY command processes. The file is formatted in standard IBM 
IEBUPDTE Utility format. The first card,./ADD..., is an IEBUPDTE control card that 
indicates these cards are added to a partitioned dataset specified in the NAME parameter. 
The cards that follow are in the format described in the PUNCH DIRECTORY command 
description. The last card is an IEBUPDTE control card that indicates the end of the 
control cards. See the PUNCH Batch AKR command for the AKR Punch Directory File 
format. (See "Punch Directory File" on page 216.) 

Figure 88 � AKR Punch Directory File

Allocating and Expanding AKRs without ISPF
The Batch AKR Utility can allocate and expand VSAM AKRs without using ISPF. ESW 
provides the VIASAKRA JCL to allocate an AKR, and the VIASAKRX JCL to expand 
an AKR. Figure 89 on page 217 and Figure 90 on page 217 illustrate the VIASAKRA 
JCL. These figures illustrate the VIASAKRX JCL: 

� Figure 91 on page 218

� Figure 92 on page 219

� Figure 93 on page 219 
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Figure 89 � VIASAKRA JCL for a VSAM AKR (1 of 2)

Figure 90 � VIASAKRA JCL for a VSAM AKR (2 of 2)
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To allocate an AKR

1 Replace xx in the NAME(XX), NAME(XX.DATA), and the DSNAME(XX) 
parameters with the name of the AKR to be allocated. 

2 Replace XX(XX) with the allocation units values and quantities for your site.

Figure 91 � VIASAKRX JCL for a VSAM AKR (1 of 3)
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Figure 92 � VIASAKRX JCL for a VSAM AKR (2 of 3)

Figure 93 � VIASAKRX JCL for a VSAM AKR (3 of 3)
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To expand an AKR 

1 Replace xx in the NAME(XX.EX), NAME(XX.EX.DATA), DSNAME(XX.EX), 
INDATASET(XX), and the OUTDATASET(XX.EX) parameters with the name of 
the AKR to be expanded. 

2 Replace XX(XX) with the allocation units values and quantities for your site.

To rename an AKR 

1 Replace the XX in the DELETE statement with the AKR to be renamed. 

2 Enter the new AKR name in the NEWNAME(XX) parameter.
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 14Online Component Commands
This chapter describes the SmartDoc online component commands and contains these 
sections: 

Introduction
SmartDoc is primarily a batch-oriented product; however, the online component offers 
commands as well. This chapter describes all SmartDoc commands.

Section Page

Introduction 221

Command Processing 222

Command Diagrams 222

ANALYZE Command 224

HELP Command 225

KEYS Command 227

LOCATE Command 228

PARMDEF Command 229

PRINTLOG Command 230

PRODLVL Command 231

RECALL Command 232
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Command Processing
Enter commands in the command input area on SmartDoc screens. SmartDoc handles the 
commands that you press a PF key to enter in the same manner as those you enter in the 
command input area. If you press a PF key to enter a command and a command is already 
in the command input area, SmartDoc appends the contents of the command input area to 
the PF key command. The combined commands are then executed as a whole. Separate 
multiple commands entered in the command input area by a semicolon (;). Multiple 
commands process from left to right.

Note:
The SmartDoc command delimiter is the same character defined for ISPF in the 
COMMAND DELIMITER field on the ISPF Terminal Characteristics screen. Typically, 
this character is the semicolon.

Command Diagrams
These notational conventions are used to describe command syntax: 

Item Description

ABBREViations Command abbreviations are shown in uppercase letters; 
lowercase letters in the command are optional.

lowercase Lowercase values indicate user-supplied variable information.

UPPERCASE Uppercase words indicate commands or keywords.

Underline The default value of an operand is underlined.

| A vertical bar separates synonymous commands or operands.

A right ending arrow indicates that the command syntax is 
continued on the next line.

A right beginning arrow indicates the command syntax is 
continued from the previous line.

Right and left ending arrows indicate the end of the command 
syntax.

An operand or keyword displaying on the main command line is 
required.required 
222



14   Online Component Commands
This is a syntax diagram for the HELP command. Since H is shown in uppercase letters, 
H is the minimum you can enter. You can enter a question mark (?) instead of H or 
HELP. You do not need to enter an operand with the HELP command since all are shown 
below the path of the main line. If the path is followed down the first line, any operand 
shown can be specified. Since the MESSAGE operand is separated with a vertical bar (|), 
you can enter MESSAGE or MSG.

Stacked operands on the main line indicate a choice of one 
required item.

An operand or keyword displaying below the main command line 
is optional.

Stacked operands below the main line show a choice of one 
optional item.

A returning arrow indicates that more than one operand can be 
chosen.

A returning arrow with a + (plus sign) indicates that operands can 
be concatenated by placing a + between them.

Item Description

choice1
choice2
choice3

optional

choice1
choice2

choice1
choice2

choice1
choice2
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ANALYZE Command

The ANALYZE command can be entered on any SmartDoc screen and displays the 
Analyze Submit pop-up. Use this pop-up to submit a compile/analyze job without ending 
the current SmartDoc function. This is the syntax diagram for the ANALYZE command:

Function

Note:
A program must be analyzed before it can be used in SmartDoc. See Chapter 11, 
"Analyze," on page 159 for additional information.

Operands

None.

Usage Notes

To display the Analyze Submit pop-up, follow this step:

� Select Analyze � File and press Enter. 

See Chapter 6, "File," on page 107 for additional information.
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HELP Command 
Use the HELP command to display information about these items:

� The current SmartDoc screen

� Pop-ups

� Reports

� Commands

� Messages

� Abend codes

This is a syntax diagram for the HELP command:

See Chapter 9, "Help," on page 149 for more information.

Operand
These are the Help command operands:

Operand Description

blank If no message displays on the screen, type HELP without operands to 
display the Help Tutorial for the current screen or pop-up. Here 
you�ll find a description of all fields on the screen and any special 
processing considerations. If a message displays on the screen or 
pop-up, type HELP without operands to view the Help Explanation 
and Action screen for the current message.

MESSAGE | MSG Displays the Help Explanation and Action screen, that shows the 
specified short and long message, an explanation of the message, and 
any actions to be performed.

ASGmsg# | msg# Defines the ESW message number for the Help Explanation and 
Action screen to be displayed. This number consists of 1 through 4 
digits. You do not need to enter leading zeros.

COMMANDS Displays a list of all SmartDoc primary commands. Information for 
a particular command is displayed by selecting the appropriate 
number.
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Usage Notes

Note:
You can also obtain Help information by selecting an action on the Help pull-down.

See Chapter 9, "Help," on page 149 for more information on the Help pull-down and its 
actions, and Chapter 15, "Help Facility," on page 235 for more information on the Help 
facility and the Help Tutorial.

REPORTS Displays a list of all SmartDoc reports. You can view information for 
a particular report by selecting the appropriate number.

cmd This operand is a SmartDoc primary command. When you request 
help for a command, a long message displays giving a brief 
description of that command. Requesting help again to view more 
detailed information about the command.

ABENDS Displays the Abends screen that lists the types of abend codes.

SCREEN Displays the Help Tutorial for the current screen or pop-up, that 
describes all fields on the screen or pop-up and any special 
processing considerations.

Operand Description
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KEYS Command
The KEYS command displays the Options - PF Key Definition pop-up. Use this pop-up 
to display and/or modify the current SmartDoc PF key assignments. This is the syntax for 
the KEYS command: 

Operands
None.

Usage Notes

To display the Options - PF Key Definition pop-up, follow this step:

�  Select Options � PF keys and press Enter.

To display and/or modify the current PF key assignments, follow this step:

� Type KEYS on any SmartDoc screen. Values assigned to the SmartDoc PF keys have 
no affect on other ISPF applications.

See Chapter 8, "Options," on page 141 for additional information on PF key assignments 
and the Options - PF Key Definition pop-up.
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LOCATE Command
Use the LOCATE command on the File - AKR Directory pop-up to locate a particular 
program. 

To display an item that matches a specified string, follow this step:

� Enter the LOCATE command with the string. 

This is the syntax for the LOCATE command: 

Operands

string. An alphanumeric or DBCS character string to locate a particular item.

Usage Notes
When you do not know the exact name of a program or a list item, specify a character 
string. The LOCATE command displays the item that most closely matches the character 
string you specified. Matching is done alphabetically.

See Chapter 6, "File," on page 107 for more information on the File - AKR Directory 
pop-up.
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PARMDEF Command
The PARMDEF command displays the Options - Product Parameters pop-up. Use this 
pop-up to set parameters that affect the online operation of SmartDoc. This is the syntax 
for the PARMDEF command

Operands
None.

Usage Notes

To display the Options - Product Parameters pop-up, follow this step:

� Select Options � Product Parameters and press Enter.

See Chapter 8, "Options," on page 141 for more information on the Options - Product 
Parameters pop-up.
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PRINTLOG Command
The PRINTLOG command can be issued on any SmartDoc screen and displays the 
Options - Log File Definition pop-up. Use this pop-up to print the Log file. This is the 
PRINTLOG command syntax:

Operands
None.

Usage Notes

To display the Options - Log File Definition pop-up, follow this step:

� Select Options � Log file and press Enter.

See Chapter 8, "Options," on page 141 for additional information on the Options - Log 
File Definition pop-up.
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PRODLVL Command
Use the PRODLVL command to display the current SmartDoc and Center product levels. 
This is the syntax for the PRODLVL command:

Operands
None.

Usage Notes
The PRODLVL command displays the product name, operating system, product release 
number, and release level on the message line, for example:

ASG1554I ASG-SMARTDOC-OS (XA) Rn.n AT Lnnn, CENTER Rn.n AT Lnnn

where:

Rn.n is the release number.

Lnnn is the release level.

Note:
This information is requested when ASG Customer Support is contacted for assistance.

To display the current SmartDoc and Center product levels, follow this step:

� Select Help � About and press Enter.

See the online help for more information on ASG Customer Support and the Help - About 
pop-up.
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RECALL Command
The RECALL command displays the previous primary or internal command, message, or 
pop-up. The last 20 executed commands and the last 20 displayed messages are stacked. 

To redisplay these commands or messages, follow this step:

� Type RECALL. 

This is the syntax for the RECALL command:

Operands
These are the RECALL command operands:

Operand Description

blank Displays the last primary command that was stacked. After you 
enter the RECALL command with operands, subsequently entering 
RECALL with no operands automatically uses the operands that 
were last entered.

COMmand | CMD Displays a stacked primary command. This is the default.

MESsage | MSG Displays a stacked message.

NEXT Displays the next command or message in the stack.

PREV Displays the previous command or message in the stack. This is the 
default value.

POPup Displays the pop-up that was most recently requested from a 
pull-down.
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Usage Notes

To display any of the 20 stacked commands or messages

1 Type the RECALL command repeatedly. 

2 Use the NEXT and PREV operands to move forward or backward through the 
stacked commands or messages. 

3 After the desired command displays, press Enter to execute it again. 

Note:
You can change any recalled command before executing it.

ESW products issue internal commands when you make certain selections on pull-downs 
and pop-ups. The operands you specified for the RECALL command remain in effect 
until one of these conditions occur:

� You specify a different operand.

� You execute a different primary command. When this occurs, the RECALL 
command default operands automatically set. A message displays that indicates all 
stacked commands or messages have been shown and the stack is displaying again.
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 15Help Facility
This chapter discusses the online Help facilities and contains these sections: 

Introduction
SmartDoc provides comprehensive and context-sensitive online help facilities to answer 
most of your questions. The Help Tutorial contains help information on several subjects, 
such as screens, pop-ups, reports, commands, messages, and abends. The Help Tutorial 
also includes a Table of Contents that describes each major SmartDoc function, and a 
comprehensive Index where you can view specific information.

Section Page

Introduction 235

Help Navigational Commands 236

Screen Help 237

Report Help 238

Command Help 239

General Information 240

Specific Information 241

Help Abends 242

Help Messages 243
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To request SmartDoc online help, follow this step:

� Choose one of these actions: 

� Select Help on the action bar and press Enter.

� Press PF1/13.

� Type HELP in the command input area on any screen and press Enter.

� Type a question mark (?) in the command input area on any screen and press Enter.

Help Navigational Commands
Use the Table of Contents or the Index to access each online help subject from anywhere 
within the Help Tutorial. After you access the Help Tutorial, it provides commands for 
navigating within it. These are the navigational commands:

Help Command Purpose

BACK Redisplays the previous Help Tutorial screen.

END Exits the Help Tutorial.

Enter Displays the next screen in a continuation series.

INDEX Displays the first screen of the Help Index.

SKIP Goes directly to the next subject.

TOC Displays the Help Table of Contents.

UP Displays the next higher-level subject.

alpha character Displays the Index screen corresponding to a certain 
alphabetic character when that character is entered.
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Screen Help

The Help Tutorial for each screen or pop-up describes all the options available on that 
screen, lists descriptions of all the screen fields, and notes any special processing 
considerations.

To request SmartDoc Help for the current screen or pop-up, follow this step:

� Choose one of these actions: 

� Type HELP and press Enter.

� Press PF1/13 while there are no screen messages 

� Type HELP SCREEN and press Enter.

� Select Help � Current Screen and press Enter.

The Help Tutorial for the current screen displays (see Figure 94).

Figure 94 � Screen Help Example
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Report Help

The SmartDoc Reports Help Tutorial screen (see Figure 95), lists all SmartDoc reports. 
Select any report for further information. Use the Help Index to request help for specific 
reports.

To display the SmartDoc Reports Help Tutorial screen, follow this step: 

� Choose one of these actions: 

� Type HELP REPORTS and press Enter.

� Type REPORTS and press PF1/13.

� Select Help � All reports and press Enter.

Figure 95 � SmartDoc Reports Help Tutorial Screen
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Command Help

The Help Tutorial (see Figure 96) for each command displays the command syntax 
diagram, and each operand in the command. 

To display a list of all SmartDoc commands, follow this step: 

� Select Help � All commands and press Enter.

Figure 96 � Command Help Example

To request help for a specific command 

1 Perform one of these actions to display a message describing a specific command:

� Type the command in the input area and press PF1/13. 

� Type HELP followed by the desired command name and press Enter.

� Select Help � Specific command and press Enter. 

2 Press PF1/13 again to display the Help Tutorial screen for that command.
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To request help on all SmartDoc commands

1 Use the HELP COMMANDS command.

Or

Select Help � All Commands and press Enter. 

A list displays containing most of the primary commands. 

2 After this message displays, press PF1/13 for a complete list of all SmartDoc 
commands. 

3 Select the appropriate number to display command information.

General Information
To request general help information, follow this step:

� Enter the Help Tutorial and type TOC.

Or

Select Help � Table of contents and press Enter.

The Help Table of Contents Screen displays (see Figure 97).

Figure 97 � Help Table of Contents
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Specific Information

To request help for specific subjects

1 To request help for specific subjects, perform one of these actions:

� Enter the Help Tutorial, then type INDEX.

� From the Help Table of Contents select option 6 and press Enter. 

� Select Help � Index and press Enter. 

2 The Help Index displays (see Figure 98). Select the appropriate Index entry to view 
the Help for a specific subject.

To display a certain Index screen, follow this step:

� Enter an alphabetic character to display the Index screen corresponding to that 
character.

Figure 98 � Help Index Example
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Help Abends

To request help for ASG user abends

1 To request help for ASG user abends, perform one of these actions:

� Type HELP ABENDS and press Enter.

� Type ABENDS in the command input area and press PF1/13.

� Select Help � Common Abends and press Enter.

2 The ABENDS screen displays (see Figure 99). 

Figure 99 � ASG Abend Codes Screen

To display a list of all user abend messages and explanations for each message, follow 
this step:

� Select Topic 2 on the ASG Abend Codes screen to display the ASG Abend Codes 
screen.
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Help Messages
SmartDoc messages display in the long message area, which is located on the bottom of 
the screen. This is the message format:

ASGnnnnx text

where:

nnnn is the message number

x is one of the severity levels listed below.

text is the text of the long or the short message.

Short messages display when available. Long messages display when short message does 
not exist, or when help is requested immediately following a displayed short message.

To display Help for a specific message, follow this step:

� Type HELP, followed by the message number and press Enter. The Help Explanation 
and Action Panel for that message displays (see Figure 100).

Figure 100 � Help Explanation and Action Panel

Severity Levels

I Informational - no required action.

W Warning - an error condition exists that is not critical.

E Error - a critical error condition exists.

D Disaster - serious error condition exists and the product is unable 
to continue.

T Termination - product terminated with the specified error.
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Printing Messages
Use the VIASMPRT program to print all or a range of SmartDoc messages. The 
VIASMPRT program produces a list of specified messages that includes this data:

� Message number

� Short message (if available)

� Long message

� Explanation of the message

� Action (if any)

The JCL to execute the VIASMPRT program resides in 
ASG.VIACENxx.CNTL(VIASMPRT). The entire message file prints unless you specify 
a range in the PRM parameter. This syntax would print messages 300 through 499, for 
example:

 PRM='START=300,END=499'

To print all messages, follow this step:

� Specify the ALL keyword in the PRM parameter.

The default value for START is 1. The default value for END is 9999. If you only enter 
the START value, messages print starting at the specified message number and ending 
with 9999. 

If you only enter the END value, the messages print starting with 1 and ending with the 
message number that you specified.

The NOTES keyword specifies that any notes associated with a message are printed. The 
default is NONOTES. Typically, notes are provided to illustrate Center primary 
commands.
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Figure 101 and Figure 102 on page 246 illustrate the VIASMPRT JCL and the output 
from the job.

Figure 101 � VIASMPRT JCL
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Figure 102 � VIASMPRT Output
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Glossary
action bar
The line of keywords at the top of a screen. Each keyword represents a category of 
actions that may be performed on that screen. Select an action by moving the cursor to the 
desired keyword and pressing Enter. See Chapter 1, "Introduction," on page 1 for more 
information.

alias of
A field on a pop-up listing entries in the AKR. If the analyzed program contains an 
ENTRY point, Alias Of is the name of the program containing the ENTRY point. If the 
name in the PROGRAM-ID statement was overridden at the time the analyze job was 
submitted, Alias Of is the name that was entered in the AKR program name field on the 
Analyze Submit pop-up.

analyze
The process used by SmartDoc to prepare a COBOL program for reporting.See Chapter 
11, "Analyze," on page 159 for more information.

analyze options
Run-time options that control the Analyzer processing. Many of these options are similar 
to the COBOL compiler options. Default values are established at installation time and 
can be overridden by editing the Analyzer JCL or by using the Analyze screens. The 
Chapter 11, "Analyze," on page 159 contains a complete description of each Analyze 
option.

analyze Summary report
A summary of the run-time statistics and diagnostic messages produced when an Analyze 
job completes.

AKR
A BDAM or VSAM file organization that contains all analysis information produced by 
the Analyze job. Multiple AKRs can be defined. See Chapter 13, "AKR Utilities," on 
page 199 for more information.

browser
An application that displays World Wide Web content.
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COBOL subset
COBOL verbs of a similar nature that have been grouped together. For example, READ, 
WRITE, OPEN, and CLOSE are grouped into the IO subset. See Chapter 2, "Concepts," 
on page 7 for more information.

command input area
The field on SmartDoc screens where primary commands are entered, indicated by ===> 
on the fourth line of the screen.

dataname
A standard COBOL term for fields defined in the DATA DIVISION of a COBOL 
program. Variable names, files, groups, array elements, and fully qualified datanames.

data usage
Defines how a data item is used: DEF indicates the statements in the DATA DIVISION 
where the data item is defined; USE indicates the statements where the value is used or is 
tested; MOD indicates the statements where the value is set or is modified; REF indicates 
any of the above conditions.

DBCS
See double byte character set (DBCS).

DDL
DB2 SQL Data Definition Language, a subset of SQL.

diagnostic message
An informational or an error message generated by the online and batch components. 
Online - A short message displays in the upper right corner of the screen (if available). A 
long message displays on line three when PF1/PF13 is pressed or when HELP is entered 
for a short message. Batch - Messages are included in the Analyzer Summary.

DL/I | DL/1
The database (DB) portion of the IMS system.

DML
DB2 SQL Data Manipulation Language, a subset of SQL.

double byte character set (DBCS)
A character set that uses two bytes to represent each character. Various Double Byte 
Character Sets are used with languages such as Chinese and Japanese that cannot be 
represented with single byte codes.

file transfer protocol (FTP)
A protocol that defines how to transfer files from one computer to another.
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help
SmartDoc has three levels of Help: Long messages, notes, and tutorial screens. Specific 
command information is available by entering a command, then pressing PF1/13. The 
Help facility can also be accessed from the Help pull-down or any SmartDoc screen. See 
Chapter 9, "Help," on page 149 and Chapter 15, "Help Facility," on page 235 for more 
information.

label name
Any PROCEDURE DIVISION paragraph or section name and the PROCEDURE and 
PROC literals.

live exit
An abnormality in program control caused by out of perform range GO TOs and 
overlapping perform ranges.

log file
A file allocated bySmartDoc and used for error messages and log commands.

logical unit
Performed paragraphs (or sections) and CALLed programs reported on the Structure 
Chart.

long message
A diagnostic or an error message that displays on line five of SmartDoc screens. Long 
messages are sometimes preceded by short messages displayed in the upper right corner 
of the screen. Pressing PF1/PF13 after receiving a short message displays the 
corresponding long message.

member
A member in a PDS or a source manager such as Panvalet or Librarian. This can be the 
alias name found in the AKR.

metrics
A measure of program quality or complexity.

page mode
A formatting option for the Structure Chart. Page Mode indicates the Structure Chart is 
printed on pages that can be placed in a notebook.

perform range
A perform range consists of the source code contained in a PERFORM statement, and 
includes all code that is or could be executed as a result of GO TOs, PERFORMs, etc., 
within that PERFORM.
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pop-up
A window displayed by selecting an item on a pull-down or a pop-up, or by entering 
certain commands. It is superimposed on the screen to allow entry of information for the 
requested action. See Chapter 1, "Introduction," on page 1 for more information.

primary command
An instruction entered in the command input area of the screen.

program
Program source member name, the name specified in the IDENTIFICATION DIVISION 
of a COBOL program, or the CSECT name of a program that is not COBOL.

pull-down
The list that displays when an action is selected on the action bar. On a pull-down, actions 
followed by ... display a pop-up when selected. Actions not followed by ... immediately 
activate internal commands.

recursion
A perform range or paragraph that performs itself.

SBCS
See single byte character set (SBCS).

screen
A full-width display of information containing an action bar as the first line. SmartDoc 
screens are modeled after TSO/ISPF screens.

short message
A diagnostic or an error message that displays in the upper right corner of SmartDoc 
screens. Pressing PF1/13 after receiving a short message displays the corresponding long 
message.

single byte character set (SBCS)
A character set that uses one byte to represent each character. Single Byte Character Sets 
are used with languages such as English where the characters can be represented with a 
one-byte code.

SQL
DB2 Structured Query Language, including DML and DDL.

storage management subsystem (SMS)
An operating environment that automates and centralizes the management of storage. To 
manage storage, SMS provides the storage administrator with control over data class, 
storage class, management class, storage group, and ACS routine definitions.

subset
See �COBOL subset� on page 248.
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tile mode
A formatting option for the Structure Chart. Tile Mode indicates the Structure Chart is 
printed on pages that can be pasted together to produce a single chart of the entire 
program.

VIASUB
An edit macro included with the SmartDoc product used to submit an Analyze job.

VIASUBDS
A CLIST included with the SmartDoc product used to submit an Analyze job.
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LANGLVL override 180
LINECNT 185�186
MAIN 186
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